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1. KURSUSE TUTVUSTUS 

1.1 Iseloomustus 

Käesolev kursus on mõeldud kõigile, kes kasutavad GIS tarkvara MapInfo Professional. Kursus ei hõlma täielikult 

kõiki pakutavaid võimalusi, vaadeldakse põhialuseid ning enamvajaminevaid ning tähtsamaid funktsioone. 

Kursuse aluseks on MapInfo Professional tarkvara versioon 16.0 (tootjaks Pitney Bowes Software Ltd, USA). 

Sarnasel tasemel konkureerivad tooted on ESRI ArcGIS Standard/ArcGIS Advanced ning Intergraph GeoMedia 

Professional. 

Kursuse eesmärgiks on, et lõpetanu valdaks üldisi protseduure, mis on vajalikud MapInfo abil ruumiandmete 

kasutamiseks ning lihtsate andmestike loomiseks. Peamisteks märksõnadeks on: 

 Tabelite (infokihtide) haldamine: loomine, andmete lisamine ja parandamine 

 Päringute teostamine 

 Temaatiline kaardistus 

 Ruumi– ehk geoinfo analüüs 

 Kaardipildi kujundamine väljatrükiks 
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1.2 Eelnõuded 

1) Kursus ei nõua eelnevat MapInfo ja geoinfosüsteemide (GIS) ala tundmist. 

2) Eeldatakse elementaarset tööoskust Microsoft Windows keskkonnas: eelkõige failide avamine, sulgemine ja 

salvestamine, kopeerimine, programmide käivitamine, programmiakendega manipuleerimine (avamine, 

sulgemine, nihutamine, suuruse muutmine). Kasuks tuleb ka, kui tuntakse üldisi termineid andmebaasidest 

(tabelid, read/kirjed, veerud/väljad, muutujad, veerutüübid, avaldised). 

1.3 Kursusel kasutatavad materjalid 

 Kursuse harjutuste juhend ja failide kujul andmestik 

 Käesolev teooriakonspekt – lugemiseks pärast kursust 

 MapInfo User’s Guide PDF faili kujul ning Online Help – soovitav lisakirjandus. Online Help avaneb 

funktsiooniklahviga F1 ja on mugavas *.chm formaadis. F1 klahvile on mõtet vajutada kohas, kus abistavat 

infot koheselt vajatakse.  

1.4 Kokkulepped 

Valikud menüüdest on tähistatud: Lindimenüü > Käsk (näiteks Home > Open Table). Mitmesugustes akendes (list 

box’ides) Valikurida –> Valik (näiteks Open Table dialoogis Files of type –> Raster Image). Klaviatuurinuppudest 

valitavad käsud: [Nupukäsu nimi] (näiteks [Del]). Inglisekeelsed mõisted ja käsud on reeglina kujutatud kaldkirjas.  

1.5 Üldist 

MapInfo 16.0 tarkvara installeerimise juhend on lisatud konspekti lõppu, samuti MapInfo teiste tarkvaratoodete 

lühiülevaated leiab konspekti lõpust. 

* MapInfo Professional koduleht asub aadressil http://www.mapinfo.com  

* MapInfo andmestike vaatamiseks (kaardil navigeerimine, info küsimine) ja trükkimiseks on olemas vabavaraline 

tarkvara MapInfo Proviewer. MapInfo Professional tarkvara täiustamiseks (lisaprogrammide loomiseks ja rutiinsete 

tööprotsesside automatiseerimiseks) on arendajale olemas tasuta arendusvahend MapInfo MapBasic. 

http://www.mapinfo.com/
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Arvutikaardistuse mõisted 

1.6 Mis on arvutikaardistus ? 

1.6.1 Mis on andmebaas ? 

Andmebaas on kogum andmetest reaalelu nähtuste kohta, andmed on seal antud tabelite kujul, kus:  

 Igale tabeli reale ehk kirjele (record, row) vastab üks andmebaasis sisalduv objekt. 

 Igale tabeli veerule ehk väljale (field, column) vastab objekti üks meid huvitav 

omadus/tunnus/atribuut/parameeter.  

Näiteks kui andmebaasis on tabel koolidest, siis iga kooli kohta oleks koolide tabelis üks rida. Näiteks: 

 

Uue andmebaasi koostamine eeldab loodavate tabelite kirjeldamist. Tuleb kindlaks teha, (1) millised tabelid on 

vajalikud ja milliseid nähtusi need tabelid sisaldavad, (2) milliseid nähtusi iseloomustavaid tunnuseid on vaja 

salvestada ning (3) mis tüüpi on need iseloomustavad tunnused – tekstilised või numbrilised ja soovitav on kohe ka 

kindlaks määrata tunnuste kvantitatiivsed piirangud, milledest olulisemad on: kui suured võivad olla numbrilised 

väärtused, millise täpsusega on need vajalikud, kui pikad võivad olla tekstid tähemärkides. Heaks tavaks on kõik see 

dokumenteerida kirjalikult, siis 

on ka suurema infosüsteemi 

loomisel sellest väga hea lähtuda.  

Tüüpilised kaardistatavad 

nähtused ja nende näidistunnused 

on näiteks: 

 teed (tee laiusklass, kate),  

 tänavad (tänava nimi, klass),  

 majad (aadress, omanik, 

hoone tüüp), 

 metsakvartalid (kvartali 

number, pindala), 

 taimeliigid (liigi nimi, 

ladinakeelne nimi, arvukus) 

jne. 
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1.6.2 Mis on GIS? 

GIS–i (Geograafilise Informatsiooni Süsteemi, Geographic Information System) omapära on see, et andmebaasi 

(st. tabelite) andmed on seotud ruumiinfoga, objektide kohta on öeldud peale tekstilis–numbriliste omaduste ka 

nende asukoht. MapInfo mõistes on igale andmebaasi kirjele lisatud graafiline objekt, mida näidatakse koos teiste 

graafiliste objektidega digitaalkaardi kujul. Näiteks on kooli andmetele tabelis lisatud kooli asukohta tähistav 

leppemärk kaardil (ning kaardil on toodud tekstilised märgised tähistamaks kooli nime, mis on automaatselt võetud 

tabeli andmerealt ning kujutatud objekti juures kaardil – kooli nimi on üks tema tunnuseid): 

Teooria järgi on vähemalt 80% tavaandmebaasides sisalduvas infos mingil moel salvestatud ka asukohainfo 

(aadress, linn/vald, maakond, postikood vms.). See loob võimaluse objektid kaardile panna (siduda 

koordinaatidega), mis reeglina aitab märgatavalt kiiremini haarata seni märkamata jäänud seoseid ja trende. 

1.7 MapInfo GIS–i põhimõtted 

1.8 Tabelid 

MapInfos nimetatakse kõiki kasutatavaid andmestikke tabeliteks. Üks infokiht (näiteks krundipiirid) = ühe tabeliga. 

Ühe tabeli sisse võib salvestada kõiki graafilisi elemendi tüüpe (jooned, areaalid, tekstid, punktid–sümbolid). 

Soovitav on praktikas siiski erinevat tüüpi graafilised elemendid paigutada erinevatele kihtidele e. erinevatesse 

tabelitesse. 

Kaardil kujutatakse tabel infokihina (e. kaardikihina, layer), digitaalkaart koosneb reeglina paljudest üksteise 

peale/kohale näidatavatest infokihtidest.  

Tabelid salvestatakse failidena, ning üks tabel moodustub kõvakettale salvestatult mitmest sama nimega, kuid eri 

laiendiga failist (laiendeid ei näidata Windows Exploreris, kui see ei ole sisse lülitatud (paremklikk hiirega tühjal 

alal > View > Details). Faililaiendid on järgmised: 

 *.TAB – tabeli kirjeldus, peamine fail. TAB laiendiga on fail, mis on MapInfos kirjeldatud andmetel alati 

olemas ja seal ei ole kirjas reaalsed andmed, vaid (meta)info tabeli andmete kohta (MapInfo versioon, 

atribuuditabeli struktuur jne.). 

 *.DAT, .mdb, .dbf, .txt või .xls – atribuutandmete e. tunnuste e. tabelandmete fail (rasterandmete korral võib 

olla ka pilt: .tif, .bmp, .jpg või .gif). 

 *.MAP – graafiline kaardikujutis ehk kaardiobjekte sisaldav fail 

 *.ID – indeksfail, seosed graafilise kujutise ja tabelandmete vahel 

 *.IND – indeksfail, kasutatakse tabelitega töö kiirendamiseks (see fail võib ka puududa, kui ükski tabeli 

veergudest ei ole indekseeritud) 

Kõik samanimelised, kuid erinevate laienditega failid peavad avamisel asuma ühes kataloogis (muidu kihi avamine 

ei õnnestu)! 

Failide avamisel Open käsuga valitakse tavaliselt .TAB fail (failitüübiks on MapInfo *.TAB)  

Ekraanil olev pilt ehk kõik avatud tabelid ning aknad (kaardiaknad, tabeliaknad, kujundusaknad, infoaknad jms), 

millisena kaardiaknas kihid kuvatakse, teostatud päringud, loodud teemakaardid jpm. salvestatakse enamasti 

hilisemaks mugavaks andmete taasavamiseks tööseisuna (e. tööfailina, workspace) – tekib .WOR laiendiga fail. 

Tööfaili avamiseks tuleb Open käsu korral failitüübiks valida MapInfo Workspace *.WOR. Täpsemalt sellest 

edaspidi. 

1.9 Raster– ja vektorfailid 

On kaks põhilist viisi looduses eksisteerivaid nähtusi/objekte arvutikaardil kujutada: 

a) Vektorjoonis koostatakse selgelt eraldatud graafilistest objektidest nagu jooned, alad (areaalid) ja punktid, 

iga selline graafiline objekt püüab tabada vastava loodusobjekti kuju ja asukohta.  

b) Rasterjoonise pilt koosneb ristkülikukujulises ruudustikus (e. rastris) asuvatest punktidest (e. pikslitest), iga 

punkt näitab oma värviga, kas seal asub vastav objekt/nähtus või mitte. Näiteks sinise värviga piksel võib 

tähistada, et seal on meri, ja rohelise värviga piksel metsa. Suured objektid moodustuvad kõrvutiasetsevatest 

pikslikogumitest. Sisuliselt on rasterpilt iga trükitud kaart. 

Paberkaardipilti on võimalik skaneerida, siis saadakse tulemuseks rasterfail, kus värvidega (toonidega) antakse 

edasi nähtused–objektid. Et aga pikslitest ei oska arvuti moodustada tervikobjekte, saame seda pilti MapInfos 

kasutada vaid taustainfona. Skaneeritud pildi abil on võimalik luua vektorpilt, kui joonistada käsitsi objektide 



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  1-8 

piirjooned ekraanil üle, seda nimetatakse digitaliseerimiseks (ehk digimiseks). Tavaliselt sisestatakse koos 

kaardiobjektide joonistamisega kohe ka nende atribuuttunnused: iga objekti nimi jms. olulised tunnused. 

MapInfo (nagu ka enamik GIS programme) kasutab omas töös andmebaasidega peamiselt vektorobjekte. See 

eeldab, et iga kaardil olev objekt on piisava täpsusega välja joonistatud. 

1.10 Vaated, tööaknad 

MapInfo infosüsteemi aluseks on tabelandmed 

(tabelid, kus on read ja veerud ning veergudes on kirjas 

tekstid ja numbrid ning tabeli ridadega on seotud 

objektide graafiline kujutis. 

Kuna MapInfo tabelis on nii graafilist, kui tekstilis–

numbrilist infot, on kasulik seda vaadata eri viisidel, 

valik sõltub konkreetsest vajadusest. Andmete 

vaatamiseks on MapInfos viis erinevat tööakent: 

 

1. Tabeliaken (browser) – andmete esitus tabeli 

kujul; tabeliakna kaudu näidatakse objekte 

iseloomustavad tekstilised ja numbrilised andmed 

(tunnused). Siin saab liikuda kerimisnuppude abil, 

kasutada filtreid ja teha andmetes parandusi. 

Näiteks haldusüksuste tabeliaken võiks välja näha 

järgmine: 

2. Kaardiaken (mapper) – kaardi graafiline kujutis; aknas näidatakse objektide graafilisi kujutisi (maakonna 

piire, jõgesid, linnade asukohti ja nimesid jms) sarnaselt joonistus– ja kujundusprogrammidele. Kaardiaknas on 

tavaliselt juba koos mitme tabeli andmed 

infokihtidena, mis paiknevad üksteise peal. 

Aknas olevat pilti saab suurendada–

vähendada jne., muuta kihtide kuvamise 

järjekorda, väljanägemist, küsida 

koordinaate, küsida objekti kohta infot, 

graafilisi objekte muuta, lisada, kustutada 

jne. 

 

3. Kujundusaken (layout) – Kujundus 

paberväljatrükiks; siia aknasse 

koondatakse väljatrükiks kõikide antud 

hetkel vajalike akende sisu, mida 

soovitakse koos trükkida, lisades 

legendid, pealkirjad, logod jms. 

kujunduselemendid. Mõõtkavalise 

väljatrüki kaardist võib teha ka otse 

kaardiaknast ilma kujundusakent 

kasutamata. Kujundust saab salvestada 

ning kasutada salvestatud 

näidiskujundust (template) teiste 

sarnaste kaartide väljatrükil. 

4. Piirkondadeks ümberjaotamise 

analüüsi–aken (redistricter) – 

võimaldab läbi viia objektide 

grupeerimise meetodil põhinevat (nn 

what–if) analüüsi. 

 

Viimast akent kasutatakse üldjuhul 

harvemini. 
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2. Alustamine, töövahendid, andmestike kuvamine 

2.1 MapInfo käivitamine 

Tarkvara installeerimise järgselt tekkis Start –> All Programs –> MapInfo sektsiooni shortcut „MapInfo Pro 16.0”. 

MapInfo käivitamisel näidatakse kõigepealt akent, milles küsitakse, milliseid andmeid kasutaja soovib avada: 

  

Restore Previous Session – avatakse tööseis …\AppData\Roaming\MapInfo\Professional\MAPINFOW.WOR ehk 

jätkatakse eelmisel korral pooleli jäänud kohast. Avatakse need tabelid ja aknad, mis olid eelmisel korral 

programmist väljumisel avatud. Selliseks avamise eelduseks on, et MapInfost väljuti eelmisel korral ilma aknaid ja 

andmeid eraldi kinni panemata (ilma Close All käsuta) ehk siis kas käsuga Pro > Exit või paremast ülemisest ristist. 

Open Last Used Workspace – avatakse viimati kasutatud tööseis, näidatud on ka selle tööseisu nimi (antud pildi 

puhul ei ole varem ühtegi tööseisu avatud olnud). 

Open a Workspace – tööseisu avamise valik. Kasutaja valib ise, millist konkreetset tööseisu ta avada tahab. 

Tööseisu nime küsitakse peale OK vajutamist. 

Open a Table – tabelite avamise valik. Tabeli(te) nime(sid) küsitakse peale OK vajutamist. Korraga saab  [Ctrl] 

klahvi all hoides avada ka mitu kihti. 

Cancel – sisenetakse MapInfosse avamata ühtegi tabelit. Andmeid saab sellisel juhul hiljem avada valides menüüst 

Home > Open... käsu. Näiteks, kui soovitakse andmete avamise asemel koheselt tegeleda hoopis andmete 

importimisega Table >Open > Import käsuga (lugeda .MIF, .DXF, .DBF vms. formaatidest). 

NB! Quick Start dialoogiakent MapInfo käivitamisel ei kuvata, kui see on välja lülitatud programmi tööparameetrite 

seadistamise dialoogis: Pro > Options –> Startup –> Display Quick Start Dialog. 

2.2 Töövahendid 

Enamkasutatavad käsud saab valida käsunuppudest, mis on grupeeritud lindimenüüdesse. Need on kujundatud 

ning kasutatavad analoogselt teistele Windowsi keskkonnas töötavatele programmidele. Nupu tähendust näidatakse 

tekstina (tooltip), kui hiire kursor jätta mõneks sekundiks nupu kohale seisma.  

MapInfo hoiab viimati valitud käsunuppu aktiivsena seni, kuni valitakse uus käsunupp st. vahepeal 

mittekäsunuppudega teostatud toimingud nupukäsku ei deaktiviseeri. 

Tavaliselt on töötamise loogika selline, et valitakse õige käsk ning siis avaneb kas mingi dialoogiaken või näiteks 

asutakse joonistama–mõõtma vms. Teisel juhul on enne käsu andmist vaja ära valida objektid, millega käsu 

andmine hiljem teostab mingi operatsiooni. 

Käske saab menüüdesse ka juurde lisada kasutades selleks Home > Tool Extensions 

akent. Sellest tuleb täpsemalt juttu peatükis 22 
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2.2.1 Home menüü 

 

 

 

Open (MapInfo jätab meelde galeriist viimati valitud käsu): 

 

> Open  Workspace – tööseisu avamine 

> Add Workspace – tööseisu lisamine 

> Table – tabeli avamine 

> Import – graafikafaili importimine 

> Universal Data – teiste formaatide otse avamine 

ilma konverteerimata 

> Database Table – ühenduse loomine välise 

andmebaasi tabeliga 

> Program – MapBasicu programmi avamine 

> Aerial – Bing ortofoto veebikaardi avamine 

> Roads – Bing teede veebikaardi avamine 

> Hybrid – Bing hübriid veebikaardi avamine 

> Mapping (WMS) – WMS formaadis andmekihtide 

(rasterandmed) lisamine vastavat teenust pakkuvast 

veebiserverist 

> Feature (WFS) – WFS formaadis andmekihtide 

(vektorandmed) lisamine vastavat teenust pakkuvast 

veebiserverist 

> Mapping (WMTS) – WMTS formaadis 

andmekihtide (eeltailitud rasterandmed) lisamine 

vastavat teenust pakkuvast veebiserverist 

 

Open Table – tabeli avamine 

Save Workspace: 

 

> Save Workspace – tööseisu salvestamine 

> Save Workspace As – tööseisu salvestamine uude 

asukohta 

 

Save: 

 

> Save Table – tabeli(te) salvestamine 

> Save Copy As – tabeli koopia salvestamine uue nime, 

projektsiooni või asukohaga 

 

Close: 
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> Close DBMS – välistest andmebaasisüsteemist avatud tabelite 

sulgemine 

> Close Table – kihtide valikuline sulgemine 

> Close All – kõikide avatud andmete sulgemine 

 

Copy – info kopeerimine lõikepuhvrisse 

Paste – info toomine lõikepuhvrist tagasi 

Cut – info viimine lõikepuhvrisse 

Undo – viimase muudatuse tagasi võtmine 

New Document:   

 

> Map – uue kaardiakna avamine 

> Legend – lisa legendiakna raam 

> 3D Map – kolmemõõtmelise kaardiakna avamine 

> Redistricter – uue spetsiaalset tüüpi teemakaardi loomise 

akna avamine 

> Browser –uue tabeliakna avamine 

> Layout – uue trükikujundusakna avamine 

> Prism Map – perspektiivvaates prismakaardi loomine 

> Clone Window – aknast identse koopia–akna avamine 

> Redraw Window – aktiivse akna kuva värskendamine 

> Hide Status Bar – Olekurea peitmine/näitamine 

 

 

Tool Windows: 
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> Info – objekti info akna avamine 

> MapBasic – MapBasicu akna avamine 

> Message – teadete akna avamine 

> Statistics – statistikaakna näitamine 

> Themes – teemakaardi legendiakna näitamine 

> Explorer – tööseisu haldamise akna avamine 

> Ruler – vahemaade näitamise akna avamine 

> Tasks – avab taustal toimuvaid protsesse näitava akna 

> Move To – Aadressi ja objekti otsimine ning 

kaardipildi nihutamine sellele 

> Tool Extensions – lisavahendite haldamise akna 

avamine 

> Windows – avatud akende haldaja 

> Connections – andmebaasiühenduste näitamine 

> Layers – kaardikihtide haldamise dialoogiakna 

avamine 

> Tables – tabelite haldamise dialoogiakna kuvamine 

 

Recover Windows – ujuvate akende tagasitoomine ekraanile 

Create – aktiivsest aknast PDF dokumendi loomine 

Print – aktiivse akna välja trükkimine  

Save Image – akna salvestamine pildifailiks 

Page Setup – väljatrüki lehe seadete paikapanemine 

Tool Extensions – lisavahendite haldamise akna avamine  

 

2.2.2 Table menüü  

 

New Browser – uue tabeliakna avamine 

Open: 
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> Open  Workspace – tööseisu avamine 

> Add Workspace – tööseisu lisamine 

> Table – tabeli avamine 

> Import – graafikafaili importimine 

> Universal Data – teiste formaatide otse 

avamine ilma konverteerimata 

> Database Table – ühenduse loomine välise 

andmebaasi tabeliga 

> Program – MapBasicu programmi avamine 

> Aerial – Bing ortofoto veebikaardi avamine 

> Roads – Bing teede veebikaardi avamine 

> Hybrid – Bing hübriid veebikaardi avamine 

> Mapping (WMS) – WMS formaadis 

andmekihtide (rasterandmed) lisamine vastavat 

teenust pakkuvast veebiserverist 

> Feature (WFS) – WFS formaadis andmekihtide 

(vektorandmed) lisamine vastavat teenust 

pakkuvast veebiserverist 

> Mapping (WMTS) – WMTS formaadis 

andmekihtide (eeltailitud rasterandmed) lisamine 

vastavat teenust pakkuvast veebiserverist 

 

Save: 

 

> Save Table – tabeli(te) salvestamine 

> Save Query – päringu salvestamine 

> Save Copy As – tabeli koopia salvestamine uue nime, 

projektsiooni või asukohaga 

 

Revert – tabelis tehtud muudatuste tühistamine kuni eelmise salvestamiseni 

Close – tabeli(te) sulgemine 

New Table – uue tabeli loomine 

Export – tabeli eksportimine teise formaati 

Universal Translator – lisavahend andmete konverteerimiseks levinud GIS 

failiformaatide vahel 

Select – kihil olevate objektide valimine 

SQL Select – objektide valimine SQL päringu abil 

Invert – objektide valiku muutmine vastupidiseks (valitakse objektid, mis algselt ei 

olnud valitud) 

Clear – objektide valiku tühistamine 

Find: 



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  2-14 

 

> Find – otsib üles ja kuvab kaardiakna keskele (või tabeliakna esimeseks reaks) valitud objekti 

> Find Address – aadressi otsimine (eelduseks vastav veebiserver, mis geokodeerimisteenust 

pakub) 

> Mark – otsib objekte vastavalt kriteeriumitele ja märgistab need kaardil 

 

Update Column – tabelandmete hulgakaupa muutmine 

Append Rows – kahe samasuguse veergude struktuuriga tabeli andmete kokku liitmine 

Add New Row – rea lisamine tabelisse 

Clear Map Objects – valitud objektide graafilise info kustutamine  

Table: 

 

> Modify Structure – tabeli struktuuri (veergude nimede, arvu, järjekorra ja tüüpide muutmine) 

> Pack Table – tabeli optimeerimine ehk „pakkimine“ (hallide ridade kaotamine ja failide suuruse 

vähendamine) 

> Delete Table – tabeli kustutamine kettalt (korraga kustutatakse kettal kõik 2–5 faili, mis selle 

kihi moodustavad) 

> Rename Table – tabeli failinime muutmine (kettal nimetatakse korraga ümber kõik 2–5 faili) 

 

Database: 
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> Make DBMS Table Mappable – välise andmebaasitabeli kaardistatavaks 

tegemine 

> Change DBMS Table Symbol – välise andmebaasitabeli objektide kaardil 

kujutamise stiili muutmine 

> Unlink DBMS Table – välise andmebaasitabeli sulgemine 

> Refresh DBMS Table – välise andmebaasitabeli „värskendamine” (avamise ja 

käesoleva hetke vahelisel ajal tehtud muudatuste sisselugemine) 

> Create Oracle Workspace – Oracle töökeskkonna loomine 

> Delete Oracle Workspace – Oracle töökeskkonna kustutamine  

> Merge Oracle Table – Oracle andmebaasisüsteemi tabelite ühendamine 

> Refresh Oracle Table – Oracle andmebaasitabeli „värskendamine” 

> Enable Oracle Versioning –  

> Disable Oracle Versioning –  

 

Library: 

 

> Add To Library – lisa tabel MapInfo Manager Teeki 

> View/ Edit Metadata – tabeli metaandmete vaatamine ja muutmine 

 

Raster: 

 

> Adjust Image Styles – rasterkihi kontrastsuse, heleduse, läbipaistvuse, pool–läbipaistvuse 

muutmine 

> Modify Image Registration – rasterkihi registreerimine ehk koordinaatidega sidumine 

> Select Control Point – rasterkihi koordinaatidega sidumise protsessis kontrollpunkti valimine 

kaardilt 

 

Web Services: 
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> WFS Table Properties – WFS kaardiserverist avatud kihi parameetrite seadistamine 

> WFS Table Refresh – WFS kaardiserverist avatud kihi „värskendamine” e. andmete 

uuendamine 

> WMS Table Properties – WMS kaardiserverist avatud kihi parameetrite seadistamine 

> WMTS Table Properties – WMTS kaardiserverist avatud kihi parameetrite seadistamine 

 

 

2.2.3 Map menüü  

 

Map – uue tabeliakna avamine 

Open:  

 

> Open  Workspace – tööseisu avamine 

> Add Workspace – tööseisu lisamine 

> Table – tabeli avamine 

> Import – graafikafaili importimine 

> Universal Data – teiste formaatide otse 

avamine ilma konverteerimata 

> Database Table – ühenduse loomine välise 

andmebaasi tabeliga 

> Program – MapBasicu programmi avamine 

> Aerial – Bing ortofoto veebikaardi avamine 

> Roads – Bing teede veebikaardi avamine 

> Hybrid – Bing hübriid veebikaardi avamine 

> Mapping (WMS) – WMS formaadis 

andmekihtide (rasterandmed) lisamine vastavat 

teenust pakkuvast veebiserverist 

> Feature (WFS) – WFS formaadis andmekihtide 

(vektorandmed) lisamine vastavat teenust 

pakkuvast veebiserverist 

> Mapping (WMTS) – WMTS formaadis 

andmekihtide (eeltailitud rasterandmed) lisamine 

vastavat teenust pakkuvast veebiserverist 
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Add Theme – teemakaartide loomine 

Add To Map: 

 

> Legend – kartograafilise legendi loomine 

> Gridlines – võrgustiku lisamine kaardile 

> Scalebar – joonmõõtkava loomine 

 

Cosmetic: 

 

> Clear Cosmetic Layer – ajutisel joonestuskihil oleva info kustutamine 

> Save Cosmetic Layer – – ajutise joonestuskihi objektide salvestamine püsivale 

kihile 

 

Select: 

 

> Select – objektide valimine ükshaaval (nii kaardi–, kui tabeliakna kaudu) 

> Radius Selection – ringikujulisest alast kaardiaknas objektide valimine 

> Marquee Selection – ristkülikukujulisest alast kaardiaknas objektide valimine 

> Polygon Selection – kaardiaknas objektide valik joonistatava hulknurga seest 

> Boundary Selection – kinnise areaalelemendi sisse jäävate objektide valimine kaardiaknas 
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SQL Select –  objektide valimine SQL päringu abil 

Invert –  objektide valiku muutmine vastupidiseks (valitakse objektid, mis algselt 

ei olnud valitud) 

Clear – objektide valiku tühistamine 

Find: 

 

> Find – otsib üles ja kuvab kaardiakna keskele (või tabeliakna esimeseks reaks) valitud objekti 

> Find Address – aadressi otsimine (eelduseks vastav veebiserver, mis geokodeerimisteenust 

pakub) 

> Mark – otsib objekte vastavalt kriteeriumitele ja märgistab need kaardil 

 

Pan – kaardipildi nihutamine„käpaga" 

Zoom In – kaardiakna kuva suurendamine 

Zoom Out – kaardiakna kuva vähendamine 

Previous View – eelmise akna kuvamispiirkonna taastamine 

Move To – Aadressi ja objekti otsimine ning kaardipildi nihutamine sellele 

Zoom To: 

 

> Entire Selection Layer – kaardiaknas väljavalitud kihi näitamine kogu ulatuses 

> Extents of Selected Objects – kõigi väljavalitud objektide aknasse mahutamine 

> Entire Layer – terve kihi objektide aknasse mahutamine 

> Entire Map – kogu kaardipildi aknasse mahutamine 

> Nearest Tile Server Level –  

Label Tool – objektile märgise lisamine 

Selectable – kontrollimine, kas märgised on valitavad 

Clear Custom – muudetud märgiste eemaldamine 

Priority – märgise prioriteedi muutmine 

Map Tools: 
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> Ruler – vahemaade mõõtmine 

> Statistics – statistikaakna näitamine 

> Explorer – tööseisu haldamise akna avamine 

> Info – objekti info akna avamine 

> Hotlink – võimaldab elemendile klikkides vaadata elemendiga seotud viidet (fail või 

URL) 

> Redraw – aktiivse akna kuva värskendamine 

 

Redistricter: 

 

> New Redistricter Window – avab uue piirkondadeks ümberjaotamise analüüsi 

akna 

> Set Target – aktiivse grupi valik 

> Assign District – valitud objektide lisamine aktiivse grupi alla 

> Add District – uue tühja grupi lisamine 

> Delete District – rea päise kaudu valitud grupi kustutamine 

> Options – gruppide järjestuse jms määramine 

 

Map Options – kaardi seadete muutmine 

Hotlink Options – viidete muutmine 

Drag Map – kaardipildi tõstmine teise programmi (nt Word) 

Lock Scale – lukusta mõõtkava nii, et kaardiakna suuruse muutmine ei muuda kaardi mõõtkava 

 

2.2.4 Spatial menüü  

 

 

Copy – info kopeerimine lõikepuhvrisse 

Paste – info toomine lõikepuhvrist tagasi 

Cut – info viimine lõikepuhvrisse 
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Undo – viimase muudatuse tagasi võtmine 

Select: 

 

> Select – objektide valimine ükshaaval (nii kaardi–, kui tabeliakna kaudu) 

> Radius Selection – ringikujulisest alast kaardiaknas objektide valimine 

> Marquee Selection – ristkülikukujulisest alast kaardiaknas objektide valimine 

> Polygon Selection – kaardiaknas objektide valik joonistatava hulknurga seest 

> Boundary Selection – kinnise areaalelemendi sisse jäävate objektide 

valimine kaardiaknas 

SQL Select – objektide valimine SQL päringu abil 

Invert – objektide valiku muutmine vastupidiseks (valitakse objektid, mis algselt ei olnud valitud) 

Clear – objektide valiku tühistamine 

Find: 

 

> Find – otsib üles ja kuvab kaardiakna keskele (või tabeliakna esimeseks reaks) valitud objekti 

> Find Address – aadressi otsimine (eelduseks vastav veebiserver, mis geokodeerimisteenust 

pakub) 

> Mark – otsib objekte vastavalt kriteeriumitele ja märgistab need kaardil 

 

Set Target – sihtmärgi määramine 

Clear Target – sihtmärgi tühistamine 

Erase: 
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> Erase Target – sihtmärgi kustutamine valitud objekti seest 

> Erase Outside Target – väljapoole valitud objekti jääva sihtmärgi osa kustutamine 

 

Combine: 

 

> Combine Selected Objects – valitud objektide liitmine 

> Combine Using Column – objektide liitmine tabelis oleva ühise tunnuse järgi 

 

Split: 

 

> Split Target – sihtmärgi lõikamine–poolitamine areaalobjekti abil 

> Split Target Using Polyline – sihtmärgi poolitamine joonobjekti abil 

> Polyline Split at Node – murdjoone poolitamine (nurga)punktis 

 

Disaggregate – 

Buffer: 

 

> Buffer Objects – puhvertsoonide loomine valitud objektide ümber 

> Buffer Table – puhvertsoonide loomine ja salvestamine tabelisse 

> Convex Hull – minimum bounding polygon’i ehk objekti ümber vähima ümara areaalobjekti loomine 

 

Nodes: 
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> Snap to Nodes – objekti nurgapunktist kinni haaramine 

> Reshape – objekti kuju muutmine 

> Add Node – nurgapunktide lisamine 

> Overlay Nodes onto Target – ristumiskohtadesse nurgapunktide 

lisamine 

 

Fix/Clean: 

 

> Check Regions – topoloogia kontrollimine: saab kontrollida kohti, kus areaal ristub iseendaga (self 

– intersections), erinevate areaalide kattuvuse kohti (overlaps) ning kohti, kus areaalide piir peaks 

kattuma, kuid tegelikkuses ei kattu (vahel on auk –gap) 

> Clean Objects – topoloogia parandamine 

> Snap/Thin – objektide parandamine nurgapunktide nihutamise ja eemaldamise kaudu 

> Smooth Line – silumine (teeb murdjoone kurviliseks) 

> Unsmooth Lines – silumise tühistamine (eemaldab murdjoone kurvilisuse) 

 

Transform: 

 

> Offset Object – objekti kopeerimine teatud kaugusele ja nurga all 

> Rotate Object – objekti pööramine 

 

Convert to Polylines – 
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Clip Region: 

 

> Set Clip Region – lõikamispiirkonna määramine 

> Clip Region On/Off – lõikamispiirkonna kuvamise 

sisse/välja lülitamine 

 

Digitizer Setup – digitaliseerimisseadme parameetrite määramine 

Clear Map Objects – valitud objektide graafilise info kustutamine 

Insert: 

 

> Symbol – punktsümboli joonistamine 

> Text – teksti sisestamine 

> Line – ühe joonelõigu joonistamine 

> Polyline – murdjoone joonistamine  

> Arc – kaare joonistamine 

> Polygon – polügooni (hulknurkse ala, regiooni, 

areaali) joonistamine 

> Ellipse – ellipsi joonistamine 

> Rectangle – ristküliku joonistamine 

> Rounded – ümardatud nurkadega ristküliku 

joonistamine 

 

Style: 

 

> Symbol Style – punktsümboli kuju, värvi, suuruse muutmine 

> Line Style – joone värvi–, stiili– ja paksuse muutmine 

> Region Style – polügooni värvi, mustri, äärejoone muutmine 

> Text Style – teksti värvi–, suuruse– ja fondi muutmine 

 

Regions: 
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> Convert to Regions – polügooniks konverteerimine 

> Enclose (Polylines to Regions) – piirjoontest areaalide moodustamine 

> Drive Regions (Objects) – mööda teedevõrku kaugustsooni arvutamine 

> Drive Regions (Table) – mööda teedevõrku kaugustsooni arvutamine tabeli objektide jaoks 

> Voronoi (Objects) – Voronoi polügoonide moodustamine 

> Voronoi (Table) – Voronoi polügoonide moodustamine tabeli objektide jaoks 

 

Create Points – punktobjektide sidumine koordinaatidega tabelis sisalduvate X ja Y koordinaatide järgi 

Geocode: 

 

> Geocode – tabelandmete automaatne koordinaatidega sidumine 

(eeldab alus–aadress–andmebaasi olemasolu) 

> Geocode Using Server – tabelandmete automaatne koordinaatidega 

sidumine (eelduseks vastav teenusepakkuja) 

 

 

2.2.5 Layout menüü 
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New Layout – uue kujundusakna avamine 

Open: 

 

> Open  Workspace – tööseisu avamine 

> Add Workspace – tööseisu lisamine 

> Table – tabeli avamine 

> Import – graafikafaili importimine 

> Universal Data – teiste formaatide otse avamine 

ilma konverteerimata 

> Database Table – ühenduse loomine välise 

andmebaasi tabeliga 

> Program – MapBasicu programmi avamine 

> Aerial – Bing ortofoto veebikaardi avamine 

> Roads – Bing teede veebikaardi avamine 

> Hybrid – Bing hübriid veebikaardi avamine 

> Mapping (WMS) – WMS formaadis andmekihtide 

(rasterandmed) lisamine vastavat teenust pakkuvast 

veebiserverist 

> Feature (WFS) – WFS formaadis andmekihtide 

(vektorandmed) lisamine vastavat teenust pakkuvast 

veebiserverist 

> Mapping (WMTS) – WMTS formaadis 

andmekihtide (eeltailitud rasterandmed) lisamine 

vastavat teenust pakkuvast veebiserverist 

 

Page Setup – väljatrüki lehe seadete paikapanemine 

Copy – info kopeerimine lõikepuhvrisse 

Paste – info toomine lõikepuhvrist tagasi 

Cut – info viimine lõikepuhvrisse 

Map – kujundusaknasse uue kaardi sisestamine 

Legend – legendi lisamine kujundusse 

Browser: tabeliakna lisamine kujundusse 

Text – teksti sisestamine 

Image – pildi lisamine  

Scalebar – mõõtkava lisamine 

Insert: 

 

> Symbol – punktsümboli joonistamine 

> Text – teksti sisestamine 

> Line – ühe joonelõigu joonistamine 

> Polyline – murdjoone joonistamine  

> Arc – kaare joonistamine 

> Polygon – polügooni (hulknurkse ala, 

regiooni, areaali) joonistamine 

> Ellipse – ellipsi joonistamine 

> Rectangle – ristküliku joonistamine 

> Rounded – ümardatud nurkadega ristküliku 

joonistamine 
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Frames: 

 

> New Frame – uue raami asetamine kujundusaknasse 

> Remove Content – eemalda raami sisu 

> Remove – raami kustutamine 

 

Reorder: 

 

> Bring to Front – valitud objektide toomine ettepoole 

> Send to Back – valitud objektide saatmine tahapoole 

 

Guide: 

 

> Add Vertical Guideline – vertikaalse abijoone lisamine 

> Add Horizontal Guideline – horisontaalse abijoone lisamine 

> Disable Guidelines – abijoonte peitmine 

> Remove All Guidelines – abijoonte kustutamine 
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(vasakult paremale)  

I rida: Snap To  Left; Snap To 

Top; Align Horizontal Center 

 

II rida: Snap To Right; Snap To 

Bottom; Align Vertical Center 

 

Snap To  Left – objekti nihutamine lähima vasakpoolse abijooneni 

Snap To Top – objekti nihutamine lähima ülemise abijooneni 

Align Horizontal Center – objektide nihutamine horisontaalselt, et 

keskpunktid asuksid ühel vertikaalsel sirgel 

Snap To Right – objekti nihutamine lähima parempoolse abijooneni 

Snap To Bottom – objekti nihutamine lähima alumise abijooneni 

Align Vertical Center – objektide nihutamine vertikaalselt, et keskpunktid 

asuksid ühel horisontaalsel sirgel 

Grid – näita/peida kujundusakna abiruudustik 

Snap to Grid – abiruudustiku külge haakimise aktiveerimine 

Grid Size – abiruudustiku suuruse muutmine  

Select – objektide valimine kujundusaknas 

Zoom In – kujundusakna kuva suurendamine 

Zoom Out – kujundusakna kuva vähendamine  

Pan – raami nihutamine„käpaga" 

 

 
(vasakult paremale)  

I rida: Font Family; Font Size; Increase Font Size; 

Decrease Font Size; Rotate Frame 

II rida: Bold; Italic; Font Color; Left Align Text; 

Center Text; Right Align Text; Line Spacing; 

Symbol Styles; Frame 

 

Font Family – kirjastiili määramine 

Font Size – kirja suuruse määramine 

Increase Font Size – kirja suurendamine 

Decrease Font Size – kirja vähendamine 

Rotate Frame – raami pööramine etteantava nurga võrra 

Bold – paks trükk 

Italic – kaldkiri 

Font Color – teksti värv 

Left Align Text – teksti joondamine vasakule 

Center Text – teksti joondamine keskele 

Right Align Text – teksti joondamine paremale 

Line Spacing – reavahe 

Symbol Styles – sümbolobjektide stiili muutmine 

Frame – raamistiili muutmine 

Style: 

 

> Symbol Style – punktsümboli kuju, värvi, suuruse muutmine 

> Line Style – joone värvi–, stiili– ja paksuse muutmine 

> Region Style – polügooni värvi, mustri, äärejoone muutmine 

 

 

Print – akna välja trükkimine 
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Create – aktiivsest aknast PDF dokumendi loomine 

Save Image – aktiivse akna salvestamine pildina 

 

2.2.6 Raster menüü 

 

 

  

 

Open: 

 

> Open Table – tabeli avamine 

> Open Workspace – tööseisu avamine 

 

Copy Raster – rasterfaili koopia salvestamine  

Delete Raster – rasterfaili kustutamine 

Rename – rasterfaili ümbernimetamine 

Raster Info – rasterfaili inormatsiooni kuvamine 

Statistics – rasterandmete statistika kuvamine 

Cell Value: 
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> Full – rastrielemendi info kuvamine eraldi aknas 

> Status Bar – rastrielemendi info kuvamine olekuribal 

 

Create Raster – rastri loomine vektorandmetest 

Create Raster Multifile – rastri loomine mitmest vektorfailist 

Field – rastri kuvamine välja põhjal 

Display – rastri kuvamisviisi valimine 

Bands –kuvatavate värvikanalite valimine 

Color – rastri värviskeemi muutmine 

Color Stretch – rastri värvide kuvamise seadete muutmine 

Advanced Color – histogrammi abil rastri värviseadete valimine 

Hill Shade – nõlvavarjutuse lisamine  

Raster Quality – rasterpindade kuvamise kvaliteedi parandamine interpoleerimise abil 

Convert – rastri teisendamine muudesse formaatidesse (nt MRR) 

Resample – muudetud kõrguse ja laiusega rastri loomine 

Reproject –  rastri projektsiooni muutmine 

Clip – rastri lõikamine areaaliga 

Merge – rastrite liitmine üheks 

Rasterize – vektorfaili teisendamine rastriks 

Combine – kahe või enama rastri ühendamine MRR failiks 

Point Inspect – loob tabeli punktobjektidest ja nende asukohas olevate pikslite andmetest 

Region Stats – rastristatistika leidmine areaalide poolt kaetud ala kohta 

Line Stats – joonobjekti tabeli täiendamine pikslite statistiliste parameetritega 

Calculator – rasterarvutuste läbiviimiseks mõeldud tööriist 

Contour – samakõrgusjoonte loomine klassifitseeritud rasterandmetest 

Viewshed – mingist rastripunktist lähtuva vaatevälja leidmine kõrgusmudelil 

Classify – rastri pikslitele uute väärtuste määramine 

Cross Section –piksliväärtuste leidmine piki joonobjekti 

Line of Sight – kahe punkti vahelise nähtavuse kontrollimine 

Surface – pinnamoe iseloomulike näitajate leidmine 

Filter – rasterpildi sujuvamaks tegemine 

Volume – tasapinnast kõrgemal või madalamal asuva pinna mahu arvutamine  

Export – rastri eksportimine ASCII formaati 

Import ASCII – ASCII formaadis rastri importimine 

Profile: 
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> Interactive Cross Section – piksliväärtuste leidmine piki joonobjekti 

> Interactive Line of Sight – kahe punkti vahelise nähtavuse kontrollimine 

 

Help – MapInfo abi 

 

2.2.7 Style menüü 

Vektorandmete korral: 

 

Rasterandmete korral: 

 

Apply Styles – kihi kujunduse sisse/välja lülitamine 

Use Stacked Styles – kombineeritud stiilide kasutamine 

Region Style – polügooni värvi, mustri, äärejoone muutmine 

Line Style – joone värvi–, stiili– ja paksuse muutmine 

Symbol Style – punktsümboli kuju, värvi, suuruse muutmine 

Text Style – teksti värvi–, suuruse– ja fondi muutmine 

Symbol Rotation – sümbolite keeramine etteantud nurga võrra 

Layer – kihi läbipaistvuse sättimine 

Label – märgiste läbipaistvuse sättimine 

Show Nodes – käänupunktide näitamine/ peitmine 

Show Centroids – objekti keskkoha näitamine/ peitmine 

Show Line Direction – joonobjektide joonistamissuuna näitamine/ peitmine 

 

Layer – kihi läbipaistvuse sättimine 

Label – märgiste läbipaistvuse sättimine 

Contrast – rasterkihi konrastsuse määramine 

Brightness – rasterkihi heleduse määramine 

Gray Scale – värvilise rastri kuvamine must-valgelt 

Field – rastri kuvamine välja põhjal 

Display – rastri kuvamisviisi valimine 

Bands –kuvatavate värvikanalite valimine 

Color – rastri värviskeemi muutmine 

Color Stretch – rastri värvide kuvamise seadete muutmine 

Advanced Color – histogrammi abil rastri värviseadete valimine 
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Hill Shade – nõlvavarjutuse lisamine  

Raster Quality – rasterpindade kuvamise kvaliteedi parandamine interpoleerimise abil 

 

2.2.8 Labels menüü 

 

Label Using – millise veeru andmeid märgiste lisamisel kasutada 

Abbreviate with – millise veeru andmeid kasutatakse lühendina, kui märgiseid ei saa täispikkuses kuvada 

Label Rules: 

Punktobjekti korral: 

 

> Default Point Labeling – märgise lisamine 

punktobjektile vaikimisi määratud seadistuste järgi 

 

Joonobjekti korral: 

 

> Curved – märgis kuvatakse pikki murdjoont võttes 

arvesse joone ruumikuju 

> Curved with Fallback – märgis kuvatakse pikki 

murdjoont, kuid vajadusel võib selle asemel seda ka 

keerata vastavalt joone suunale 

> Overhang – kui suur protsent märgisest võib jääda üle 

joone ääre 

> Rotated – märgis keeratakse vastavalt joone suunale 

> Horizontal – märgis paigutatakse horisontaalselt joone 

juurde 

 

Pindobjekti korral: 

 

> Auto Size – teksti suurust muudetakse mahutamaks seda 

pindobjekti sisse 

> Auto Size with Callout – teksti suurust muudetakse 

mahutamaks seda pindobjekti sisse ja vajadusel 

paigutatakse märgis väljapoole pindobjekti 

> Auto Size with Overflow – teksti suurust muudetakse 

mahutamaks seda pindobjekti sisse, kuid vajadusel võivad 

need ulatuda ka kõrvalasuvatele aladele 

> Font Reduction – mitme protsendi piires võib fonti 

vähendada 

> Auto Position – määratud märgise paigutamise reegleid 

ignoreeritakse 

> Auto Position with Callout – määratud märgise 

paigutamise reegleid ignoreeritakse ja vajadusel 

paigutatakse märgis väljapoole pindobjekti 

> Auto Position with Overflow – määratud märgise 

paigutamise reegleid ignoreeritakse ja vajadusel võivad 

need ulatuda ka kõrvalasuvatele aladele 

> Font Size – mitut erinevat fonti suurust võib ühe kihi 

märgiste puhul kasutada 
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> Centroid – märgised paigutatakse ala keskpunkti 

 

 

 

Label Position – märgise paiknemine objekti suhtes 

 

Offset – kui kaugel paikneb märgis oma ankrust 

Label Overlap – kuidas toimub märgiste kujutamine, kui esineb kattumist 

Allow Duplicates – sama märgise kordumine erinevate objektide korral 

Label Partial Objects – objektide, mille keskpunkt ei jää kaardile, märgistamine 

 

 

(vasakult paremale)  

I rida: Font Family; Font Size; Increase Font 

Size; Decrease Font Size 

II rida: Bold; Italic; Underline; All Capitals; 

Expanded; Shadow; Font Color; Halo; 

Highlight; Label Background Color 

Font Family – kirjastiili määramine 

Font Size – märgiste suuruse määramine 

Increase Font Size – märgiste suurendamine 

Decrease Font Size – märgiste vähendamine 

Bold – paks trükk 

Italic – kaldkiri 

Underline – märgiste allajoonimine 

All Capitals – märgiste kuvamine läbiva suurtähega 

Expanded – tähemärkide vahel on lisatühik 

Shadow – varju kuvamine 

Font Color – teksti värv 

Halo – taustaks joonistatakse halo 

Highlight – märgiste esiletõstmine 

Label Background Color – märgise taustavärv 

Label Lines – väljaspoole pindobjekti paigutatud märgistele osutavate joonte 

kujundamine 

Enable Preview – eelvaate võimaldamine 

 

2.3 Aknad 

Akendest on alati üks (ja ainult üks) aktiivne, seda on näha sellest, et akna päis kuvatakse tumedama värviga 

ning kõik operatsioonid saavad toimuda ja menüükäske saab valida vaid vastavalt aktiivsele aknale. Näiteks ei 

saa valida joonistamiskäske, kui aktiivne on tabeliaken, joonistamiseks tuleb esmalt teha aktiivseks kaardiaken. 

Selleks tuleb klõpsata hiirega kaardiakna ülaservas ehk päises. 

Aknad võivad olla sakkidena (tabbed), programmiakna servale kleebitud  (dockable) või ujuvad (floating). 

Valiku saab teha akna päisele hiire parema klahviga vajutamise tulemusel avanevas hüpikmenüüs. Sakkidena 

(ka paneelidena ja tabuleeritult) paigutatud aknaid saab viia ka gruppidesse (paremklikk > New Horizontal Tab 

Group /New Vertical Tab Group).  

Kaardi–, tabeli– ja kujundusaknas saab kasutada käskude kiirvalikuks ka hiire hüpikmenüüd, mis sisaldab 

enamkasutatavaid käske (enamasti sageli mugavuse mõttes dubleerib menüükäske) ning avaneb vajutades 

hiirekursoriga akna kohal olles hiire paremale nupule. 

2.4 Failide (tabelite, kihtide ja tööseisude) avamine ja importimine 

Failide avamine toimub Open käsuga, mille võib leida nii Home, Table kui ka Map menüüst. Lisaks on Home 

menüüs eraldi välja toodud tabeli avamise käsk (Open Table), sest selle kasutamist esineb kõige sagedamini. 

MapInfo on võimeline andmestikke avama või importima järgmistest formaatidest: 

 Open > Table käsuga andmete avamise dialoogiaken on väga sarnane Microsoft Office programmidele. 

Tabeli avamiseks peab faili tüüp (Files of type) olema MapInfo (*.TAB), tööseisu puhul Worskpace (*.Wor).  

Samas saab määrata kindlaks ka tabeli(te) avamismeetodi: 
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Automatic – tabel(id) avatakse automaatselt sobivas aknas (enamasti lisatakse info aktiivsele kaardiaknale 

juurde, kui need iseloomustavad looduses sama piirkonda ja on samas koordinaatsüsteemis, muidu avatakse 

eraldi kaardiaken) 

Browser – avatakse ainult tabeliaknad, kaardiaknas kihte ei näidata 

Current Mapper – püütakse paigutada uus tabel aktiivsesse kaardiaknasse ka siis, kui avatavad tabelid ei sisalda 

infot sama piirkonna kohta looduses või ei ole samas koordinaatsüsteemis 

New Mapper – tabel(id) avatakse ühte uude kaardiaknasse 

No View – tabel(id) avatakse, kuid infot ei näidata üheski aknas 

Peale MapInfo .TAB faili saab Open dialoogiakna kaudu avada ka MapInfo tööseise (workspace) ja teistes 

andmeformaatides faile: tabeleid (Microsoft Access .MDB ja .ACCDB, Microsoft Excel .XLS ja .XLSX, dBase 

.DBF, Delimited ASCII, Comma .CSV, Lotus 1-2-3 .WK1, . WKS, . WK3 ja . WK4, SQLite .SQLITE, Geopackage 

.GPKG.), rasterfaile (Raster Image, GRID Image) ning ESRI Shape .shp formaadis faile (ESRI Shapefile .SHP). 

Neil juhtudel luuakse esimesel avamisel alati tabeli definitsioonfail .TAB ning hiljem saab neid andmestikke 

MapInfos avada, nagu iga teist MapInfo tabelit *.TAB faili kaudu. Selleks, et tabelit kaardina kujutada, peab see 

sisaldama objektide X ja Y koordinaate. Koordinaatide lisamist tabelile nimetatakse geokodeerimiseks 

(geocoding). Näiteks MS Excel failis olevate X ja Y koordinaatide väärtuste järgi saab paigutada punktobjektid 

kaardile (Spatial > Create Points). 

Create copy in Mapinfo format for read/write - Teistes formaatides, kui *.tab, avatakse tavaliselt ainult 

lugemisõigustes vaade(Read Only). Selleks, et teist formaati faili avamisel tehaks kohe koopia MapInfo 

formaati, et andmeid oleks võimalik muuta, peab vajutama selle linnukese sisse.   

Kihid e. Layer–ided on loogilised infokihid, millest neid üksteise peale asetades koosneb arvutikaart. MapInfos 

on iga kiht eraldi tabel. Kihil on oma nimi, mis on vaikimisi TAB faili nimi; kui juhtumisi avatakse mitu korda 

erinevatest kataloogidest sama nimega TAB fail, siis lisatakse tabelinimele allkriipsuga järjekorranumber. 

Näiteks majad, majad_2, majad_3, jne. 

 Open > Web Services käskudega: 
o WFS formaadis andmekihte (vektorandmed) vastavat teenust pakkuvast veebiserverist 

o WMS formaadis andmekihte (rasterandmed) vastavat teenust pakkuvast veebiserverist. Avalikke WMS 

teenuseid pakub Maa-amet. Vastavad WMS serverite aadressid leiab  maaameti 

kodulehelt:(http://www.maaamet.ee)  

o WMTS formaadis andmekihte (eeltailitud rasterandmed) vastavat teenust pakkuvast veebiserverist 

 Open > Database Table: 
o ODBC ühenduse kaudu kõikvõimalikke tabeleid erinevatest välistest andmebaasidest 

o FDO ühenduse kaudu erinevaid andmeid teenust toetavatest andmebaasidest 

 Open > Universal Data: 
Sellega käivitatakse FME Andmekonverter, millega saab avada erinevatest formaatidest andmeid. 

o .DGN, .DWG, .DXF – Microstation DGN, AutoCAD DWG, AutoCAD DXF ehk kõiki levinud CAD 

graafika formaate (sh. DWG 2007/2008). 

o e00 – Arc/INFO andmevahetusformaat 

(eksportformaat)  

o .MDB ja .SDE– ESRI geoandmebaasi 

ning ESRI ArcSDE andmebaas 

o .KMZ, .KML – Google Earth kaardid 

o *CATD.DDF – STDS formaat 

o + veel teisi formaate() 

Käsu valimise järel avaneb järgnev dialoogiaken:  

  

 

Vaikimis proovitakse tuvastada failiformaat etteantud failist <Guess from Dataset>, kuid failitüüp on 

võimalik ka käsitsi ette anda. Selleks klikkame Format lahtri kõrval olevale noolele 

http://www.maaamet.ee/
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. Avaneb rippmenüü, kust valime 

More Formats... ning avanevas dialoogiaknas sisendformaadi, mida me edaspidi kasutada soovime. 

Klõpsates nupul OK lisatakse see eelnevalt mainitud noole alt avanevasse formaatide kiirvaliku 

rippmenüüsse. 

 
 

Vahemärkus: Juhul, kui ESRI formaatide read on hallid ja linnukese lülitamine ei toimi, siis tähendab see 

kahjuks seda, et nendest formaatidest ei saa enne andmeid otse avada, kui arvutisse ei ole installeeritud ESRI 

tarkvara (geoandmebaasi puhul ArcView või ArcEditor või ArcInfo versioon 8 või hilisem). Seega - tugi on 

MapInfos olemas, aga litsentsitingimused on lihtsalt nii karmid. Add More Formats nupu all avatakse firma 

Safe Software veebileht, mis annab informatsiooni tingimuste kohta, mis võimaldavad MapInfole lisada kuni 

150 maailmas kasutust leidva GIS formaadi toetuse. 

 

 Dataset lahtri kõrval nupuga  saab otsida sisendfaili(d), nupuga  saab ette anda sisendfailide 

kataloogi(d), milles olevad kõik failid korraga avatakse. 

Coordinate Systems alt määrata kindlasti sisendfailide koordinaatsüsteem. Kui MapInfo vaikimisi 

joonistamise täpsus on ebapiisav (näiteks tiheasulates teostusjooniste avamisel, siis saab kasutada muudetud 

parameetritega L-EST97 koordinaatsüsteemi kirjeldust - vt. täpsemalt leheküljelt  38). 

 

Parameters nupu alt avaneb dialoogiaken, milles saab täpsustada konverteri käitumist mitmetes aspektides 

igale sisendformaadile spetsiifiliselt: 

 

MicroStation DGN failide puhul: 

Group Elements By – kuidas elemendid grupeeritakse (ja kui palju MapInfo TAB faile tekib): 

Level Numbers– originaalfaili(de) kihi numbri järgi (tekib tõenäoliselt palju TAB faile) 

Level Names – originaalfaili(de) kihtide nimede järgi (tekib jällegi palju TAB faile) 

Geometry – graafiliste elementide tüüpide järgi (sarnaselt Universal Translator’iga) 

Schema - Level Numbers – schema ja kihtide numbrite järgi  

Schema - Level Names – schema ja kihtide nimede järgi 

Element Options – kuidas käitutakse teatud tüüpi graafilise infoga 

Expand Named Cells – korduvelemendid (cells) lõhutakse ära lihtsamateks graafilisteks 

elementideks. Kui linnuke on väljas, siis asendatakse korduvelement punktsümboliga. 

Preserve Named Cell Insert Points – korduvelemendi ankurpunkti (origin) asukohas 

näidatakse punktsümbolit (soovitav valik = sisse lülitamata). 

Expand Unnamed (Group Hole) Cells – lõhutakse aukudega areaalid ja elementide grupid 

üksikareaalideks. Kui linnuke on väljas, siis säilivad auguga elemendid ja grupid. 

Preserve Unnamed Cell Insert Points – auguga areaali või grupi keskkohas kuvatakse 

täiendavat punktsümoblit (soovitav valik = sisse lülitamata). 

External Reference File Options – kuidas käitutakse taustafailidega 

Read Elements From Reference Files – avatakse ka joonisfailidega seotud 

taustafailide info (ning omakorda taustafailidega seotud taustafailide info) 

Max Depth of Reference Files to Read – mis tasemeni taustafailide infot 

lugeda 

Use Reference's Parent Model (V8 Only) – V8 DGN failide puhul loeb 

vanem mudeli info kaasa. 

Keep Elements That Represent Reference Files (V8 Only) – säilita taustafaili 

elemendid 
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Output Tags as Text - DGN graafikaga seotud tag-atribuudid konverteeritakse 

tekstelementideks 

Attribute Options – kuidas käitutakse atribuutidega 

Read Tag Attributes – 

Read Xattributes As List (V8 Only) - 

Linkage Extraction – kuidas käitutakse andmebaasiseoseid sisaldavate identifikaatoritega  

MSLinks – näitab esimest kolme ID väärtust  

Framme – selles formaadis andmestikke Eestis ei esine 

Coordinate Units By – milline on avatava graafika puhul koordinaatsüsteemi põhiühik 

Master – avatava graafika koordinaatsüsteemi ühikud on antud põhiühikutes 

Sub - avatava graafika koordinaatsüsteemi ühikud on antud alamühikutes 

UOR - avatava graafika koordinaatsüsteemi ühikud on antud resolutsiooniühikutes 

Override Global Origin – vajadusel koordinaatsüsteemi alguspunkti nihutamine 

UOR X Global Origin – alguspunkti nihutamine koordinaati X 

UOR Y Global Origin – alguspunkti nihutamine koordinaati Y 

UOR Z Global Origin – alguspunkti nihutamine koordinaati Z 

Schema Attributes – 

Additional Attributes to Expose - 

Use Search Envelope – vali importimiseks vaid andmed, mis jäävad piiritletava ala sisse 

Minimum X – minimaalne X-väärtus 

Minimum Y – minimaalnle Y-väärtus 

Maximum X – maksimaalne X-väärtus 

Maximum Y – maksimaalne Y-väärtus 

Clip to Search Envelope – kas lõigata alast välja ulatuvad objektid ala piiriga 

Advanced – täpsemate seadete valimine 

Drop Complex Chains/Shapes – aheljooned ja liitpolügoonid (mitmest iseseisvast joonest või 

polügoonist koosnevad liitobjektid) lõhutakse komponentideks. Kirjet liitobjekti enda kohta ei 

säilitada ja sidususe info kaotatakse 

Split Multi Text – lõhutakse reavahetusega tekstid eraldi tekstelementideks (soovitav valik = 

sisse lülitatud). 

Drop Dimensions – sisse lülitatult lõhutakse mõõtjooned lihtsamateks graafilisteks 

elementideks 

Apply World File (.wld) – kasuta ESRI World faili. Fail peab olema sama nimega kui avatav 

dgn fail ja asuma samas kataloogis 

Preserve Curves – DGN failis olevaid kaari ei muudeta murdjoonteks 

Remove Duplicate Points – eemaldab punktid, mille puhul on nii X- kui Y-koordinaat samad 

Assume Master Units Equal Working Units – eeldatakse, et tööühikud on samad põhiühikutega 

UOR to FME Units Scale Factor – mitu maapinnaühikut vastab ühele resolutsiooniühikule 

UORS PER SUB UNIT – mitu resolutsiooniühikut vastab ühele alamühikule 

SUBS PER MASTER UNIT – mitu resolutsiooniühikut vastab ühele ülemühikule  

Elevation Shift Factor – millises ulatuses kõrgusandmeid võimendada 

Number of Interpolated Curve Vertices – mitmest punktist interpoleeritakse joon kumera 

objekti korral 

 

Konverteerimise käigus ei konverteerita shared cell tüüpi graafikat, vaid ainult nö tavalisi korduvelemente! 

Ei konverteerita punktelemente (ehk null-pikkusega jooni). Ei konverteerita elementide sisu värvi, kui see 

erineb äärejoone värvist (opaque).  

 

AutoCAD DWG failide puhul: 

Group Entities By – kuidas elemendid grupeeritakse (ja kui palju MapInfo TAB faile tekib) 

Layer Name – kihi alusel 

Geometry – geomeetria alusel 

Attribute Schema – atribuutide alusel 

Entity Options – kuidas käitutakse elementidega  

Explode Blocks into Entities  – block tüüpi elemendid lõhutakse lihtsamateks elementideks 

Use Block Feature Type for Components – elemendid saavad olema block objektiga 

sama tüüpi. Linnukese eemaldamisel on need vastavad kihile. 

Use Block Layer Information for Components – elemendid paigutatakse block objekti 

kihile. Linnukese eemaldamisel paigutatakse elemendid nende enda kihile 

Store Insert Location on Components – elemendid säilitavad info block objekti 

asukoha kohta 

Preserve Insert Points –   

Explode Selected Blocks – lõhutakse valitud block elemendid 
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Read Visible Attributes as Text Entities - kas nähtavad atribuudid säilitatakse objekti 

tunnustena või konverteeritakse nad ka eraldi tekstiobjektideks 

Explode MText Entities – multitekst tüüpi objektid lõhutakse tekstielementideks säilitades 

multitekst objekti stiili ja asukoha 

Read Polylines as 2.5D – joonobjektide kõrgusatribuut konverteeritakse z koordinaadiks. 

Kehtib AutoCADi 2D joonobjektide kohta  

Model and Paper Space Options – kuidas käitutakse mudeliruumi ja lehekülje andmetega 

Read Model Space – kas loetakse mudeliruumi andmed 

Read Paper Space – kas loetakse ka lehekülje andmed 

Read Selected Paper Spaces – loe valitud lehekülgede andmed 

Read Paper Space Layout Information – loe lehekülje kujunduse andmed 

Read Model Space Entities Through Viewport – loe mudeliruumi elemente läbi  

Attribute Options – kuidas käitutakse atribuutidega 

Read Interpreted Extended Entity Data – 

Read Extended Entity Data as List - 

Read Attribute Entity Data as List – 

Entity Xrecord Data Reading – 

Schema Attributes – schema atribuudid 

Additional Attributes to Expose - Lisa atribuudid mida arvestatakse objektitüübi 

konverteerimisel. 

Use Search Envelope – vali importimiseks vaid andmed, mis jäävad piiritletava ala sisse 

Minimum X – minimaalne X-väärtus 

Minimum Y – minimaalnle Y-väärtus 

Maximum X – maksimaalne X-väärtus 

Maximum Y – maksimaalne Y-väärtus 

Clip to Search Envelope – kas lõigata alast välja ulatuvad objektid ala piiriga 

Advanced – täpsemate seadete valimine 

Resolve Entity Color – elemendi värv säilitatakse (soovituslik valik on linnuke sisse lülitatud) 

Preserve Complex Hatches and MPolygons – kas mustrid ja liitpolügoonid säilitatakse või 

lõhutakse lihtobjektideks 

Preserve Clipped Rasters – lõigatud rastrite puhul loetakse sisse terve rastri info 

Explode Dimensions – 

Evaluate Multi-line Entity Geometry – joonobjektide puhul, kus on augud sees või mis 

koosneb mitmest joonest, tehakse põhjalikum kontroll. Ilma linnukeseta võetakse ainult joonte 

kujupunktid. 

Store Spline Definitions – splaini koefitsent säilitatakse atribuutides 

Store Bulge Info – 

Ignore User Coordinate System (UCS) – Ignoreeritakse kasutaja defineeritud 

koordinaatsüsteemi 

Convert Zero Length Arcs to Points – nullpikkusega kaared muudetakse punktideks 

Read Groups – kas loetakse ka AutoCAD-i grupp-tüüpi elemendid 

Read Extrenal References –loetakse elemente, mis on väliste viidetega 

Store Layer Properties on Features – kihi omadeused salvestatakse atribuutidena objekti 

juurde 

Output Zero Length Lines as Lines – nullpikkusega jooned jäävad joonteks 

Ignore Frozen Layers – „külmutatud“ kihtidel olevaid objekte ei impordita 

Apply World File – objektide koordinaadid määratakse ESRI World faili (*.wld) abil. Fail peab 

olema sama nimega kui avatav .dwg fail ja asuma samas kataloogis 

Read Proxy Entity Graphics – 

Read Drawing System Variables – imporditakse joonises salvestatud süsteemimuutujad 

DXF header – 

DXF Header File – 

 

   

ESRI geoandmebaasi puhul: 

Geodatabase – vajaliku andmebaasi valimine 

Table List – saab valida ainult vajaliku tabeli 

Additional Attributes to Expose – lisa atribuudid mida arvestatakse objektitüübi konverteerimisel. 

Use Search Envelope – vali importimiseks vaid andmed, mis jäävad piiritletava ala sisse 

Minimum X – minimaalne X-väärtus 

Minimum Y – minimaalnle Y-väärtus 

Maximum X – maksimaalne X-väärtus 

Maximum Y – maksimaalne Y-väärtus 
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Clip to Search Envelope – kas lõigata alast välja ulatuvad objektid ala piiriga 

 

  

Viimane dialoogiaken, mis 

avaneb enne konverteerima 

asumist on selline, kus saab 

täpsustada elementide 

väljanägemist (klikkides 

kõigepealt kihi nime lahtris – 

Layer Name ja seejärel 

sümbolil) ning kus määratakse 

ka kindlasti Directory alt 

kataloog, kuhu TAB failid 

tekivad (mille kaudu edaspidi 

mugavalt CAD graafikat 

avada) ning Use color 

information from dataset 

juures linnukese lülitades 

säilivad värvid. 

 

  

 

 

 Universal Translator (UT) lisavahend on MapInfoga kaasas ja selle abil saab konverteerida kõigi 

Eestis levinud formaatide vahel edasi–tagasi. Universal Translator näol on tegemist firma Safe 

(www.safe.com) väga võimsa (~150 formaati) transleerimisvahendi FME lihtsustusega. UT–ga saab 

konverteerida näiteks järgnevatest formaatidest ja formaatidesse: 

o MapInfo (nii TAB, kui MID/MIF) 

o MicroStation DGN – levinud CAD formaat (Bentley MicroStation ja Bentley PowerDraft formaat). 

Sageli on CAD failides DWG või DGN formaadis salvestatud teostusjoonised, projektid jms.  

o AutoCAD DXF ja DWG (vanemad MapInfo versioonid ei pruugi avada kõige uuemaid DWG formaadis 

faile) 

o ESRI Shape – ESRI avatud formaat (N: ArcView kihid on sageli selles formaadis) 

o .e00 – Arc/INFO andmevahetusformaat (eksport–formaat) 

Tähele tuleb panna, et nimetatud formaatides joonisfailid (v.a. TAB ja SHP formaat) ei sisalda 

koordinaatsüsteemi infot, seega tuleb UT dialoogiaknas öelda, mis koordinaatsüsteemiga on algandmetes tegu. 

Soovitav on kasutatud koordinaatsüsteemi kohta eelnevat infot pärida andmete saatjalt. Eestis on valdav enamus 

andmeid üleriiklikus L–EST97 koordinaatsüsteemis. 

UT käivitatakse Table  menüüst Universal Translator valikuga  ning konverteerimise 

tulemuseks on uued tabelid, mida peale töö lõppu MapInfos vaikimisi ei avata (erinevalt Home/ Table/ Map > 

Open > Import käsust, mis peale importimist ka tabeli avab). Näiteks ühe CAD faili importimisel tekib tavaliselt 

palju MapInfo faile - UT loob uued tabelid grupeerides objektid nende graafilise elemenditüübi järgi (jooned, 

alad, sümbolid, kaared, ellipsid, tekstid jne. eraldi failidesse). Seda põhjusel, et hiljem oleks Layers akna kaudu 

võimalik juhtida, millist infot mille peal kuvatakse – et näiteks seest täis värvitud areaalid ei kataks joonobjekte 

ära vms. CAD faili kihi number, värvikood ning teised graafilised parameetrid kirjutatakse MapInfo 

atribuuditabelisse võimaldades näiteks kihi numbri järgi vajadusel graafika uuesti kujundada. Universal 

Translator ei konverteeri DGN faili koos tabelandmetega, kuid konverteerib iga objekti identifikaatori 

(MSLINK) ja kihi numbri (level) eraldi veergu, mistõttu on hiljem võimalik suurema vaevata tabelandmed 

uuesti siduda avades originaaltabeli näiteks otse MapInfoga ja sidudes graafilised objektid ja originaaltabeli 

MSLINK veergude järgi ära. Tegelikkuses Eestis valdav enamus CAD graafikat ei olegi seotud tabelandmetega 

ja nõnda ei ole tabelandmete ületoomine enamjaolt probleemiks.  

Universal Translator kirjutab ka logifaili, millest vajadusel on võimalik saada lisainfot, eriti siis, kui 

transleerimisel tekib probleeme. UT on võimalik tööle panna ka käsurealt, mis teeb võimalikuks automaatse 

konverteerimise mingil kellaajal. MicroStationi formaatidena tunnustatakse nii v7 kui v8 formaati. MapInfo 16.0 

versiooniga kaasas olev UT toetab AutoCAD formaate kuni AutoCAD 2013-ni(kaasa arvatud).  

Töö käik näiteks CAD faili importimisel: 

a.         Sisendiks (Reader->Format) MicroStation Design või AutoCAD DWG 

b.         failiks (Reader->Dataset) on  üks või mitu DGN või DWG faili 
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c.         Coord. System nupu alt määrame L-EST97  (see on absoluutselt oluline) 

d.         väljundformaadiks (Writer->Format) on TAB (või MID/MIF) 

e.         väljundkataloogiks (Writer->Dataset) on näiteks c:\Andmed 

g.         vajutame OK 

Alates 12.0 versioonist kasutatakse Universal Translator all uut FME Quick Translator tööriista. Uues liideses 

on võimalik koheselt näha logi ja sammuti ka logis veateateid välja otsida. Lihtsaim viis seda kasutada on tõstes 

teisendatava faili Quick Translator aknasse, misjärel avaneb parameetrite valimise aken, kus lähteandmete osa 

on automaatselt täidetud. Edasine töökäik on nagu eelnevalt mainitud CAD faili importimisel. 

 

NB! MapInfo töövälja/joonistamise täpsus on vaikimisi 16.5 cm. Kõik andmed CAD failist konverteeritakse 

vaikimisi sellise täpsusega TAB faili. Juhul, kui on oluline säilitada suur asukohatäpsus, siis tuleks joonise 

täpsuse säilitamiseks kasutada muudetud (Bounds) parameetritega L-EST97 koordinaatsüsteemi kirjeldust: 

Näiteks 1 cm täpsuse jaoks oleks koordinaatsüsteemi rida järgnev (selliselt saab kaardistada kogu Euroopa): 

"L-EST97 1 cm täpsus (EUREF89)", 2003, 115, 7, 24, 57.51755393056, 58, 59.33333333, 500000, 6375000, -

9530545.2550000008, -3655545.2550000013, 10530545.260000002, 16405545.260000002  

ja 1 mm täpsuse jaoks (selliselt saab MapInfoga kaardistada kogu Baltikumi): 

"L-EST97 1 mm täpsus (EUREF89)", 2003, 115, 7, 24, 57.51755393056, 58, 59.33333333, 500000, 6375000, -

503054.52549999999, 5371945.4740000004, 1503054.5260000001, 7378054.5259999996 

 Home/Table/Map > Open > Import käsuga saab sisse tuua: 
MID/MIF – hea formaat andmevahetuseks kõigi teiste levinud GIS programmidega 

DXF – universaalne CAD graafika andmevahetuseks mõeldud formaat 

MBI, MMI ja IMG – MapInfo DOS Boundary Interchange formaat, DOS MMI ja DOS Image 

GML ja GML v2.1 (Geography Markup Language) – uus standardne formaat, mis on XML formaadi 

laiendus (geo)graafiliste andmete jaoks. 

MapInfo on võimeline andmestikke eksportima järgmistesse formaatidesse: 

 Home > Save > Save Copy As käsuga saab salvestada: 

 graafika MapInfo .TAB 

 MapInfo version 2x.TAB  

 dBASE .DBF 

 Microsoft Access .MDB 

 SQLite Database .sqlite 

Geopackage .TAB 

 

 Table > Export käsuga saab välja viia: 

 graafika .MID/.MIF, 

 AutoCAD .DXF  

 Delimited ASCII .TXT 

 dBASE .DBF 

 Comma delimited CSV .CSV 
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 Universal Translator abil – kõikidesse Eestis levinud GIS formaatidesse (vt. eelmist lõiku) 

 Home > Save Image käsuga: 

Saab kaardiakna pildi salvestada tavaliseks pildifailiks (vajadusel koos nurgakoordinaatidega varustatud 

TAB failiga) või koordinaatidega varustatud GeoTIFF formaadis pildifailiks  

2.5 Kaardiaken  

Kihtide graafiline pilt kuvatakse kaardiaknas (Map Window). Tabeli avamisel lisatakse selles sisalduvad andmed 

automaatselt kaardiaknasse järjekordseks infokihiks (layer–iks). Uue kaardiakna saab avada Map menüüst Map– 

nupuga . 

Kaardil saab navigeerida suurenduse/vähenduse nuppude (Zoom In , Zoom Out , kuva nihutamise (Pan 

, või hiire rullikuga) ja erinevates piirides suurendamine (Zoom To ) käskudega. Suurendamisel saab 

kasutada „aknaga” suurendamist – lohistades hiirega kaardiaknas kasti (aktiivne peab olema Zoom In käsk. 

Abiks on ka käsk Previous View (taastab eelneva kuva suurenduse). Kaardiaknas paremkliki tegemisel 

avanevas hüpikmenüüs leiduvad kaardil navigeerimiseks käsud View Entire Layer (terve kihi kuvamine), View 

Entire Selection Layer (terve kihi kuvamine, millel olevad objektid on selekteeritud), Change View (parameetrite 

jõuga seadmine), Nearest Tile Server Level ja eelnevalt mainitud Previous View. 

Iga kaardiakna jaoks on omad kuva parameetrid, mis ei mõjuta teisi kaardiaknaid. Neid saab seadistada Map > 

Map Options dialoogiakna kaudu . 

Kuva parameetriteks on antud kuva laius ja mõõtkava ning kaardiakna keskkoha koordinaat. Kuva mõõtmise 

ühikuks on kaardiakna laius (looduses). Kõik mõõtmised toimuvad looduse mõõtühikutega, neid saab seadistada 

Map > Map Options –> Distance Units ja selle dialoogiakna muudatused kehtivad ainult konkreetse kaardiakna 

jaoks (salvestuvad tööseisu salvestamisega, millest edaspidi…) ja siin saab määrata: 

 

Coordinate Units – ühikud, milles näidatakse 

koordinaate. Nendeks võivad olla kraadid (degrees) või 

meetrid (meters). Valikuvõimalused sõltuvad 

kasutatavast koordinaatsüsteemist. 

Distance Units – ühikud, milles näidatakse vahemaid 

Area Units – ühikud, milles näidatakse pindala 

Distance/area using – määratakse, kas pindala ja 

vahemaad arvutatakse maa kumerust arvestades 

(Spherical) või mitte (Cartesian) – näidatakse 

ristkoordinaatides tasapinnaliselt nagu see CAD 

programmides on. NB! Non–Earth süsteemi korral on 

Cartesian ainuke võimalik valik. Katastriandmed on 

näiteks antud ristkoordinaadistikus. Kuldreegel on, et 

kui ala/objekt on suurem, kui 10x10 km2, siis peab 

maapinna kõverust arvestama. 

Display in Status Bar – määratakse, millist infot 

kuvatakse järgnevast neljast valikust jooksvalt 

staatusreal. 

Zoom – staatusreal näidatakse kaardiaknas kuvatava 

ala laiust looduses 

Map Scale – staatusreal näidatakse kaardi mõõtkava 

Cartographic Scale – staatusreal näidatakse kartograafilist mõõtkava. 

Cursor Location – staatusreal näidatakse kaardil liikudes kursori asukoha koordinaate 

Apply Clip Region Using – kuidas käitutakse Clip Region funktsiooni puhul (st. kas käsule alluvad ka regioonist 

välja jäävad teatud tüüpi objektid – tekstid, punktobjektid) 

Saab määrata, et kaardipildist näidatakse vaid mingi osa. Selleks tuleb kõigepealt valida areaalobjekt, 

mis piiritleb sobivat ala ja valida Spatial > Clip Region > Set Clip Region. Väljalõikamist saab sisse ja 
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välja lülitada Spatial > Clip Region > Clip Set Region on/off . Käsk ei lõika objekte füüsiliselt, vaid 

väljapoole jäävaid objekte lihtsalt ei kuvata. Funktsiooni võib kasutada näiteks trükkimise ajal, kui 

soovitakse trükkida täpselt piirkonna (näiteks maakonna) sees olevat infot. 

When Resizing Window – kuidas muutub kaardiakna suurendus kaardiakna suuruse muutmisel: 

Fit Map to New Window – akna suuruse muutmisega muutub ka mõõtkava – pilt mahutatakse uude aknasse 

ära 

Preserve Current Scale – säilitatakse olemasolev mõõtkava ja osa kaardist jääb „serva taha” 

Display Coordinates – määratakse, millisel kujul kuvatakse koordinaate jooksvalt MapInfo olekureal/staatusreal. 

Degrees Decimal – kraadikoordinaate kuvatakse kümnendsüsteemis 

Degrees Minutes Seconds – kraadikoordinaate kuvatakse kraadides, minutites ja sekundites 

Military Grid Reference – koordinaate kuvatakse spetsiifilises sõjaväe poolt kasutatavas formaadis 

Scroll Bars – kerimisribade näitamine kaardiakna servades (pildi nihutamiseks) 

Autoscroll – mõõtmise või joonistamise ajal kaardiakna serva lähedale klikkides nihutatakse kuva automaatselt 

vastavas suunas edasi 

Enhanced rendering – Suuremad viimistlusvõimalused 

Smooth Text & Labels – anti–aliaising metoodikaga pooltoonides värvide moodustamine, mis võib 

parandada teksti ja märgiste loetavust. Valik on kas seda kasutada või mitte. 

 Smooth Images –  piltide kvaliteedi seadmine (High Quality, Low Quality, none) kõrge ja madala 

kvaliteedi peale. 

Smooth Lines & Borders - anti–aliaising metoodikaga pooltoonides värvide moodustamine, mis võib 

parandada joonte ja äärejoonte  loetavust. Valik on kas seda kasutada või mitte. 

Projection nupu abil on võimalik kuvamise ajal muuta kaardiakna matemaatilist alust e. koordinaatsüsteemi 

(füüsiliselt siin kihtide koordinaatsüsteemi ei muudeta). 

Image Processing nupu alt määratakse, millise meetodiga kaardiakna koordinaatsüsteemi muutmisel rasterkujul 

taustakaardid väänatakse kuvamise ajaks uude süsteemi:  

1) kas seda üldse tehakse (Never) – vaikimisi valik, mil MapInfo käitub eelnevate versioonide sarnaselt – 

rasterkujul andmete korral ei ole võimalik kaardiakna koordinaatsüsteemi muuta),  

2) alati tehakse (Always) – kasutades seejuures ühte levinud meetoditest (Cubic Convolution või Nearest 

Neighbor). Cubic Convolution on soovituslik valik aerofotode ja satelliidipiltide korral. Nearest 

Neighbor on soovituslik valik skaneeritud värviliste kaartide korral (rasterkujul põhikaart näiteks). 

Nearest Neighbor algoritm on ka kiirem. 

3) Optimized – väänamist tehakse järgmise rasterfaili avamisel juba olemasolevale juurde ainult juhul, kui 

see ei ole samas süsteemis. 

NB! Map > Map Options dialoogiaknas määratavad parameetrid mõjuvad ainult konkreetsele kaardiaknale ja 

need jäetakse meelde tööseisu salvestamisel. Füüsiliselt tabelite infot ei muudeta. 

NB! Kõigi hiljem avatavate kaardiakende vaikimisi parameetrid tulevad selliselt, nagu on määratud MapInfo 

üldistes tööparameetrites – Pro > Options > Map Window. 

2.6 Kihtide kujutamine ja järjekorra muutmine 

Tavaliselt töötatakse ühe kaardiaknaga, kuid kaardiaknaid võib olla ka mitu ja igas kaardiaknas saab kuvada 

avatud kihtide hulgast just endale meelepäraseid kihte nõnda, et üks ja sama kiht võib olla eri kaardiakendes 

erinevalt kujundatud. Paljude kihtide korraga avamisel püütakse need paigutada automaatselt niiviisi, et nad 

üksteist võimalikult vähe varjaksid (areaalobjektid allapoole, seejärel joonobjektid, punktid ning tekstid kõige 

peale).  
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Siiski on sageli vaja järjekorda muuta, lisada uusi kihte või 

lülitades sisse mitmeid teisi parameetreid (märgised, kihi 

redigeerimine, kihi stiili muutmine, kihi ajutiselt mitte 

kuvamine). Selleks kõigeks on dialoogiaken, mis avaneb 

järgnevalt: Home > Tool Windows > Layers. Layers akna võib 

jätta avatuks kogu tööprotsessi käiguks. Akna asukoht võib olla 

nii ujuv kui ka MapInfo programmiakna servale „kleebitud“. 

Selleks tuleb akna päisest (sinine riba) hiirega kinni võtta ning 

lohistada ta programmiakna soovitud serva lähedale ja 

kleepimist tähistava nupu  ilmumisel selle peale. Kleebitud 

aken võib olla alati avatud või automaatselt peituv, seisu saab 

vahetada akna üleval paremas nurgas asuva Autohide nupu  

abil.  

Kõik järgnevad Layers aknas tehtavad toimingud on võimalikud 

ka Explorer aknas, mida saab avada Home > Tool Windows > 

Explorer. Lisaks kihtidega seotud toimingutele saab seal 

ülevaate ka tööseisus avatud kaartidest, tabelitest, akendest ja 

ühendustest.  

Nimekirjas (Layer:) on loetelu kaardiaknas kuvatavatest 

kihtidest ja kihtide gruppidest, iga kihi juures on määratud neli 

põhiparameetrit: 

 Kihi kuva – näitab, kas kihti kuvatakse kaardiaknas või teda 

ajutiselt ei kuvata. Exploreris kehtib see ka kõigi teiste akende 

kohta. Kihi kuva muutmine akent lõplikult ei sulge ja selle saab 

taastada uuesti linnukese lisamisega (kasulik eriti kaardiakende 

puhul, et ei peaks tervet kaarti hakkama uuesti kiht kihi haaval 

üles ehitama nagu peaks seda Close käsu kasutamisel tegema).  

 Kihi redigeeritavus – kas kihile saab joonistada ja muuta 

sellel kihil olevaid objekte kaardiakna kaudu (seda, kas mingi 

kiht on redigeeritav, näitab ka programmi staatusreal Editing: … 

lahter) 

 Kihi valitavus – kas saab valida Select käsuga  kihil 

olevaid objekte (seda, kas mingilt kihilt on objekt valitud, näitab 

programmi staatusreal Selecting: … lahter) 

 Automaatsed märgised (Auto labels) – kas näidatakse 

kaardil automaatselt kihi objektide juures tekstilisi 

tabelandmeid e. märgiseid (pikemalt hiljem). 

Parameetreid saab muuta ka mitme kihi jaoks korraga, valides  

[Ctrl] klahvi abil mitu kihi nime ja klõpsates mistahes kihi 

juures olevas kastis. 

Lisaks nupud: 

– eelnevalt avatud uue kihi lisamine kaardiaknasse (st. 

lisatavaid kihte saab siin valida ainult avatud tabelite hulgast). 

– kiht eemaldatakse nimekirjast ehk aktiivsest 

kaardiaknast, tabelit füüsiliselt ei suleta ega kustutata.  

Kihi omadusi saab muuta hiire paremkliki tulemusel avanevas 

hüpikmenüüs valides: 

Layer Properties – kihtidel tehtavate muudatuste jaoks 

vastavatesse dialoogiakendesse pääsemiseks. Enne tuleb vastav 

kiht Layers  aknas välja valida. 

Kihte saab koos kujundusega lohistada hiirekursoriga ühest 
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kaardiaknast teise kaardiaknasse . 

2.6.1 Kihtide järjekorra muutmine 

Kõik kihid kuvatakse üksteise peale. Mida ülevalpool on kiht kihtide nimekirjas, seda hiljem (pealepoole) see 

joonistatakse. Järjekorda saab muuta Layers aknas nuppudega  Up – liigutab valitud kihi ühe võrra üles e. 

pealepoole,  Down – liigutab kihi allapoole. Kihte saab nihutada ka valides ühe või mitu kihi nime ja 

lohistades neid hiirekursoriga. Ajutine joonestuskiht (Cosmetic Layer) jääb alati kõige peale ja selle kuvamist ei 

saa välja lülitada ega teda allapoole nihutada. Objektide järjestust sama kihi piires muuta ei saa. Hiljem 

muudetud objektid kuvatakse sama kihi piires pealepoole. 

NB! Kaardiobjektide valimisel, kui eri kihtide objektid on lähestikku või üksteise peal, valitakse esimesena 

objekt kõige pealmisest valitavast kihist, selle alla jääva objekti valimiseks tuleb kasutada  [Ctrl] klahvi 

(klikkides klahvi all hoides sama koha peal uuesti) või äärmisel juhul muuta Layers akna kaudu teised kihid 

mittevalitavaks või veelgi äärmuslikuma lahendusena saab muuta kihtide järjestust lohistades olulise kihi 

loetelus ülespoole. 

Seega, iga tabel võib olla: 

1. Avatud, kuid üheski aknas ei kuvata tema infot 

2. Olemas kaardiaknas kaardikihina (Layer–ina), kuid mitte nähtav 

3. Olla kaardiaknas nähtav 

4. Olla kaardiaknas valitav 

5. Olla aktiivne e. redigeeritav (editable), redigeeritav saab korraga olla vaid üks kiht. 

 

Kõigi avatud tabelite kohta saab infot Home > Tool Windows > Tables või Explorer aknas grupi Tables all. 

 Nii Explorer kui ka Layers aknas kuvatakse kihi nimi rasvases kirjas, kui sellel on tehtud ühe või rohkema 

elemendi valik (select). 

2.6.2 Kihtide grupeerimine 

Kihte saab grupeerida tehes Layers aknas kaardiakna nimel (Näiteks: Maakond, 

Tee Map) paremklõpsu ja valides Add Group. Kihtide nimistusse lisatakse uus 

grupp, millesse saab tabeleid lisada neid hiirega grupi nimele lohistades. Grupile 

saab nime anda hüpikmenüü käsuga Rename, gruppi laiali lõhkuda käsuga 

Ungroup.  

Gruppidesse saab lisada ka alamgruppe.  

2.6.3 Kihi kuva ja kujutamise 

parameetrid 

Igale kihile tervikuna saab 

kuvamise ajaks määrata oma stiili, 

mis ei sõltu enam objektide 

tegelikest parameetritest (värvist, 

joone paksusest jne.), selleks tuleb 

Layers  aknas valida vastav kiht 

(topeltklikk kihi nimel või hiire 

parema nupuga avanevast 

hüpikmenüüst Layer Properties.  

Layer Display aknaosas 

määratakse: 

Display Mode – juhul, kui stiili 

üledefineerimise kast (Style 

Override) on sisse lülitatud, 

kuvatakse kõiki kihil olevaid 

objekte ühesuguse stiiliga, nagu 

paistab kasti sees olevalt pildilt. 

Stiili muutmiseks tuleb klikata kastile ning kõik kihil asuvad objektid kuvatakse vastavalt siin defineeritavale 

stiilile. Kui kiht sisaldab mitut erinevat tüüpi graafilisi objekte (jooned, areaalid, sümbolid), siis on 

dialoogiaknas ka stiili muutmise nuppe nii mitu tükki. 
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Use Stacked Styles – alates MapInfo versioonist 10.5 on 

võimalik stiile omavahel kombineerida. Selleks tuleb lisada 

linnuke kasti Use Stacked Styles, mispeale stiili ikoonil 

klõpsates avaneb kujutatud dialoogiaken. Nupuga Add saab 

stiile nimekirja lisada, nupuga Remove eemaldada. Stiilid 

laotakse üksteise peale järjekorras alt üles, kombineeritud 

stiil on koheselt näha ka stiili näidisekastis. Stiilide 

järjekorda nimekirjas saab muuta nuppudega Move Up / 

Down. 

Zoom Layering – Kihi kuvamine teatud 

suurendusvahemikus (allpool pikemalt) 

Show Line Directions – näidatakse joonte suunanooli 

Show Nodes – näidatakse objektide nurgapunkte 

Show Centroids – näidatakse objektide tsentroide (keskkohti). 

NB! Muudetud parameetrid jäetakse alatiseks meelde ainult töökeskkonna (workspace) salvestamisel. 

2.6.4 Mõõtkavaline kuva (Zoom Layering) 

Mõõtkavaline kuva on vajalik selleks, et tagada kaardi loetavus st. kaardipilti suurendades tuleks nähtavale 

detailsem informatsioon ja pilti vähendades kaoks loetavuse huvides infot ära. Iga kihi puhul saab määrata 

suurendusvahemiku, millises seda kihti näidatakse. Selleks tuleb Layers aknast valida kiht, teha sellel topeltklikk 

(Layer Properties), sisse lülitada linnuke Display within zoom range ette ning defineerida minimaalne ja 

maksimaalne suurendus, mille puhul antud kihti näidatakse. Suurenduse väärtuse määramisel on abiks 

programmi staatusrea Zoom lahter. Selles näidatakse jooksvalt, milline on kaardiaknas kujutatava ala ulatus 

(looduses). 

2.6.5 Mõõtkavaline stiil (Display Overide) ja mõõtkavast sõltuvad märgised (Label Override) 

Alates MapInfo 10.5 versioonist on võimalik lisandunud stiilide mõõtkavast 

sõltuv kujundus. Selleks tuleb kihi nimel paremklõpsuga avanevast 

hüpikmenüüst valida Add a Display Override, misjärel lisatakse kihile 

alamstiil ja kuvatakse selle suurendusvahemik. Uute alamstiilide lisamisel 

jagatakse viimane suurendusvahemik pooleks. Alamstiilide 

suurendusvahemikke saab muuta alamstiili peal topeltklõpsu tehes. 

Hüpikmenüü käskudega on alamstiile võimalik eemaldada (Remove) ja poolitada (Split). 

2.6.6 Ajutine joonestuskiht (Cosmetic Layer) 

Ajutine joonestuskiht on igas kaardiaknas olev abikiht (igal kaardiaknal on oma personaalne ajutine 

joonestuskiht). Tüüpiliselt kasutatakse seda töö käigus tekkivate abielementide jaoks, mida on vaja vaid selles 

ühes kaardiaknas. Ajutisele joonestuskihile paigutatud objektid salvestatakse tööfaili (Workspace) sisse. Ajutisel 

joonestuskihil olevad objektid saab kustutada ühe käsuga Map > Cosmetic > Clear Cosmetic Layer. Ajutist 

joonestuskihti ei saa välja lülitada, seda saab teha vaid redigeeritavaks või valitavaks. Samuti saab sellel olevaid 

objekte salvestada eraldi tabelisse Map > Cosmetic> Save Cosmetic Objects käsuga. Ajutise joonestuskihi 

omapära on ka selles, et sellel kihil asuvad objektid ei oma andmerida. 

2.6.7 Kihile vaikimisi joonistus–stiili defineerimine 

Iga kihi puhul saab paika panna, millise stiiliga vaikimisi uusi objekte sellele kihile joonistatakse st. tehes kihi 

aktiivseks, teab programm juba, millise väljanägemisega objekte sellele kihile joonistada tuleb. Stiilide 

määramine käib selliselt, et kiht tuleb teha redigeeritavaks, avada Layer Properties aken (topelklikk kihi nimel) 

ja vajutada seejärel Layer Display aknaosas nupule Styles for New Objects. Nüüd tuleb nõustuda (OK vajutus) 

või muuta iga objekti tüübi (punkt, joon, polügoon, tekst) jaoks pakutavat stiili ja siis vajutada OK. 

2.6.8  Objekti sidumine URL–iga 

Iga kaardiobjekti saab siduda internetiaadressiga, pildiga, viitega mingit tüüpi failile. Etapid: 

1) Viidete kirjutamine tabelisse 

2) Viidete otsimise selgekstegemine MapInfole 

3) Viidete vaatamine objektile klikkides 
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1) Kõigepealt peab objektiga seotud tabelireale tekstilist tüüpi veergu kirjutama viite (näiteks veebilehe aadressi 

www.reach-u.com või viite objektist tehtud pildifaili asukohale arvuti kõvakettal või  võrgukettal N: 

C:\fotod\munamagi.jpg või viite dokumendile, mis sisaldab objekti kohta pikemat kirjeldust N: 

C:\dokumendid\loodus\munamägi.doc või viite teisele MapInfo kihile, mis tuleb objektile klikates täiendavalt 

avada N: aluskaardi planšett C:\kaardid\pohikaart\64112.TAB).  

2) Seejärel määrata ära, millistest 

veergudest antud puhul viiteid 

otsitakse. Selleks tuleb kiht 

Layers aknas ära valida ja Map 

menüüs  Hotlink Options.. 

nupule vajutades avaneb 

kujutatud dialoogiaken. 

 

Ülemises dialoogiakna osas 

näidatakse loetelu kõigist tabeli 

„Maakond” defineeritud 

veergudest, millest viiteid 

otsitakse. Päris alguses on see 

sektsioon tühi. 

a) vajutame Add nuppu 

b) Muudame Filename 

Expression lahtris 

dialoogiakna keskel 

veeru nime (N: NIMI);  

c) Muudame Activate 

Hotlink on –> Objects 

(e. viidet näidatakse hiljem objektile klikkdes ja mitte märgisele klikkides)  

d) Vajadusel lülitame linnukese „Filename locations are relative to table location” ette – seda juhul, kui 

oleme tabelisse kirjutanud viited failidele nende suhtelise asukoha järgi antud kihi (Maakond) suhtes. 

See tähendab seda, et kui „Maakond” tabel asuks näiteks kataloogis C:\Kaardid\Maakond.TAB ja mõni 

muu kiht, nt. põhikaardi planšett asub C:\Kaardid\Pohikaart\64\64112.TAB, siis tabelisse saab kirjutada 

pika ketta ja kataloogide tee asemel: Pohikaart\64\64112.TAB. Teise viitelise veeru lisamisel (N: 

ortofoto_alus) tuleb uuesti käia läbi punktid a-d (kõigepealt Add nupp jne).  

e) Enne dialoogiakna sulgemist OK nupuga tuleks mõelda, kas tehtud liigutused on olulised ainult antud 

tööseisu korral või võiks need alatiseks selle (Maakond) kihi jaoks meelde jätta. Viimasel juhul 

soovitaks enne OK vajutust linnukese sisse lülitada Save options to table metadata ette. 

 

3) Viidete vaatamiseks–käivitamiseks on Map menüüs käsk Map Tools > Hotlink  . Olles objekti kohal, mis 

sisaldab viidet või viiteid muutub käpakujuline kursor piksenoole kujuliseks ja kui teha klikk, siis vaadatakse 

viidet ja vastavalt viites sisalduvalt faili laiendile avatakse see programm, mis viidet näidata suudab 

(veebilehitseja, tekstitöötlusprogramm, pildifaili näitaja jne). 

2.6.9 Hüpikmenüü 

Juba varem mainitud hüpikmenüü avaneb kaardiakna kohal 

parema hiireklahvi vajutusel – selles menüüs dubleeritakse 

programmi menüüde käskusid, kuid mitte kõiki, vaid 

enamkasutatavaid.  

 - objektide valimine  

 - valiku tühistamine 

 - kuva suurendamine 

 - kaardipildi liigutamine 

 - märgiste lisamine 

http://www.reach-u.com/
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 - kuva vähendamine 

 - kaardikirjade muutmine 

 - käänupunkti lisamine 

 - objekti muutmine 

Find Selection – otsib üles ja kuvab kaardiakna keskele (või tabeliakna esimeseks reaks) valitud objekti 

Select All from Selection Layer –  valib välja kõik objektid kihilt, kus on eelnevalt kasvõi ainult üks objekt välja 

valitud  

Make Selection Layer Editable – teeb valitud objektidega kihi redigeeritavaks 

Clear Cosmetic Layer – kustutab ajutiselt joonestuskihilt kõik sinna vahepeal paigutatud objektid 

Save Cosmetic Objects – ajutisel joonestuskihil olevate objektide salvestamine uude tabelisse 

Previous View – taastab kaardiakna eelmise kuva 

View Entire Layer – mahutab optimaalselt kaardiaknasse ära kõik näidatava kihi objektid (vaikimisi valik on, et 

ära mahutatakse kõik kihid – All Layers) 

View Entire Selection Layer – näitab kaardiaknas väljavalitud objektide kihti kogu ulatuses 

Nearest Tile Server Level – 

Get Info (funktsiooniklahv F7 või topeltklõps objekti peal 

kaardiaknas) – kuvab objekti geomeetriat iseloomustava 

informatsiooni – millist tüüpi graafilise objektiga on 

tegemist, annab objekti ulatuse (tema ümber mõtteliselt 

joonistatava ristküliku nurgapunktide koordinaadid – 

Bounds ning selle ristküliku keskkoha koordinaadid – 

Center), samuti pisut statistikat ning kui kiht on 

redigeeritav, siis lubab Style nupule vajutades muuta 

konkreetse objekti väljanägemist (värv, joone paksus, jne.) 

ning keskkoha koordinaate muutes ka objekti liigutada. 

NB! korra veel – keskkoha koordinaadid ei asu mitte 

objekti raskuskeskmes, vaid on ristküliku keskkoha 

koordinaadid (kõik kaardiobjektide valimised toimivad 

keskkoha valimise kaudu). 

Get Info dialoogiaken areaal–objekti puhul on selline ->  

2.7 Objektide tabelinfo vaatamine  

MapInfo tabelis olevate tekstilis–numbriliste andmete (tabelandmete) küsimiseks kaardil objektile klikkides 

on vahend Info  (Map > Map Tools). Kui kaardiaknas näidatavas kohas kattub üksteisega mitu graafilist 

objekti, näidatakse Info–aknas kihtide ja objektide arv ja loetelu koos iga objekti esimese veeru andmetega. 

Seega, kui on mitu objekti, siis tuleb täiendava hiireklikiga info akna sees täpsustada, millise kihi objekti kohta 

kõiki tabelandmeid näha soovitakse. Kui kaardil klikitud kohas omab infot ainult üks objekt, siis näidatakse 

kohe kõik selle objekti tabelandmed. Info–aknas saab teha kohe ka tabelandmetes muudatusi ning need hiljem 

Table > Save > Save Table käsuga salvestada. 

Kui kaardiaknas on grid–tüüpi rasterkaardikiht, siis näidatakse selle "infoks" muutuja, mida on grid–i 

moodustamisel kasutatud (grid–muutuja) interpoleeritud väärtus näidatavas punktis. 

2.8 Tabeliaknad ja tabelite nimekiri 

Avatud tabelite sirvimiseks ja sorteerimiseks on MapInfos tabelite nimekirja aken (Tables). See kuvatakse  

menüükäsuga Home > Tool Windows > Tables  

Tabelite nimekirja aknas kuvatakse kõik avatud tabelid ja rasterpildid. Sarnaselt Layers aknaga on Tables akent 

võimalik kleepida programmiakna serva ja muuta seda automaatselt peituvaks (autohide). 
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Tables aknas on võimalik otsida tabelit nime või nimeosa järgi. Otsisõna tuleb sisestada nupu  kõrval 

asuvasse kasti 

Nupust  avaneb rippmenüü, kus on järgmised käsud: 

 Group by Type – tabelite nimekirja 

grupeerimine tüübi järgi 

/  Ascending/Descending Order – 

sorteerimine tähestiku järgi 

 Recently Opened – sorteerimine avamise 

järjekorra alusel 

Kui korraga on avatud nii Layers kui Tables 

aknad, on võimalik neid kuvada ühes ja samas 

aknas. Selleks tuleb üks aken lihtsalt teise peale 

lohistada. Seda, kumma akna sisu parasjagu 

kuvatakse, saab muuta, klõpsates soovitava akna 

nimel koondakna alaservas (kujutatud 

juuresoleval joonisel). 

Tables aknast saab soovitud tabelil hiire 

paremklõpsuga avaneva hüpikmenüü abil 

sooritada sagedamini kasutatud operatsioone 

nagu kuvada tabeliakent (Browse), valida tabeli 

kõik kirjed, avada tabeli uues kaardiaknas, 

muuta tabeli struktuuri, tabeli sulgeda jms.  

Tabeliaken (Browser) avatakse 

vajutamisel hüpikmenüüs nupule Browse 

. Tabeliakent saab avada ka menüüst 

Table > New Browser ning valides 

vajaliku tabeli nime (juba Open käsuga 

avatud tabelite hulgast) 

Tabeliakendes kuvatakse tabelite 

tekstiline sisu, st objektide tabelis olevad 

atribuutandmed. Siin saab liikuda 

kerimisnuppude abil ja teha parandusi 

andmetes (v.a. kui tabel on avatud ainult 

lugemiseks – näiteks on tabelandmed MS 

Excel formaadis). Näidatavaid veerge 

saab välja valida Table > Pick Fields. 

Tabelandmete muutmiseks ei pea kiht 

kaardiaknas olema redigeeritav, 

muudatusi saab teha igal ajal. NB! 

Valitud tabeliridade e. objektide 

kustutamine toimub tabeliakna kaudu 

DEL klahvile vajutades ühegi hoiatuseta! 

Tabelisse saab ridu lisada vajutades 

[Ctrl+E] või valides menüüst Table > Add 

New Row. Siin tuleb aga siis silmas 

pidada, et tabelisse tekib rida, kuid 

kaardiaknasse kohe objekti ei teki – see 

tuleb hiljem joonistada (ja siduda 

joonistamise ajal andmereaga). 

Vastupidiselt aga – kõigepealt kaardiaknasse objekti joonistades, tekib selle 

objektiga seotud tühi andmerida automaatselt. 

Tabelis olevate veergude järjekorda saab muuta veeru päisest kinni haarates ja 

lohistades, kuid sellisel juhul jäetakse veergude asukoht meelde ainult akna 

lahtioleku ajaks.  
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Tabeliaknast on võimalik ära kaotada lahtrite abijooned valides Table > Gridlines. 

Alates versioonist 11.5 on võimalik tabeliaknas andmeid sorteerida kas ühe või mitme välja alusel. Sammuti on 

lisandunud võimalus andmeid filtreerida. Selleks tuleb vajutada filtreeritaval väljal parempoolset hiireklahvi ja 

valida Filter... . Korraga saab ühel väljal olla 2 filtreerimislauset. 

Tabeliakna tekstide fonti saab muuta funktsiooniklahvi F8 või menüüst Table > Font. 

Tabeliaknas kuvatavate veergude arvu saab reguleerida Table > Pick Fields käsuga (liigutades segavad veerud 

paremast sektsioonist Remove nupu abil vasakusse sektsiooni). Selle dialoogiakna abil saab kuvada ka nö. ajutisi 

veerge, mida programm arvutab ja näitab nö „lennult”. Ülevalpool näiteks on el_tihedus arvutatav veerg elanike 

arvu (El_arv) ja pindala veeru jagatise tulemusel. Linnuke Save As Default Browser View jätab tabeliakna 

kujunduse alatiseks meelde ja seda saab hiljem muuta sellesama dialoogiakna kaudu. 

Alates versioonist 11.5 on tabelis read kujutatud kahe värviga, et oleks lihtsam jälgida andmeid. Alternatiivse 

reavärvi muutmiseks tuleb minna menüüst  Pro > Options> Browser Window.... 

Kõikide tabeliaknas olevate ridade välja valimiseks vajuta tabeli ülemisele vasakule nurgale  või vali 

kihinimel paremklahviga vajutades avanevas hüpikmenüüs Select All 

2.9 Kujundusaken  

Kujunduse (Layout) akendesse koostatakse kaardi väljatrüki kujundus, pannakse (ühele või mitmele lehele) 

kokku kaardid, legendid, tabelid ja muud vajalikud andmed (kaardi raam, kirjanurk, pealkiri jms). Kujundusaken 

avatakse Layout > New Layout . Pikemalt on sellest juttu trükkimise peatükis 12.2. 

2.10 Tööseis (tööfail, tööruum, workspace, WOR) 

Selleks, et meelde jätta: 

 Millised andmed (tabelid) on avatud (andmed ise ei pruugi olla ekraanil mingilgi moel nähtavad) 

 Millised (kaardi–, tabeli jms) aknad on avatud 

 Akende kujundus (millised kihid ja millises järjestuses jms.) 

 Kaardiakende üldparameetreid  

 Kaardiakna kihtide parameetrid (märgised – Labels, mõõtkavaline kuva – Zoom Layering, näiline kuva – 

Style Override) 

 Temaatilised kaardid (Thematic Maps) 

 Kujundusakna sisu (Layout) 

 Ajutisel joonestuskihil (Cosmetic Layer) olevad elemendid 

 jms.  

salvestatakse avatud andmed st. ekraanil olev „pilt” tööseisuna (workspace). Salvestamine toimub käsuga Home 

> Save Workspace. Tihti (kui eesmärgiks on kujundatud kaardi trükkimine) ongi tööseis kaarditöö lõpp–

punktiks.  

NB! Save Workspace käsk ei salvesta tabelite infot, kui ka neid on vahepeal muudetud. Tehtud muudatused 

andmetes (tabelites) salvestatakse eraldi käsuga Save Table.   

Workspace on .WOR laiendiga tekstifail. Mõnikord võib vajalikuks osutuda muuta tööseisu väljaspool MapInfot 

(näiteks juhul, kui mõni tabel, mis on tööseisus kirjeldatud, on vahepeal oma nime või asukohta kõvakettal 

muutnud). Seda saab teha näiteks Notepad–i abil, sest .WOR on käskude tekstifail. Pikemalt on sellest juttu 

MapInfo edasijõudnute kursusel. 

2.11 Rasterkaartide kasutamine 

Rasterkaarti kasutatakse nn. rastertabelina, mis on enamasti skaneeritud kaardid, aero– või kosmosefotod. 

Kasutada saab praktiliselt kõiki tuntud rasterfailide formaate (.bmp, .gif, .tif, .jpg, .psd, .sid, .ecw jms). Rasterpilt 

võib olla mustvalge (näiteks katastrikaart või mustvalge põhikaart on sellised), halltoonides (gray–scale, 

vanemad aerofotod) või värviline (tavaline skaneeritud värviline kaart, värviline aerofoto või satelliitfoto). 

Skaneeritud kaartide puhul on parimaid tulemusi failide suuruste ja kiiruse suhtes andnud .tiff formaat, eriti kui 

kasutatakse LZW pakkimist. Maa–ametist on saadavad värvilised aerofotod ECW formaadis. ECW on pakitud 

formaat, mis tähendab, et failid võtavad kettal vähem ruumi, kuid pakkimise tõttu on info selgus võrreldes 

originaaliga pisut väiksem. ECW formaati toetavad uuemad MapInfo versioonid.  
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Rasterkaardi puhul saab MapInfos muuta nii heledust–kontrasti–läbipaistvust, kui ka värviskeemi. Saab 

vahetada värvikanaleid ja valida, kuidas kuvatakse värve (color stretch). Võimalik on luua vektorandmetest 

rasterkaarti (ka mitme vektorfaili põhjal) ja teostada erinevaid toiminguid rasterkaartidega (Raster Operations 

grupi käsud). Teiste hulgas on Calculator, mis võimaldab teostada rasterarvutusi.  

Rasterpilti saab MapInfos näidata ka mitte–kaardina, näiteks kasutada firma logot pildina, mis paigutatakse 

väljatrüki kujundusse. Sellisel juhul tuleb pildifaili avamisel valida valik Display (mitte Register). Rasterfaili 

avamisel luuakse alati .TAB fail ning järgmine kord saab juba konkreetset rasterfaili avada TAB faili kaudu.  

MapInfo määrab koordineeritud rasterfaili avamisel vaikimisi automaatselt sellele suurendusvahemiku väärtused 

(Zoom Layering), mistõttu ei pruugi kohe peale avamist info nähtaval olla. Selleks, et info nähtavale tuleks, on 

kõigepealt vaja kaardiaknas täpselt selles piirkonnas piisavalt suurendada. Selline käitumine programmi poolt 

tekitab sageli segadust ja seetõttu oleme soovitanud automaatse suurenduse määramise programmil ära keelata 

Pro > Options >Map Window sektsioonis valikuga Automatic Raster Zoom Layering (linnuke välja võtta). 

Kaardiakna koordinaatsüsteem sätitakse automaatselt vastavalt esimesena avatud rasterkihi omale. Alates 

MapInfo versioonist 8.5 saab seda vajadusel muuta. Kaardiakna koordinaatsüsteemidest räägib täpsemalt 

ülejärgmine alapeatükk 2.14. 

Rasterpildi värvide parameetreid (heledust, kontrastsust, läbipaistvust ja pool–läbipaistvust) saab muuta kihi 

valimisel ilmuvas Style menüü alt. Rasterfaile (nt ortofotosid) saab teha tervikuna pool–läbipastvaks 

(translucency) – mis toob kihtide loetelus nendest allpool olevate kihtide info läbikumavalt nähtavale. Kõik 

tehtud muudatused salvestuvad automaatselt kohe TAB faili (v.a. juhul, kui fail asub CD ketta peal ja on seega 

read–only. Kui kõike eelnevat sättida: topeltklõps Layers aknas kihi nimel  –> Layer Properties –> Style 

Override kaudu, siis need muudatused salvestuvad ainult tööseisu .WOR faili salvestamise korral. 

2.12 Kaardiserverite kasutamine ja metaandmete otsing 

MapInfo kaudu on võimalik oma kaardiaknasse laadida raster- ja vektorkaarte ka sisevõrgus või internetis 

asuvatest kaardiserveritest. Toetatud on nii WMS (Web Map Service), WMTS (Web Map Tile Service) kui WFS 

(Web Feature Service) teenused, lisaks on loodud otsene ligipääs ka Bing veebikaartidele. Vektorkaarte saab 

peale alla laadimist kasutada nagu tavalisi MapInfo kaardikihte, muutes nende kujundust ja sooritades päringuid. 

WMS teenusserverid 

Teenusserveri valimiseks ja sealt andmete avamiseks tuleb valida Home/ Table/ Map > Open > Mapping 

(WMS). Avaneb kujutatud WMS teenuse dialoogiaken: 

 

Dialoogiaknas tuleb määrata kasutatav teenusserver (WMS Server), kuvatavad kihid (WMS Layers), alla laetava 

rasterfaili formaat (Image Format), rasterpildi läbipaistvuse seaded ja koordinaatsüsteem. Määrata tuleb ka 

salvestatava tabeli nimi, kuna MapInfo tekitab iga avatud rasterpildi kohta nende hilisemaks kiiremaks 

avamiseks tabelifailid. Kiirvalikust Preferred View saab valida, millises kaardiaknas rasterpilti kuvada. 
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Aknas WMS Layers on nimekiri kõigist teenusserveri pakutavatest kaardikihtidest. Valida võib sealt nii palju 

kihte kui parasjagu vaja, lisades nad nupuga Add>> parempoolsesse nimekirja. Nuppudega Move Up / Down 

saab valitud kihtide kuvamise järjekorda muuta. Tasub tähele panna, et peale päringu kinnitamist kihtide 

järjekorda enam muuta ei saa, MapInfo kuvab nad ühe kombineeritud rasterkaardina. 

Rasterfaili formaadi valikus on kuvatud kõik serveri pakutavad pildiformaadid. Kasu on neist näiteks aeglasema 

internetiühenduse puhul kuna mahult väiksem .gif laiendiga fail laetakse alla tunduvalt kiiremini kui .tiff. 

Läbipaistvuse seaded (Image Background -> Transparent) määravad, millist värvi rasterpildil käsitleda 

läbipaistvana. Sellest on abi näiteks must-valgete kihtide puhul, kui üht värvidest läbipaistvaks määrates on seda 

hea kuvada mõne teise meid huvitava kihi peal. 

Koordinaatsüsteemi alajaotuses on kuvatud kõik koordinaatsüsteemid, mis on valitud kihtidele ühised. Kui ühist 

koordinaatsüsteemi ei leitud, pole võimalik päringut kaardiserverisse sooritada. 

Teenusservereid saab kiirvaliku nimekirja lisada klõpsates nupul Servers... Kuvatavas dialoogiaknas on nimekiri 

kiirvalikus olevatest serveritest. 

Add – uue serveri lisamine 

Edit – serveri seadete muutmine 

Remove – serveri nimekirjast 

eemaldamine 

Nupp Set Default võimaldab 

määrata, milline server kuvatakse 

kiirvaliku menüüs vaikimisi 

esimesena. 

Eestis on võimalik kasutada Maa-

ameti WMS teenusservereid, 

millest enimkasutatava leiab 

aadressilt 

http://kaart.maaamet.ee/wms/al

us? Tegemist on aluskaartide 

serveriga, kust leiab nii ortofotod, 

põhikaardi, Corine andmekihid, baaskaardi kui mitmesuguseid teisi kaardikihte. Teiste Maa-ameti pakutavate 

kaardiserverite lingid leiab Maa-ameti kodulehelt rubriigist Avalik WMS teenus. 

Ka PRIA pakub WMS teenust http://www.pria.ee/et/pria/avaandmed  

 

WFS teenusserverid 

Web Feature Service serverid erinevad WMS serveritest selle poolest, et rasterpildi asemel laetakse alla 

vektorandmed ehk konkreetsed kaardiobjektid ja nende atribuutandmed. See võimaldab serverist alla laadida 

vaid meid huvitavad objektid, sooritades päringu objektide atribuutide alusel. Serveri kasutamiseks tuleb valida 

Home/ Table/ Map > Open > Feature (WFS). Avaneb järgnev dialoogiaken: 

http://www.pria.ee/et/pria/avaandmed
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Serverite lisamine ja eemaldamine käib sarnaselt WMS teenusele. Kuvatavaid kihte saab korraga valida vaid 

ühe, kuna tegemist on konkreetse andmetabeliga, millest me andmeid soovime. Infokastis Layer Abstract 

kuvatakse valitud kihi kirjeldus.  

Võimalik on rakendada filtreid nii veergudele (Column Filter) kui kirjetele (Row Filter), kiirendamaks andmete 

allalaadimist ja võimaldades laadida vaid meid huvitavad andmed. Filtrite lisamiseks on loomulikult tarvis teada 

veergude tähendusi. Lisades linnukese lahtrisse Max Features laetakse alla maksimaalselt määratud arv kirjeid 

(kuigi OGC standardi kohaselt peaks kõik WFS serverid kirjete arvu piiramist toetama, ei pruugi see praktikas 

alati töötada). 

Objektide stiile saab muuta vastavalt objekti tüübile, klõpsates sobival nupul alajaotuses Object Styles. 

Lahtris Coordinate System kuvatakse valitud kihi koordinaatsüsteemi nimetus. Kui kihi koordinaatsüsteemi ei 

suudeta tuvastada on võimalik see nupust Projection ise määrata. 

Sarnaselt WMS teenusele tuleb sisestada tabeli nimi, mis võimaldab sooritatud päringut hiljem avada ilma WFS 

dialoogiakna abita. 

Eestis pakub WFS teenust näiteks PRIA 

http://www.pria.ee/et/pria/avaandmed 

Maa-ameti pakutavate teenustega saab 

tutvuda 

http://inspire.maaamet.ee/INSPIRE-

teenused  

WMTS teenusserverid 

WMTS teenus on rasterkaardi teenus, 

mis erineb WMSist selle poolest, et 

kaardid on eeltailitud, tegu on nö 

kahhelkaartidega. See võimaldab 

andmeid kuvada kiiremini ning 

koormus WMTS serverile on väiksem 

kui WMS puhul.  

WMTS serveri kasutamiseks tuleb 

minna Home/ Table/ Map > Open > 

Mapping (WMTS) 

Avaneb kõrvalolev aken:  

http://www.pria.ee/et/pria/avaandmed
http://inspire.maaamet.ee/INSPIRE-teenused
http://inspire.maaamet.ee/INSPIRE-teenused
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Avamine on jällegi sarnane WMS teenusele: tuleb valida rippmenüüst server (uusi lisada saab Servers... nupust), 

kuvatav kiht (WMTS Layers), allalaetava pildi stiil (Style) ja formaat (Format), koordinaatsüsteem (Coordinate 

Reference System), tabeli salvestuskoht ja nimi (Table Filename) ning see, mis vaates kaart avatakse (Preferred 

View). Lisaks saab määrata kaardi ulatuse (Dimensions).  

WMTS teenuseid pakub Eestis Maa-amet http://geoportaal.maaamet.ee/est/Teenused/Avalik-WMS-

teenus/TMS-WMS-C-ja-WMTS-teenused-p481.html  

Microsoft Bing veebikaardid  

Bing veebikaardid on näide rasterpiltide kuvaserveri kasutamisest läbi MapInfo. Kaardi lisamiseks 

kaardiaknasse tuleb valida Home/ Table/ Map > Open ja sektsioonist Base Maps -> Aerial  / Roads  / 

Hybrid .  Kaardiaknas kuvatakse ortofoto, teede- või hübriidkaart Microsofti Bing kaardiserverist. 

Metaandmete otsing veebikataloogidest 

Uudne võimalus meid huvitavat ala kujutavate kaardiandmete otsinguks on metaandmete kataloogid. 

Metaandmed on andmed, mis kirjeldavad teisi andmeid, käesoleval juhul siis kaardiandmeid. Metaandmeteks on 

näiteks kaardiandmete loomise kuupäev, kirjeldus, kujutatav ala, koordinaatsüsteem, jne. MapInfo toetab CSW 

standardile vastavaid metaandmete katalooge. 

Kaardiandmete otsinguks metaandmete alusel tuleb avada vastav brauser valides Home/ Table/ Map > Open > 

Catalog (CSW). Kui tööriista menüüs ei ole, saab selle lisada: Home > Tool Extensions > sakk Registered > 

Load Tool (Run) nupp  Catalog Browseri reas. Seejärel avada brauser eelnevalt mainitud kohast. 

Avanevas aknas on vasakul pool serveri valiku, otsingusõnade ja täpsema otsingu lahtrid ning paremal pool 

leitud kaardiandmed.  

 

Servereid saab lisada klõpsates nupul Catalogs... üleval vasakus nurgas. Lisamine käib sarnaselt WMS, WFS ja 

WMTS teenusserverite lisamisele. Kasutatava serveri saab valida hüpikmenüüst Catalog, otsinguala piiramiseks 

on menüüs Search Within kolm võimalust. None – otsinguala ei piirata, Selection – otsinguala piiravad 

kaardiaknas valitud objektid, ... Map – otsingualaks on kaardiaknas kuvatav ala. Lahtrisse Text tuleb sisestada 

otsingusõnad ja nupul Search klõpsates kuvatakse leitud andmestikud. 

Otsingut saab täpsustada  nii ruumilise operaatori (Intersects, Does Not Intersect, Entirely Within), 

otsisõna tüübi (pealkiri, sisu, võtmesõnad), andmekogu loomise kuupäeva kui metaandmete kirjelduse tüübi 

alusel. 

http://geoportaal.maaamet.ee/est/Teenused/Avalik-WMS-teenus/TMS-WMS-C-ja-WMTS-teenused-p481.html
http://geoportaal.maaamet.ee/est/Teenused/Avalik-WMS-teenus/TMS-WMS-C-ja-WMTS-teenused-p481.html
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Leitud kaardiandmete kohta on võimalik kuvada nende katvus kaardiaknas , täpsemad andmed  ja 

andmete omaniku kodulehekülg või andmekogu kirjeldus XML formaadis . 

2.13 Kaardi koordinaatsüsteem 

MapInfo võimaldab kasutada praktiliselt igasuguseid koordinaatsüsteeme ja kaardi projektsioone. Infot eri 

süsteemide kohta hoitakse failis C:\Program Files\MapInfo\Professional16\mapinfow.PRJ. Seda faili saab 

muuta, kui on vaja lisada uute parameetritega mõni uus koordinaatsüsteem. Samuti võib sellest failist kustutada 

neid koordinaatsüsteemide kirjeldusi, mida ei kasutata. Koordinaatsüsteemide kirjeldamise juhend on olemas 

MapInfo User’s Guide lõpus. 

Alates versioonist 8.5 sisaldab Mapinfo Eestis üldkasutatava L–EST971 koordinaatsüsteemi kirjeldust 

(sektsioonis Estonian Coordiante Systems).  

NB! MapInfo määrab kaardiakna koordinaatsüsteemi esimesena avatava kihi järgi ning kõik järgnevalt avatavad 

kihid, mis võivad olla teises koordinaatsüsteemis, teisendatakse lennult kuvamise ajaks esimesena avatud kihiga 

samasse süsteemi. Kui avada kaardiaknasse omakorda järgmisena esimene rasterkiht, siis väänatakse kaardiakna 

koordinaatsüsteem selle rasterkihi järgi st. esimene avatav rasterkiht paneb lõplikult paika kaardiakna 

koordinaatsüsteemi. Juba järgmiste avatavate rasterkihtide süsteem ei mõjuta enam kaardiaknas kehtivat 

süsteemi. 

Map > Map Options dialoogiakna Projection nupu (ja Image Processing nupu) kasutamisega saab kaardiakna 

koordinaatsüsteemi kuvamise ajaks vajadusel muuta. 

Alates MapInfo versioonist 7.0 saab määrata Pro > Options –> Map Window –> Projection sakk –> Table 

Projection all vaikimisi iga uue tabeli tekitamisel ja MapInfo sisemiseks tööks (Session Projection) kasutatava 

koordinaatsüsteemi (näiteks L–EST97). 

Varasemates MapInfo versioonides, kui soovitakse lugeda objektide koordinaate tabelisse, kasutades 

funktsioone CentroidX(obj) ja CentroidY(obj), võib juhtuda, et MapInfo kasutab vaikimisi geograafilisi 

koordinaate (kraadides: põhjalaius ja idapikkus). Kui on tarvis saada Eesti Põhikaardi süsteemis ristkoordinaate 

(ehk projitseeritud koordinaate meetrites, X ja Y), siis tuleb avada MapBasic aken (Options > Show MapBasic 

Window), toksida seal sisse alljärgnev käsk ning vajutada [Enter] klahvile. Käsu peale mingit teadet ei kuvata, 

lihtsalt võetakse asi programmi poolt teadmiseks. 

Set Coordsys Earth Projection 3, 115, 7, 24, 57.51755393056, 58, 59.33333333, 500000, 6375000 

Käsk Set Coordsys Earth Projection 1,104 teeb vaikimisi süsteemiks WGS84 

Alates MapInfo 7.0 versioonist, kui Pro > Options –> Map Window –> Projection sakk –> Session Projection 

on määratud   L–EST97, siis ei ole MapBasic aknas eelpool mainitud käsu andmine enam vajalik. 

 

3. Objektide valimine ja päringud 

Kaardiobjektide (ehk tabeliridade) valimine on üks fundamentaalsemaid MapInfo käske. Valikukäsuga 

määratakse objektid, millega sooritatakse järgnevad käsud. Valimine loob mällu nn. valikutabeli, vaikimisi 

nimega Selection, mida saab kasutada paljude käskude juures nagu tavalist tabelit ning ka salvestada eraldi faili 

(Home > Save > Save Copy As ja valida Selection).  

3.1 Objektide valimine osutades hiirega  

Objekte saab valida:  

 Kaardiaknas Map > Select  käsuga ükshaaval klikkides. Mitut objekti saab valida hoides all [Shift] 

klahvi. Alumiselt valitavalt kihilt saab objekti valida  [Ctrl] klahvi abil klikkides rahulikult ükshaaval sama 

koha peal senikaua, kuni valitakse õige objekt. 

                                                
1 Vastavalt Keskkonnaministri 05.02.2004 määrusele nr 4 „Geodeetilise süsteemi kehtestamine” jõustunud 21.02.2004 

(http://lex.andmevara.ee/estlex/kehtivad/AktDisplay.jsp?id=60378&akt_id=60378) peab alates 01. juunist 2005. aastal Eestis riiklikes ja kohalike 

omavalitsuste andmekogudes olema kasutusele võetud geodeetiline süsteem EUREF–EST97. Tasapinnalised ristkoordinaadid L–EST97 
arvutatakse geodeetilisest süsteemist EUREF–EST97 projektsiooni LAMBERT–EST kasutades. Sellest tulenevalt soovitame edaspidi kasutada 

ülaltoodud loetelus esimest ehk "L–EST97" süsteemi ning jäädagi seda kasutama. 
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Kaardiaknas saab kasutada ka käske menüüst Map > Select: > Radius Selection , mis valib ringikujulise 

ala sisse jäävad objektid (jooksvalt näidatakse ringi raadiust staatusreal), > Marquee Selection  , mis valib 

ristkülikukujulise ala sisse jäävad objektid, > Polygon Selection  valib objektid joonistatava hulknurga seest 

ja > Boundary Selection  valib näidatava areaalobjekti sisse jäävad objektid. Kõik nimetatud valikud 

toimivad objekti keskoha valimise järgi. Map >  muudab valiku vastupidiseks – ära valitakse kõik need 

objektid, mis ei olnud eelnevalt valitud. 

 Tabeliaknas Table > Select  käsuga klikkides rea ees olevale kastile. Mitut rida saab valida hoides all 

[Shift] klahvi. 

Valimist saab tühistada neljal eri viisil: 

1) Kasutades käsku Table või Map menüüs käsku   

2) valides järgmise elemendi,  

3) klikkides kaardil tühjas kohas,  

4) valides sama elemendi ja hoides seejuures all klahvi [Shift] 

Objektide valimisel valitakse välja kogu tabeli element, st. aktiivne on nii objekt kaardil, kui rida tabelis, 

sõltumata sellest, millises aknas sooritati valimise käsk. 

3.2 SQL päringud 

Lisaks hiirega objektide valimisele saab valida paljusid tabeliridu korraga nn. päringutena (Query) SQL keeles. 

Päring on objektide valimine vastavalt tabelis olevatele atribuutandmete väärtustele (otsime mingitele 

tingimustele vastavaid objekte). Näiteks otsi välja kõik maatükid, mille omanikuks on kodanik „Jüri Mets“.  

Päringuavaldised on avaldised, mille järgi saab valida tingimustele vastavaid objekte. Table/ Map/ Spatial > 

SQL Select avab dialoogakna, kus määratakse: 

 

Select Columns: millised veerud kaasatakse 

From Tables – millisest tabelist objekte otsitakse 

Where Condition – tingimus, mis peab rahuldatud olema (näiteks: el_arv veerus peab number olema suurem kui 

50000) 

Group by Columns – veerg, mille järgi tulemused grupeeritakse 

Order by Columns – veerg, mille järgi tulemused sorteeritakse 
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Into Table Named - millisesse tabelisse tulemus paigutatakse (vaikimisi Selection, aga võib kohe ka anda endale 

arusaadava nime) 

Browse Results – päringu tulemustabel kuvatakse uue tabelinaknana ekraanile 

Find Results in Current Map Window – sisuliselt Find Selection käsk, mis otsib kohe päringuga leitud objekti 

kaardiaknas üles ja kuvab selle akna keskel. Mitme objekti korral mahutatakse need kõik kaardiaknasse ära. 

Add Results To Current Map Window – päringutulemused lisatakse kaardiaknasse 

Save Template – salvestatakse päringu süntaks näidise failina  

Load Template – Save Template nupu alt salvestatud näidiste avamine  

Avaldise moodustamiseks saab valida valikuridadest: 

Tables - tabeleid 

Columns – tabelis esinevaid veergude nimesid 

Operators – tehteid (operaatoreid), mida saab nendega sooritada 

Aggregates -  

Functions – funktsioone 

Avaldise korrektsust saab kontrollida Verify nupuga 

3.3 Päringu tulemus 

Päringu tulemust vaatleb MapInfo kui eraldi ajutist tabelit, mille poole saab viidata analoogselt tavalisele 

tabelile. Päringutabel jääb reeglina seotuks originaaltabeliga – ta on ridade/objektide väljavõte originaaltabelist, 

mitte koopia. Seetõttu saab andmeid muuta päringutabeli kaudu, mis on sageli mugavaim viis.  

On vaid mõned piirangud käskude andmisel (kuvatud päringutabeli struktuuri ei saa muuta, selle tabeli objekte 

ei saa võtta aluseks ruumipäringule). Muidu saab päringu salvestada eri viisidel: 

 Päringud salvestuvad tööseisu (WOR) salvestamisega. Tööseisu salvestamisel (Save Workspace) 

salvestatakse ka kõik tehtud päringud dünaamiliselt (.WOR faili sisse päringu käskudena). Kui töö käigus 

on tehtud palju päringuid, võib juhtuda see, et .WOR faili uuesti avamine on ootamatult aeganõudev, sest 

tehakse uuesti läbi kõik eelnevalt tehtud päringud. Seda tuleks vältida ja enne tööseisu salvestamist sulgeda 

mittevajalikud (päringu)tabelid käsuga Home > Close > Close Table valides dialoogiaknas CRTL klahvi 

abil sulgemiseks QueryX kuni QueryY ja alles seejärel salvestades tööseisu. Päringute salvestamise tööseisu 

saab äärmisel vajadusel jäädavalt välja lülitada dialoogis Pro > Options –> Startup –> Save Queries in 

Workspaces. 

 Home > Save > Save Copy as… – salvestab päringu tulemuse eraldi tavalise staatilise MapInfo kihina e. 

tabelina, kus on vaid päringuga väljavalitud read. Kui algtabeli andmed muutuvad, siis selliselt väljavõttena 

salvestatud tabeli sisu jääb ikka endiseks. 

 Table > Save > Save Query – salvestab dünaamilise päringutabeli kirjelduse. Selle käsuga ei salvestata 

tabeli enda andmeid, vaid päringutabeli avamisel avatakse originaaltabel ning sooritatakse päring uuesti. 

Eeliseks on, et kui algtabeli andmed on muutunud, uueneb ka päringu tulemus (ridu võib lisanduda või 

jääda vähemaks, sest päringu tingimus vaadatakse kõigi algtabeli ridade puhul uuesti üle). Kui alustabeli 

asukoht või failinimi on muutunud ja asi ei avane, ei ole siiski väga keeruline päringu .TAB ja .qry faile 

(mis on tekstifailid) tekstiredaktoriga vastavalt algandmete uuele asukohale näiteks Notepad abil 

korrigeerida. Sellest pikemalt edasijõudnute kursuses. 

3.4 Statistika arvutamine 

Valitud objektide kohta lihtsa statistika (summa, keskmine) näitamiseks on eraldi aken, mida saab avada Home 

> Tool Windows > Statistics või Map > Map Tools > Statistics. Eriti kasulik on see kõikvõimalike objektide 

kombineerimise / grupeerimise läbimängimisel: kohe on näha, millised saaksid olema kombinatsiooni tulemusel 

objektide agregeeritud numbrilised näitajad. 

Samuti on sellest aknast abi, kui objekti tunnuste kirjeldamisel on kasutatud numbrilisi väärtusi 0 ja 1 (kas on 

või ei ole). Sel juhul on väga lihtne statistikaaknast lugeda välja eri tunnusega objektide koguarvu, mis muidu 

vajaks mitut SQL–päringut. 

Statistika aknast on võimalik andmed kopeerida lõikepuhvrisse (kasutada copy–paste käsku). 

Statistikat saab kuvada ka SQL Query akna kaudu, valides selleks sealt sobiva agregaadi (keskmine, summa, 

min, max jne) 
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4. Märgised  

4.1 Märgise sisu 

Märgised (labels) on tekstid, 

mis sisaldavad andmetabeli 

veeru või avaldise väärtust, 

ning mis kuvatakse 

kaardiaknasse graafilise objekti 

juurde tekstelemendina. 

Näiteks kohanimed jms 

objektide nimed on tüüpilised 

märgised. Tüüpiliselt valitakse 

märgise sisuks tabeli ühe veeru 

andmed. Märgised kuvatakse 

alati kõige peale ning on alati 

valitavad ja redigeeritavad 

(nihutatavad, kustutatavad, 

muudetavad teksti sisu 

poolest). Märgise 

redigeerimisel ei muutu 

atribuuditabelis olev tekst, kuigi märgise tekst on sealt pärit. Tabelis oleva teksti muutmisel aga muutub ka 

märgise tekst kaardil. Märgised salvestatakse tööseisu salvestamisel. 

Mitme veeru andmete märgisena kasutamiseks tuleb lisada avaldise (Expression) ritta vastavasse kohta erimärk 

Chr$(13), st. reavahetus. Näiteks: vallanimi + Chr$(13) + elanike_arv 

Nt: 

 

4.2 Automaatsed märgised  

Automaatselt toimub märgiste 

kaardile kuvamine lülitades 

Layers aknas vastava kihi 

juures sisse Auto Label s.t 

klikata vastaval ikoonil . 

Märgise parameetreid saab 

muuta avades topeltklõpsuga 

või paremklõpsust avanevast 

hüpikmenüüst  Layer 

Properties->Label Display ja 

Labeling Rules... 

Avanenud dialoogiakendes saab 

paika panna, mis veeru 

andmetega või avaldisega kihi 

objektid märgendatakse (Label 
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With) ja kuidas märgiseid näidatakse:  

Allow duplicate text – Lubatakse märgiste dubleerimine. 

Label partial objects – Lubatakse poolikult kaardipildis olevate objektide kaardistamine. 

Label Visiblity – Määrab kas märgised on kuvatud(seda saab määrata ka kiirvaliku nupuga ) 

Within zoom range – Saab määrata millises suurenduse vahemikus on märgis nähtav. 

Kindlas suurendusvahemikus märgiste kirjeldamiseks tuleb valida Labeling Rules aknast Display Within 

zoom range ja määrata maksimaalne ja minimaalne suurendus (st kaardiaknas kuvatava ala laius looduses), mille 

juures märgiseid näidatakse. See on vajalik, et näiteks väikesemõõtkavalistel kaartidel ei näidataks väikeste 

objektide märgiseid, mis hakkaksid segama (ja vastupidi). 

Märgise fondi suurus ja stiil määratakse Styles–nupule vajutades (Aa–tähega nupp Layer Display sakil). Pro > 

Options –> Styles dialoogiaknas saab määrata tekstide ja märgiste vaikimisi väljanägemise. Märgise omapära on 

selles, et tema suurus kaardipildi suurendamise ja vähendamise käigus ei muutu. Märgised säilitavad oma 

suhtelise suuruse igal kaardi suurendusastmel.  

Märgise paigutuse  
Märgise automaatsel paigutusel on võimalik ette anda mõningad reeglid: 

Label position – Märgis paigutatakse tsentroidi suhtes (joonisel punane kast näitab kuhu poole tsentroidist 

märgis jääb) automaatselt mingis suunas ja Label Offset näitab mitme punkti kaugusele (Labeling Rules sakil). 

When overlap occurs: 

 Discard label - Märgiste kattumise korral eemaldatakse ülekattuvad märgised. 

Try other position – Märgiste kattumise korral proovitakse ülekattuva märgise asukohta muuta, kui ei 

õnnstu siis märgist ei panda. 

Allow overlapping text  - Märgiste ülekattumine on lubatud. 

Alad: 

Auto position label within region – See on uus featuur alates 12.0 versioonist. Objekt paigutatakse automaatselt 

ruumikuju sisse. Lisaks on võimalik anda veel parameetreid:  

Allow font reduction for better fit – Lubab märgise suurust muuta automaatselt, et tekst mahuks 

paremini objekti sisse. Võimalik on ette anda kui palju protsentuaalselt võib suurust vähendada ja mitu 

erinevat fondi suurust olla võib(Minimum # of font sizes). 

Confine labels to region Boundary – Piirab märgise ala piiridega, kui see välja lülitada lubatakse 

objekti kirjeldusel minna üle objekti piiri. 

Place outside if necessary(callout) – Paigutab märgise vajadusel objektist välja ja lisab joone, millega 

näidatakse millisele objektile vastav märgis kuulub. 

Jooned: 

Orientation 

Horizontal – Märgis paigutatakse horisontaalselt joone juurde 

Rotated – Märgis keeratakse vastavalt joone suunale 

Curved – Märgis kuvatakse pikki murdjoont võttes arvesse joone 

ruumikuju (N: Lookleb pikki jõge) 

 Auto Position along line – Märgis asukoht joonobjektil valitakse automaatselt. 

Allow rotated as fallback – Kui märgist ei ole võimalik paigutada pikki joonobjekti siis kuvatakse 

märgis keeratult joone suuna suhtes 

Overhang – Sellega saab määrata kui suur protsent märgisest võib jääda üle joone ääre. 

 

Kui märgis kuvatakse objektist eemale siis on abiks joonega viitamine märgiselt objektile. Seda saab sisse 

lülitada Label Display>Label Lines (None – joont ei ole, Simple – lihtne joon, Arrow – nool). 

Märgiseid saab redigeerida, muuta nende paigutust ja kirjastiili, samuti teksti ennast parandada tehes märgisel 

topeltklõpsu – avaneb Label Style aken, kus saab nimetatud parameetreid muuta. Kõiki märgiseid saab 

kaardiaknas liigutada ja pöörata samamoodi, nagu tavalisi tekstobjekte. Muudetud märgis viiakse automaatselt 
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ajutisele joonestuskihile. Selliste märgiste eemaldamiseks on menüükäsk Map > . Märgiseid 

saab kustutada ka ükshaaval valides märgise(d) ja vajutades [Del] klahvile. 

4.3 Märgise käsitsi paigutamine  

Märgiseid saab panna ükshaaval käsitsi kasutades Map > Label Tool töövahendit. Niiviisi pandud 

märgiste väljanägemine on samasugune, nagu Layers –>Layer Properties->Label Display dialoogis paika on 

pandud.  

Kõik märgised kaotab ekraanilt Layer Properties->Labeling Rules aknas määrang Visibility –> Off . Kui on 

vaja kustutada käsitsi paigutatud märgised, tuleb valida menüüst käsk Map > ; kui pole vaja 

näidata automaatselt paigutatud märgiseid, saab seda välja lülitada Layers aknas vastava kihi viimasest veerust 

Automatic Labels: Off . Viimasel juhul jäävad kaardile ainult kasutaja poolt muudetud/nihutatud märgised 

(kui Visibility ei ole Off).  

Kuna märgiste suurus määratakse kindla mõõtkava juures, võiks soovituslikult märgiste kaardile paigutamine 

toimuda kaardi valmimise lõppjärgus (näiteks enne trükkimist). Kindlasti EI soovita peale märgiste käsitsi 

nihutamist kasutada Pack Table käsku. 

 

5. Kaardi legend 

Korralikult vormistatud kaart peab sisaldama kaardi legendi, mis aitab mõista, millist nähtust ühe või teise värvi 

või sümboliga kaardil kujutatakse. Ilma legendita võib kaardipildist arusaamine olla vaevaline. 

 

Legendi loomiseks: 

1. Tee aktiivseks kaardiaken  

2. Vali Map > Add To Map > Legend 

3. Näita, milliste kihtide tähendused tuleb legendis kajastada (vaikimisi valitakse kõik). Tekstiliste objektidega 

kihte legendiaknas kahjuks kujutada ei saa. 

4. Vajuta Next ja näita teised parameetrid: 

Window Title – kirjuta legendiaknale pealkiri 

Title pattern – reeglina kustutatakse tühjaks 

Style name pattern – reeglina asendame „#” märgiga (tähistab tabeli nime) 

5. Vajuta Next ja näita igal kihil: 

Styles from  
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– unique map styles – objektid grupeeritakse välimuse järgi (sagedasem valik) 

– unique values in column – objektid grupeeritakse veerus olevate andmete järgi.  

Label styles with – objekti tähenduse tekst võetakse atribuuditabeli veerust (eeldus on, et see veerg 

eksisteerib ning on täidetud mõistlike tekstidega).  

6. Vajuta Finish, mille tulemusena genereeritakse legendiaken koos näidatud raamidega.  

Legendi tekste saab alati hiljem käsitsi muuta tehes topeltklõpsu vastaval raamil. Temaatilise kihi legendi raamil 

klõpsimine avab Legend Frame Properties dialoogiakna, kus saab muuhulgas ka legendi tekste parandada. Seal 

saab määrata ka, mitmesse veergu on legendi kirjed jagatud (Number of columns/rows) ning samuti saab määrata 

tingmärgi suuruse (Sample Sizes). 

Sama dialoogiaken avaneb ka valides Modify Legend , mis asub legendiakna aktiivse oleku ajal ilmuvas 

Legend menüüs.  

 

Kui kaardi sisu on muutunud, siis on vaja ka legendi vastavalt uuendada. Selleks on Legend menüüs käsk 

Refresh.  

6. Temaatiline kaardistamine  

6.1 Mis on temaatiline kaardistamine? 

Temaatiline kaardistamine e. teemakaartide loomine on kihil olevate objektide kujutamine erineva stiiliga 

vastavalt iga objekti kohta tabelis olevatele tunnuste väärtustele. Teemakaart on üks viis mõjutada arvamust. 

Teemakaart on sageli abivahend otsuste tegemiseks – ta aitab märgata seoseid–erinevusi–trende. 

6.2 Temaatilise kaardi planeerimine 

Temaatilised muutujad on andmed, mida näidatakse teemakaardil, enamasti võetakse aluseks üks tabeliveerg. 

Sektor– ja tulpdiagrammidel võib veerge olla aluseks mitu. Muutuja võib olla ka avaldis (kahe veeru võrdlus, 

veerg korrutatud konstandiga jms.).  

Teemakaardi tüübi ja kujunduse valik sõltub sellest, mida kaardistatav muutuja endas sisaldab (kas on tihedus 

või absoluutarv, mis tüüpi see on) ning mida soovitakse kaardiga näidata.  

6.3 Temaatilised kihid 

Teemakaardi loomisel paigutatakse loodav info eri tüüpi temaatilisele infokihile, baaskihi (mille andmete 

põhjal teemakaart luuakse) kohale. 

Temaatilise kihi kuvamine toimub samadel põhimõtetel tavalise kihiga. Kihtide nimekirjas näidatakse:  

 <Teema tüüp> with/by <veerg või avaldis>  

Näiteks: Ranges by Elanike_arv (elanike arvu veeru järgi tehtud teemakaart) 

6.4 Temaatilise kaardistuse meetodid 

 Temaatilise kaardi loomiseks peab esmalt 

olema avatud ja aktiivne kaardiaken, kuhu 

teemakaart tehakse, ning kaardiaknas peab 

olema kujutatud see infokiht, mille kohta 

teemakaart tehakse. Seejärel tuleb valida Map 

> Add Theme, seejärel valida teemakaardi 

tüüp koos stiilinäidisega (stiile saab hiljem 

muuta), seejärel kaardistatav tabel ja veerg, 

millele põhinedes kaart tehakse ning 

teemakaardi muud parameetrid.  
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Pikemalt seletades toimub teemakaardi loomine kolmes etapis 

(järgmisesse viib nupp [Next], eelmisesse [Back] ) 

1) valitakse Map > Add Theme (eelnevalt peab aktiivne olema 

vastav kaardiaken koos vastava infokihiga) ja näidatakse 

teemakaardi tüüp (Type) koos stiilimalliga (Template name).  

 

Erinevaid teemakaardi tüüpe on seitse:  

 Vahemikkaart (nn koropleetkaart, Ranges)  

 Tulpdiagramm–kaart (Bar Charts) 

 Sektordiagramm–kaart (Pie Charts) 

 Gradueeritud sümbol–kaart (Graduated) 

 Punkttihedus–kaart (Dot Density) 

 Üksikväärtuste–kaart (Individual) 

 Pind–teemakaart (Grid, alates MapInfo 5.0–st)  

2) näidatakse, mis tabeli millise veeru põhjal teemakaart luuakse  

Table – tabeli nimi 

Field – tabeli veerg või avaldis (Expression) – muutuja võib 

olla kombineeritud mitmest komponendist või võetud teisest 

tabelist (Join). 

Ignore Zeroes or Blanks – kas ignoreeritakse objekte, millel 

vastavas veerus andmed puuduvad (väärtuseks on „0“ või tühi lahter). 

3) pannakse paika konkreetsed teemakaardi parameetrid: 

Eelvaate (Preview) aknas näidatakse, millisena kujuneb legend, lisaks saab siin määrata: 

Ascending – legendi väärtused näidatakse suurenevas järjekorras 

Descending – legendi väärtused näidatakse vähenevas järjekorras 

Järgnevad parameetrid sõltuvad konkreetse teemakaardi tüübist: 

Ranges – vahemikud, millised valitakse 

Styles – stiilid, milliste värvidega jms. kujutatakse temaatika 

Legend – temaatilise legendi parameetrid, peamiselt tekstide font, välimus ja tähendus. 

Tehtud teemakaardi parameetrite muutmiseks (sama dialoogiakna uuesti kuvamiseks) tuleb teha Layers aknas 

topeltklõps teemakaardi kihinimel.  

Teemakaardi stiili saab mallikohaselt muuta, kui valida parameetrite aknas Template –> Merge ning mingi teine 

stiil. Samuti on võimalik paikapandud stiilid salvestada enda mallina (template) selleks, et seda kasutada teiste 

teemakaartide loomisel (Save As...).  

Teemakaardi aktiivse oleku korral avaneb ka teemakaardi menüü (Theme): 

 

Save as Template – salvesta kasutatav teema, et seda hiljem teiste kaartide puhul kasutada 

Save Theme – salvesta kasutatav teema kaardi metainfosse, et edasistel avamistel kuvataks kaart sama 

kujundusega 

Remove Theme – eemalda kaardi metainfost sinna salvestatud vaikimisi teema 

Refresh Theme – uuenda teemainfot ilma, et peaks kogu kaarti otsast peale alustama 

Field – veerg, mis sisaldab teemainfot 

Ülejäänud menüü sõltub sellest, milline teemakaart on parasjagu aktiivne.  
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Teemakaartide tüübid on: 

Vahemik–kaardid (Ranged Maps) on kaardid, kus numbriline muutja on grupeeritud vahemike vahel. 

Vahemikeks jagamise meetodeid on kuus, need valitakse Method : 

1. Võrdne arv (Equal count) – igasse vahemikku üritab programm paigutada võrdse arvu objekte. Siin tuleb 

jälgida ekstreemseid olukordi, kus tulemus võib tulla ekslik, ei ole võimalik võrdselt jagada jms. 

2. Võrdsed vahemikud (Equal Ranges) – kõik vahemikud on võrdsed. Siin võib tekkida olukord, kus tekivad 

vahemikud, mille sisse ei satu ühtegi objekti. 

Järgnevaid kahte jaotust kasutatakse juhtudel, kui suurus ei ole ühtlaselt jaguv: 

3. Loomulik vahe (Natural Break) jagab vahemikud kasutades iga vahemiku keskmisi, et jagada suurus 

võimalikult ühtlaselt igasse vahemikku. Eeldatakse, et igat vahemikku iseloomustab selle keskmine küllalt 

hästi ja väärtused jäävad suhteliselt kitsasse vahemikku keskmise ümber. Kasutatakse nn. Jenki 

optimeerimisalgoritmi. 

4. Standardjaotuse (Standard Deviation) kasutamisel kasutatakse keskmist piirkonda standardhälbe 

keskkohana, eeldatakse, et muutuja jaotub normaalselt (kõige rohkem on keskmiseid väärtuseid).  

5. Kvantiilne (Quantile) meetod võimaldab luua vahemikke, mis jaotavad teemamuutuja ühtlaselt üle 

andmesegmendi. Näiteks võib nii jagada kogu Eesti rahvaarvu maakondadeks, kusjuures legend ei näita, et 

on kasutatud kvantiilset meetodit. 

6. Lisaks saab kõik vahemikud defineerida ise, kasutades meetodit Custom. Seda soovitamegi enamasti 

kasutada. 

Vahemike moodustamise parameetreid saab määrata nupust Ranges, siin: 

Ranges – vahemike arv 

Round By – ümardamise täpsus 

Color Palettes võimaldab valida värviskeemi ning Styles nupust saab seda vastavalt soovidele modifitseerida. 

 

Tulpdiagramm–kaardid (Bar Chart Maps) võimaldavad näidata mitut muutujat korraga, neid omavahel 

võrreldes. Ei ole hea näidata korraga üle 4–6 muutuja. Muuda saab graafiku tüüpi (Chart Type) ja tulpade 

gradueerimisviisi (Graduation). Samuti saab muuta tulba suurust (Height/Width), ning määrata, kuhu 

joonistatakse graaf (Orientation). Saab kasutada eri tüüpi tulpasid, tehes kõik tulbad eraldi (Styles > Multiple 

Bars), üksteise peale (Styles > Stacked). Muuta saab iga tulba värvi, teha raam ümber iga graafi, täita raami sisse 

jääv ruum mustri või värviga (Styles). 

Sektordiagramm–kaartides (Pie Chart Maps) saab samuti näidata mitut muutjat teineteise suhtes, võrreldes 

üksikuid suurusi kogu tervikuga. Siin saab kindlaks määrata iga sektori värvi, graafi piirijoone stiili (Styles), 

diagrammi suuruse (Pie Size), mis nurgast sektorid algavad (Start Angle), ning sektori paigutust (Orientation). 

Saab kasutada ka poolikuid sektoreid (Chart Type > Half Pie) ja gradueerida sektor vastavalt soovidele 

(Graduation). 

Gradueeritud sümbolkaardid (Graduated Symbol Maps) joonistavad iga objekti kohale sümboli, ja sümboli 

suurus iseloomustab teemamuutuja väärtust. Siin saab määrata sümboli tüübi, värvi ja suuruse (Positive Symbol/ 

Negative Symbol), gradueerimisviisi (Graduation). Määratakse suurim suurus (Size & At Value) ja 

interpoleeritakse kõik muud väärtused selle ja nulli vahele. Näidata saab ka negatiivseid väärtusi (Show Negative 

Values). 

Punkttihedus–kaartides (Dot Density Maps) on teemamuutuja suurus jagatud alale punktidena, sealjuures 

punktide koguhulk näitab piirkonna kogu andmeväärtust. Neid teemakaarte kasutatakse, kui iga punkt 

iseloomustab suurt hulka andmeid. Muuta saab punktide kuju (Dot Shapes), suurust (Size), värvi (Dot Color) ja 

seda, mitu teemamuutujat vastab ühele punktile kaardil (Value Per Dot). 

Üksik–väärtustega teemakaardid (Individual values maps) kujutavad endast kaarte, kus iga muutuja 

individuaalne väärtus on näidatud oma värvi/mustri/stiiliga. Saab kasutada nii numbrilisi (diskreetseid), kui 

nominaalseid väärtusi (näiteks tekstid). Sümboli puhul kasutatakse baaskihi sümboleid. Nominaalsete 

(mittenumbriliste, või kus number iseloomustab mittenumbrilist suurust, nagu näiteks nimed, ka koodid) 

andmete puhul saabki kasutada ainult individuaalväärtustega teemakaarti. Kuupäeva saab käsitleda numbrilise 

suurusena. 

Selle parameetriteks on: 
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Styles – saab muuta eri väärtuste kujutist (värvi, joone laiust jms, olenevalt objektide tüübist), igale 

individuaalsele väärtusele eraldi. Samuti saab sisse lülitada Use Color Styles, mispeale kasutatakse vaid 

värvidega stiile mustvalgete asemel. 

Color Palettes – saab valida värviskeemi 

Pind–teemakaart (Surface Thematic Map – GRID) võimaldab kujutada muutuja jaotust üle kogu ala sujuvalt. 

See on kasulik paljude näitajate puhul, mille temaatiline kujutamine mingite areaalide (näiteks linnaosad, vallad) 

kaupa ei näitaks jaotust adekvaatselt. Sisuliselt genereeritakse pindkaardi koostamiseks muutujast 

kolmemõõtmeline pind (surface), mida võib ette kujutada kui kõrgust. Nii saab tulemuse näidata sujuvate 

värviüleminekute kaupa (a’la kõrgusmudel). Pind–teemakaartide visualiseerimiseks on olemas spetsiaalne 

kaardiaken kolmemõõtmelise kujutise vaatamiseks. Lähemalt asjast hetkel juttu ei tule. 

6.5 Temaatiline legend  

Teemakaardi koostamisel teeb MapInfo legendiaknasse automaatselt legendi (Thematic Legend), seda saab 

muuta kasutades teemakaardi parameetrite dialoogiaknas nuppu Legend... Siin saab näidata:  

Title – legendi pealkirja ja selle fonti  

Subtitle – alapealkirja ja selle fonti 

Show Legend For This Layer – kas selle teemakaardi kohta näidatakse legendi (New Legend Window) või 

legendi ei näidata (No Legend) 

 Show Record Count – kas iga legendi teksti taga näidatakse sulgudes, mitu konkreetse väärtusega objekti on 

andmebaasis. 

Range Labels – vahemike või üksikväärtuste juures olevad tekstid ja nende font. Need saab muuta endale 

meelepäraseks klikates vastaval kirjel ja muutes seda lahtris Edit selected ranges here  

Show This Range – kas näidatakse konkreetset vahemikku legendiraamis või mitte 

Restore Default Title And Labels – taastab vaikimisi programmi poolt määratavad legenditekstid 
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Temaatilise kaardi salvestamiseks tuleb kas: 

1) salvestada tööseis (Workspace)  

2) valida Theme menüüs Save Theme. Sellisel juhul salvestatakse teemakaardi info tabelipõhiselt (TAB 

faili) ning hiljem kihi avamisel näidatakse alati kohe teemainfot. Teemainfo kohese näitamise eelduseks 

on, et programmi tööparameetrite Pro > Options –> Map Window sektsioonis on sisse lülitatud linnuke 

Automatically Open Default Theme. Theme > Remove Theme kustutab kihi TAB failist teemakaardi 

info ära. 

6.6 Teemakaardi mallid 

Teemakaardi mallid (Thematic Template) on vajalikud selleks, et teha erinevaid teemakaarte omavahel sarnaseks 

ning seega võrreldavaks. Malli kaudu salvestatakse vastavalt teemakaardi tüübile selle visuaalsed parameetrid: 

värvivahemik, kasutatav muster, kasutatav stiil, legenditekstide kujundus jms. See võimaldab esmalt kasutada 

rohkem eelnevalt valmisdefineeritud teemakaardi malle, samuti saab kasutaja salvestada enda defineeritud malli 

ning kasutada seda teiste teemakaartide moodustamiseks. 

Teemakaardi algmall valitakse teemakaardi moodustamise esimesel sammul, koos teemakaardi tüübi valikuga. 

Seda malli (st. värvigammat jms) on võimalik hiljem muuta, valides teemakaardi kihi, misjärel avaneb Theme 

menüü, kus on võimalik kujundust muuta. Teemakaardi tüüpi muuta ei saa. 

Malli salvestamiseks on parameetrite aknas nupp Save As Template. Save Customized Legend Text – salvestab 

kasutaja poolt muudetud legendi parameetrid (fondid jms.), hilisemal teemakaardi moodustamisel kohe esimeses 

dialoogiaknas Use Customized Legend Text sisse lülitamisel kasutatakse juba täpselt neid samu legendi 

parameetreid. 

 

7. Töö tabelitega 

MapInfos on põhilised tabelite liigid: 

1. Andmetabelid, mis võivad olla: 

a) seotud kaardiandmetega – neid saab näidata kaardiaknas kaardikihina ja tabeliaknas tabelina. 

b) mitte seotud kaardiandmetega (näiteks välised andmebaasid) – infot saab näidata vaid tabeliaknas 

NB! Sellist situatsiooni, kus graafiline objekt on, kuid andmerida ei ole, ei saa olla (v.a. ajutise joonestuskihi 

objektid). Tabelis on alati graafilise objektiga seotud üks ja ainult üks andmerida. Andmerida tabelis ilma 

graafilise objektita kaardil saab aga eksisteerida. 

2. Rastertabelid – skaneeritud kaardid, aerofotod, fotod objektidest. Neid saab näidata vaid kaardiaknas. 

Eriline liik rastertabeleid on grid–tabelid (olemas alates MapInfo versioonist 5.0), mis kujutavad sujuvaks 

pinnaks interpoleeritud muutujat (näiteks kõrguspunkte, aga ka elanike tihedust, reostuse levikut, lumikatte 

paksust vms hajusat nähtust). Võimalik on ka pinna (kõrgusmudeli) importimine levinud DEM / TIN 

formaatidest. 

7.1 Uue tabeli loomine  

Uue tabeli loomiseks tuleb valida Table >New Table. Avaneb 

selline dialoogiaken:  

 

Siin on soovitav sisse lülitada ka Open New Browser, siis avatakse 

kohe ka kihi tabeliaken. Uue tabeli loomisel saab aluseks võtta 

mingi olemasoleva avatud tabeli struktuuri. Selleks tuleks Table 

Structure sektsioonis valida Using Table ning ära näidata sobiv 

tabel. Seejärel avaneb Create nupule vajutades dialoogiaken New 

Table Structure, kus saab täpsustada või otsast peale defineerida 

loodava tabeli struktuuri: 
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Võimalikud väljade tüübid: 

 Character : tekst, kuni 254 märki (N: Palmse mõis) 

 Width – määrab (teksti)välja maksimaalse laiuse 

 Integer: : täisarvud –2 147 483 648 kuni 2 147 483 647 (vahemik on 232). (N: 1,2,3 jne) 

 Small Integer: täisarvud –32 768 kuni 32 767 (vahemik on 216). 

 Float : ujukoma kümnendarv (N: 202356.13234325) 

 Decimal : fikseeritud kümnendkohaga number (–2 miljardit ... 2 miljardit) (N: 29.2) 

Decimals – määrab komakohtade arvu 

Width – määrab numbri kohtade arvu koos koma ja miinusmärgiga. Suurim lubatud väärtus on 20 

NB! Loogika on selline, et Width=5 ja Decimals 2 tähendab, et suurim number on 99.99 (5 lahutatud 

komakohtade arv lahutatud koma ise) 

 Date : kuupäev (kuupäeva formaat sõltub arvuti Regional Settings parameetrist) 

 Time : Kellaaeg (N: 13:58:12)  

 Date/Time : Kuupäev+Kellaaeg (N: 31.08.2007 13:58:12)  

 Logical : loogiline väärtus (T (True) – tõene; F (False) – väär; saab sisestada ka Yes ja No) 

MapInfo 9.0 versiooniga lisandusid andmetüübid  

Indexed – tähistab, et konkreetne veerg on indekseeritud, see kiirendab operatsioone ning võimaldab kasutada 

Find käsku. Samuti indekseeritakse automaatselt need väljad, mida kasutatakse tabelite vaheliste dünaamiliste 

relatsioonide loomisel.  

Up/Down – muudavad veeru järjekorda tabelis 

Add Field – lisab välja 

Remove Field – kustutab välja 

Table is Mappable – tähistab, et tabel on kaardistatav 

Projection – määrab tabeli koordinaatsüsteemi (see tuleks kindlasti kohe siinsamas paika panna või kontrollida, 

kas on õige) 

Kõige lõpuks vajuta veelkord Create nupule ning salvesta loodav MapInfo tabel/kaardikiht sobivasse kataloogi, 

endale sobiva failinimega.  



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  8-64 

7.2 Muudes failiformaatides tabelandmete hoidmine 

Tabelandmed võivad olla salvestatud nii .DAT (MapInfo standardformaat), .TXT, .DBF, kui .XLS – formaadis. 

Loomulikult ka muudes andmeformaatides või andmebaasisüsteemides. Reeglina on muudes failiformaatides 

salvestatud tabelite puhul piirang, et MapInfo kaudu ei saa muuta tabeli andmete sisu ega struktuuri. Nimetatud 

formaatides tabelid saab kirjutamiskõlbulikuks muuta, kui käsuga Home > Save > Save Copy As…, salvestada 

tabelist koopia MapInfo standardformaati *.DAT.  

7.3 Tabeli struktuur ja selle muutmine 

Tabeli struktuuri saab vaadata ja muuta Table > Table > Modify Structure. Siin võib määrata, kas tabel on 

kaardistatav (Table is Mappable), ning vaadata selle koordinaatsüsteemi. Selleks, et muuta koordinaatsüsteemi 

tuleb salvestada tabelist koopia käsuga Home > Save > Save Copy As..., ning salvestusdialoogis määrata uus 

koordinaatsüsteem Projection; olemasoleva tabeli koordinaatsüsteemi otse muuta ei saa. Saab muuta ainult 

näitamise ajaks (ja see muudatus säilib, kui salvestada tööseis; füüsiliselt on tabel aga ikka vanas 

koordinaatsüsteemis). 

7.4 Tabeli salvestamine, kopeerimine, ümbernimetamine 

Tabeli muutuste (andmed, graafika) salvestamiseks on käsk Home/ Table > Save  > Save Table.  

NB! MapInfo tabel koosneb alati lisaks .TAB failile ühest või enamast lisafailist, mis on samas kataloogis sama 

nime, kuid erineva laiendiga. Kui on vaja tabelit failisüsteemis kopeerida, ümber nimetada või teha 

varukoopiat, peab seda tegema kõigi vastavate failidega (sama nimega, kuid erineva laiendiga failid). Sel 

põhjusel on soovitav kasutada tabeli ümbernimetamiseks MapInfos Table > Table > Rename Table käsku. 

Meeles peab ka pidama, et tabeli ümbernimetamine võib rikkuda juba salvestatud tööfaile (.WOR –workspace), 

mida tuleb siis hiljem parandada näiteks tekstiredaktoriga muutes .WOR failis tabeli nime õigeks. 

Tabelite pakkimine kustutab tabelist kirjed, mis on programmi poolt märgitud kustutamiseks (nn „hallid read”), 

kuid pole töö kiiruse huvides kustutatud füüsiliselt. Hallide ridade eemaldamiseks tuleks peale suuremaid 

muudatusi tabeliga anda Table > Table > Pack Table käsk. See avab dialoogiakna, kus tuleks vajutada lihtsalt 

OK. Pidevalt töös olevate kihtide pakkimist võiks teha regulaarselt, sest kustutatud ridadega tabelid võivad 

tekitada probleeme mitmetes andmebaasitöötluse käskudes (näiteks Update Table juures), samuti on pakkimise 

järgselt failid kõvakettal väiksema mahuga. 

 

8. Kaardiobjektide joonistamine ja redigeerimine  

Joonistamise ja redigeerimise vahendid on vajalikud tööks kaardiinfo graafilise osaga, nii uue graafilise info 

digitaliseerimisel, kui olemasoleva parandamisel. Joonistamise ajal saab klaviatuuri + ja – märkidega kaardipilti 

suurendada ja vähendada. Kõikide joonistamis– ja redigeerimiskäskude puhul peab enne redigeerimist olema 

vastav kiht redigeeritav. Redigeeritav saab korraga olla ainult üks kiht. 

8.1 Objektide joonistamise vahendid 

[Shift] klahvi allhoidmisega saab joonistada 45 kraadi kaupa. 

[Ctrl] klahv alustab joonistamist keskpunktist (ristkülik, joonelõik) või servast (ellips) 

[Ctrl] klahv murdjoone ja polügooni joonistamise ajal lubab joonistada täisnurkselt (ka pööratud kujundi korral). 

Aktiveerides autonode režiimi klaviatuuri „N” tähe abil, saab murdjoone sisestamisel (Polyline) joonistada 

vabakäejoont. 

Aktiveerides cursor režiimi klaviatuuri „C” tähe abil, näidatakse koordinaattelgede kujulist hiirekursorit. 

Aktiveerides autotrace režiimi klaviatuuri „T” tähe abil, saab joonistada mööda olemasolevaid joon– või 

areaalobjekte. 

Aktiveerides autosnap režiimi klaviatuuri „S” tähe abil, saab joonistamisel kinni haarata nurgapunktidest. 

Kaardiobjektide joonistamisel kasutatakse peamiselt järgmisi töövahendeid (Spatial > Insert menüüs): 

Sümbol (Symbol)  – joonistab sümboli, punkti / objekti asukoha märgi. Joonistab klikk kaardiaknas. 

Murdjoon, (Polyline)  – Joonistatakse klikkides (mitte lohistades) kaardil. Viimati sisestatud nurgapunkti 

saab joonistamise ajal tühistada [Backspace] klahvile vajutades. Korduv [Backspace] vajutus võtab tagasi 

eelmiste klikkidega joonistatud nurgapunktid. Joonistamise lõpetamiseks tee topeltklõps. 
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Polügoon (Region)  – kinnine hulknurk, ala, areaal – joonistatakse klikkides (mitte lohistades) kaardil. 

Viimati sisestatud nurgapunkti saab joonistamise ajal tühistada [Backspace] klahvile vajutades. Korduv 

[Backspace] vajutus võtab tagasi eelmiste klikkidega joonistatud nurgapunktid. Joonistamise lõpetamiseks tee 

topeltklõps (viimane punkt ühendatakse automaatselt esimesega) või kliki (üks klikk) viimane punkt võimalikult 

alguspunkti lähedal. 

Tekst (Text)  – teksti joonistamine. Kliki kaardiaknas kohas, kuhu soovid teksti paigutada ja kirjuta tekst. 

Murdjoone ja areaali joonistamisel on võimalik programmil lasta joosta mööda olemasolevat elemendi piiri 

mööda ühes või teises suunas. Eelduseks on SNAP režiimi kasutamine joonistamise ajal. Kõigepealt joonista 

snäppides punkt olemasoleva piiri peale, siis vajuta alla ja hoia all vastavalt all [Shift] või [Ctrl] klahve ning tee 

klikk kaugemal olemasoleva piiri peal – siis näed mis toimub   

Harvemini kasutatakse kaardiobjektide joonistamisel järgmisi töövahendeid: 

Sirgjoon (Line)  – üksiku joonelõigu joonistamine. Et alustada joonistamist keskkohast, hoida all [Ctrl] – 

nuppu. 

Ristkülik (Rectangle) – ruudu saamiseks hoida all [Shift] klahvi; et alustada joonistamist keskkohast, hoida 

all [Ctrl] – nuppu. 

Kaar (Arc)  – ringikujulise kaare saamiseks tuleb [Shift] klahvi all hoida. 

Ellips (Ellipse)  – ringi saamiseks tuleb hoida all [Shift] klahvi; ellipsi “servast” alustamiseks hoida all [Ctrl] 

– nuppu. 

Ümardatud ristkülik (Rounded Rectangle)  – ristkülik joonistatakse ümmarguste nurkadega, [Shift] ja 

[Ctrl] klahvid sarnaselt ristkülikuga. 

8.2 Objektide redigeerimine e. muutmine 

Objektide muutmiseks tuleb valida objekt, seejärel ilmuvad objekti ümber väikesed kastikesed, nn. pidemed 

(handles). Nüüd saab valida sobiva muutmiskäsu. 

Objekti kustutamiseks tuleb see välja valida ja vajutada [Del] klahvi. 

Objekti suuruse muutmiseks tuleb objekti pidemest “kinni võtta” ja lohistada teda soovitavas suunas. Siin saab 

kasutada [Ctrl]–klahvi suuruse muutmiseks keskpunkti suhtes sümmeetriliselt ja [Shift] klahvi, et joone pikkust 

muuta vaid kindlas suunas (90 või 45 kraadi all) või muuta objekti pikkust-laiust proportsionaalselt. 

Objekti graafiliste atribuutide muutmiseks on eraldi dialoogaken, mis avaneb elemendil topeltklõpsu 

tegemisel või andes käsu Get Info  [F7] . Siin saab määrata elemendi suuruse: maksimaalse suuruse (bounds), 

keskkoha (Center X, Y) ja stiili (Style), konkreetsed atribuudid sõltuvad elemendi tüübist. Tekstielemendi puhul 

saab siin muuta ka teksti sisu. 

Objektide asukohta muuta (objekti liigutada) saab, valides noolega objekti(d) välja ja lohistades uude kohta. 

Koordinaatide järgi õigesse kohta objekti nihutamiseks tuleb teha topeltklõps objektil ja kirjutada aknasse uued 

keskkoha koordinaadid.  

Objekti saab pöörata, valides objekti välja ning haarates hiirega kinni alumisest paremast ümarast pidepunktist 

(handler) ning lohistades hiirega vastavas suunas (päri- või vastupäeva). Kindla nurga võrra pööramiseks on 

käsk Spatial > Transform > Rotate Object. 

8.2.1 Valitud objektide väljanägemise e. stiili muutmine 

Üldiselt pannakse joonistatava objekti stiil paika enne joonistamist. Hiljem saab stiili muuta valides objekti ja 

andes vastavalt objekti tüübile stiili muutmise käsu Spatial > Style > Symbol Style/ Line Style/ Region Style/ 

Text Style. Stiile pole kahjuks veel võimalik kombineerida, 

kombineeritud stiile saab kasutada vaid kihi kuvamise seadete 

alt, lülitades sisse Style Override ja Use Stacked Styles. 

Alates MapInfo versioonist 7.0 saab Pro > Options –> Styles 

alt määrata joonte, polügoonide, sümbolite ja tekstide 

vaikimisi stiile, mis on alati peale programmi käima panekut 

sellised nagu kasutaja need defineerinud on. Alates versioonist 

8.0 saab määrata stiilid igale kihile personaalselt. Alates 
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versioonist 9.0 saab määrata ka märgise ja tekstide vaikimisi väljanägemise. 

Joone stiil (Line Style)  – valitud joone stiili, värvi, paksuse muutmine. 

Joonte laiust saab (nii joonel, kui ala piirjoonel) näidata kahel viisil: astmeliselt pikselites (ekraaniühikutes) ning 

punktides (paberiühikutes, 1 point on umbes 0,1 mm, kuid sõltub printeri draiverist), viimane võimaldab anda 

täpsemaid joonelaiusi trükkimise tarbeks. Samuti on seest tühja joonestiili puhul võimalik valida Interleaved 

Line Style, mille puhul "puhastatakse" joonelõikumisel joone servad. See on eriti vajalik teejoonte puhul 

korraliku kartograafilise pildi saamiseks. Puhastatud joonestiil töötab vaid ühe kaardikihi piires (st. kõik ristuvad 

teed või tänavad peaksid olema ühel kaardikihil). 

Ala stiil (Region Style)  – valitud kinnise objekti (ristkülik, ellips, 

polügoon) täisjoonistamise (stiil, värv) ja äärejoone stiili, paksuse ja 

värvi muutmine. 

Fill –> Pattern – kas ala jäetakse seest tühjaks (esimene valik – N), 

värvitakse üleni täis (teine valik – must kast), täidetakse mustriga 

(kõik ülejäänud valikud). 

Fill –>Foreground – milline on täisvärvimise või mustri/viirutuse 

värv. 

NB! Mustrid on alates MapInfo versioonist 7.5 skaleeruvad st. 

suurenduse muutmisel säilitab muster oma tiheduse. 

Fill –> Background – kas mustri alt paistavad alumistel kihtidel 

olevad objektid välja (muster paistab läbi) või värvitakse 

mustri/viirutuse taust lahtris näidatud värviga. 

Border –> Style, Color, Width – äärejoone –> stiil, värv, paksus 

Sümboli stiil (Symbol Style)  – valitud 

sümbolobjekti tingmärk, selle värv, 

suuruse jne. 

MapInfo oskab sümboleid kasutada 

kahest allikast:  

Windows TrueType sümbol–fontides 

sisalduvaid sümboleid. Kui fonti 

millegipärast ei näidata sümbol–fontide 

loetelus, siis tuleks seda fonti eelnevalt 

mingi Font Editor / Font Creator 

programmiga muuta – määrata tema 

tüüp sümbolfondiks (Pictorial, 

Symbolic). Teine võimalus on MapInfo 

lisavahendiga Symbol Maker 

joonistada MapInfo „kaardiaknas” 

sümbol valmis ja see salvestub MapInfo 

3.0 Compatible nimelise fondi alla.  

 

Kasutaja defineeritud sümbolid (Custom Symbols) on bitmap pildid (varasemates MapInfo versioonides 

maksimaalselt 256 värviga ja 32*32 pikslit, 7.5 versioonist alates true–color ja suurusepiiranguta). Need 

pildifailid asuvad CUSTSYMB kataloogis (iga kasutaja Windows profiili all). Kasutamiseks tuleb kopeerida enda 

poolt loodud uus *.bmp fail nimetatud kataloogi alla ja vajutada Symbol Style aknas Reload nuppu. Alates 

versioonist 9.5 on tugi ka *.gif, *.jpg ning *.png piltsümbolitele. 

 

Teksti stiil (Text style)  – teksti fondi, suuruse, värvi jm atribuutide muutmine:  

 Font ja suurus – kirjastiil, saab valida kõigi Windows–fontide vahel. Suurus fikseeritakse teksti paigutamise 

ajal ning jääb muutumatuks st. suurendades suureneb ja vähendades muutub loetamatuks. 

 Text Color – teksti värv 

 Background – tausta kuva: 

None – tausta ei ole 

Halo – taustaks joonistatakse halo 
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Box – taustaks joonistatakse kast teksti ümber 

Color – halo või kasti värv 

 Effects – eriefektid: 

Bold – paks trükk 

Italic – kaldkiri 

Underline– allkriipsutus 

All Caps – KÕIK SUURTÄHED 

Shadow – varju kuvamine 

Expanded – t ä h e m ä r k i d e v a h e l 

o n l i s a t ü h i k 

8.2.2 Objekti kuju muutmine 

Et muuta polügooni, murdjoone, joone, kaare kuju, tuleb valida objekt ja anda käsk Spatial > Nodes > Reshape . 

Aktiivseks muutub kuju (nurgapunktide) muutmise režiim, st. sellel ja järgnevatel valitavatel objektidel 

näidatakse pidemed segmentide lõikumiskohtadesse, milledest saab “kinni võtta” ja sellega muuta elemendi 

kuju. Nurga (node) lisamiseks tuleb vajutada Spatial > Nodes > Add Node  ja näidata lõik, millele nurk 

lisatakse. Sõlmpunkti kustutamiseks vali noolenupuga  vastav kastike ja vajuta [Del] klahvile. 

Kaare otspunktide liigutamisel ei muudeta ellipsi kuju, mille osa on kaar, muutub vaid kaare pikkus. 

8.2.3 Mitme nurgapunkti valimine 

Valida saab ka mitut nurgapunkti, selleks tuleb kuju muutmise režiimis valida üks nurgapunkt ja klahvi [Shift] 

all hoides järgmine, valitakse kõik vahele jäävad punktid lühemat teed mööda. See võib olla kasulik pikema 

jooneosa kustutamiseks. Pikema tee valimiseks kasutatakse [Ctrl] nuppu. Selliselt valitud osa saab ka eraldi 

joonena kopeerida, kasutades käske Copy ja Paste. 

8.2.4 Haardepunktide kasutamine  

Tihtipeale on vajalik, et uus objekt puutuks täpselt olemasolevaga kokku või on vaja saavutada mõõtmisel 

punktist punkti maksimaalne täpsus. Täpselt olemasolevast nurgapunktist kinni haaramise režiimi 

aktiveerimiseks joonistamise või mõõtmise ajal tuleb klaviatuuril vajutada klahvile [S]. Selle peale ilmub 

staatusreale kiri SNAP. Haardepunktideks (Snap points) nimetatakse objektide iseloomulikke nurgapunkte. Kui 

haaramisrežiim on sisse lülitatud, muutub hiirekursor kaardiobjekti sõlmpunkti läheduses suure risti kujuliseks 

ning kursor viitab täpselt lähimat sõlmpunkti. Haaramise täpsust (kui kaugelt sõlmpunktist haaratakse) saab 

muuta Pro > Options –> Map Window –> Editing sakk –> Snap Tolerance.  

Klaviatuuri [C] klahvivajutus aktiveerib koordinaat–telgede kujulise hiirekursori režiimi (toimib peale 

kaardiakna ka rasterfaili registreerimise dialoogiaknas). 

8.2.5 Joonte ümardamine 

Murdjooni saab kuvamise ajal kujutada sujuvatest kaartest (spline) koosnevaks. Selleks tuleb valida vastav 

murdjoon–objekt ja anda käsk Spatial > Fix/ Clean > Smooth Lines. Tagasi murdjooneks teeb elemendi Spatial 

> Fix/ Clean > Unsmooth Lines. 

Jooni saab teisendada polügoonideks, valides ühendatavad jooned ja andes Spatial > Regions > Convert to 

Regions ning vastupidi, teisendada alasid murdjoonteks Spatial > Convert to Polylines. 

8.3 Tabelite käitumine joonistamisel 

Iga uue objekti joonistamisel lisatakse andmetabelisse tühi rida, millele vastab see objekt ja kuhu kirjutatakse 

joonistatud objekti kohta käiv tabeliinfo.  

Veel kaardiobjektiga sidumata andmerida saab siduda, valides tabelis rea ja seejärel joonistades objekti 

kaardiaknasse – automaatselt seotakse see objekt valitud reaga. NB! Kaardiaken tuleb enne joonistamise 

alustamist teha aktiivseks kaardiakna päise kaudu (muidu tühistub rea valik ning peale joonistamist tekib tabeli 

lõppu uus tühi andmerida, mis on selle objektiga seotud).  

Objekti kustutamisel kustutatakse ühtlasi ka vastav andmerida. Saab kustutada objekti ka rea alles jätmisega – 

valida objekt ja Table > Clear Map Objects. Vastupidine on MapInfos põhimõtteliselt võimatu. 



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  9-68 

9. Tabelitele andmete lisamine 

9.1 Mitme tabeli kokkupanek 

Selleks, et võtta tabelisse andmeid teisest tabelist, peaksid mõlemad tabelid omama samasid veerge samas 

järjekorras. Andmete liitmiseks tuleb valida Table > Append Rows; näidata tabel, millest võetakse lisatavad 

kirjed (Append Table) ja tabel, millele lisatakse kirjed (to Table). Enamasti on vaja kasutada lisatava tabelina 

(päringuga) valitud objektide kogumit (Selection). Kui tabeliveergude järjekord on erinev, tuleks enne tabelite 

liitmist ühel neist struktuuri muuta või teha päringutabel kindlate veergude järjestusega SQL Select dialoogiakna 

kaudu. 

Kaardiobjektide kopeerimisel ühelt kihilt teisele on sageli kiirem meetod kasutada lõikepuhvrit ehk Windowsi 

standardseid käske Copy ja Paste. Selleks tuleb valida algtabelis kopeeritavad read või kaardipildis objektid ning 

anda käsk Home/ Spatial > Copy. Seejärel muuta aktiivseks tabeliaken, kuhu andmeid kopeeritakse ning anda 

käsk Home/ Spatial > Paste. Kaardiaknas Paste käsu peale kopeeritakse objektid redigeeritavale kihile. 

9.2 Tabelandmete hulgakaupa uuendamine 

Andmete uuendamise all mõistetakse siin veergude lisamist või täiendamist. Käsk Update Column võimaldab 

lisada tabelile ajutise veeru, kasutada tabeli uuendamiseks mingit selle väiksemat osa (Selection) ja kirjutada 

veergudesse objektide graafilisi parameetreid või paljudele objektidele korraga ühiseid tunnuseid. 

 

 

 

Andmete massiliseks uuendamiseks käsuga Table > Update Column toimitakse järgmiselt: mis tabelisse 

kirjutame (Table to Update), mis veergu kirjutatakse (Column to Update), mis tabelist võetakse andmed (Get 

Value From Table) – sageli jääb samaks, mis väärtus kirjutatakse: kas “Calculate avaldis of teise tabeli veerg” – 

võtab teise tabeli veeru või avaldise või kirjutab fikseeritud väärtuse (Value). Teisest tabelist andmete toomisel 

tuleb määrata ka seos tabelite vahel ehk relatsioon (Join). Relatsioon on kas ruumiline või kasutatakse ühiste 

andmetega veergu mõlemas tabelis (mingi kood, objekti nimi, tüüp jms.).  

NB! Enne tabelandmete uuendamist on soovitav tabel optimeerida (Table > Table >Pack Table). 

Ühesuguse tunnuse omistamiseks valitud objektidele tuleb anda Update Column käsk ja uuendatavaks tabeliks 

määrata päringutabel Selection ning vastav veerg, mida uuendatakse; seejärel Value lahtrisse sisestatakse sobiv 

väärtus või avaldis. Mittenumbrilise (N: tekstilise) väärtuse kirjutamisel peab see olema jutumärkide vahel. 

Ajutise veeru (Temporary Column) lisamist kasutatakse näiteks teisest tabelist andmete toomiseks. Kui 

muudetakse välju, uuendatakse automaatselt ka ajutist veergu. Veeru kohta käivat infot saab salvestada tööseisu 

ning tabelit saab koos ajutise veeruga salvestada Save Copy As–käsuga uue nime alla. 

Üks kasulik funktsioon andmete hulgakaupa uuendamisel on rowid. Selle abil on võimalik kirjetele anda 

unikaalsed väärtused vastavalt kirje rea numbrile. Kasutamiseks tuleks Value lahtrisse kirjutada lihtsalt rowid, 

lubatud on ka tehteid, näiteks rowid * 2. 

9.3 Graafilise info lugemine tabelisse 

Selleks, et kirjutada objektide keskpunktide X ja Y koordinaate tabelisse, on vaja: 

1) luua tabelile koordinaatide jaoks uued numbrilist tüüpi veerud (Table > Table > Modify Structure) 

(vastavalt vajadusele kas tüüpidega Float, Integer, Decimal). 

2) L–EST97 koordinaatsüsteemis lugemiseks anda MapBasic aknas kõigepealt käsk: 

Set Coordsys Earth Projection 3, 115, 7, 24, 57.51755393056, 58, 59.33333333, 500000, 6375000 
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või Longitude/Latitude WGS84 süsteemis lugemiseks anda kõigepealt käsk: 

Set Coordsys Earth Projection 1, 104 

Alternatiivne võimalus on kopeerida vajaliku koordinaatsüsteemi andmed olemasolevalt tabelilt MapBasic aknas 

käsuga set coordsys table tabel1 

3) anda Update Column käsk kaks korda, kasutades esimesel korral avaldiseks funktsiooni CentroidX(obj) ja 

teisel korral CentroidY(obj) ning vastavalt siis tulemuse paigutamiseks veergu X ja veergu Y 

Ilma käsureal koordinaatsüsteemi määramata, kasutab MapInfo koordinaatide lugemisel vaikimisi sisemist 

koordinaatsüsteemi (Session Projection) või avatud tööseisu korral tööseisuga määratud koordinaatsüsteemi. 

Varasemates MapInfo versioonides kasutatakse vaikimisi Longitude/Latitude süsteemi ning MapInfo 7.0 

versioonist alates sisemist koordinaatsüsteemi, mis on määratud programmi vaikimisi tööparameetrite 

dialoogiakna kaudu Pro > Options –> Map Window –> Projection sakk –> Session Projection 

 

Lisaks koordinaatidele on võimalik lugeda tabelisse ka teisi graafilisi parameetreid, näiteks pindala, pikkus, 

ümbermõõt, aga ka värv, teksti sisu jne. Mõned näited: 

 Objekti tüübi saab lugeda tekstilist tüüpi veergu funktsiooniga Str$(obj). Võimalikud (olulisemad) 

väärtused on Polyline, Line, Point, Text, Region, aga ka Arc, Ellipse, Rectangle ja Rounded Rectangle. Käsu 

süntaks: update TABEL1 set VEERG1=Str$(obj) 

 Pindala lugemine numbrilisse veergu: update TABEL1 set VEERG1=CartesianArea(obj, "hectare") 

 Pikkuse lugemine numbrilisse veergu: update TABEL1 set VEERG1= CartesianObjectLen(obj, "m") 

 Ümbermõõdu lugemine numbrilisse veergu: update TABEL1 set VEERG1= CartesianPerimeter(obj, "m") 

 Objekti tekstilise sisu saab lugeda tekstilist tüüpi veergu funktsiooniga ObjectInfo(obj,3). Käsu süntaks: 

update TABEL1 set VEERG1=objectinfo(obj,3)  

Tekstobjektide korral loeb funktsioon ObjectInfo(obj,2) tabelisse kasutatava fondi jne. Joonandmete puhul loeb 

ObjectInfo(obj,2) aga hoopis joonobjekti värvi. Võimalikke ObjectInfo funktsiooni abil kuvatavaid andmeid 

saab vaadata MapInfo abiinfost, sisestades otsngusõnaks objectinfo. 

Nende käskude käivitamine võib mõnikord anda veateate (Invalid Argument 1), kuid seda ei maksa tähele panna, 

kuna töö tehakse reeglina ilusti ära. Enamasti aitab siis eelnev tabeli pakkimine. 

10. Puhvertsoonid  

Puhvertsoon on tsoon, mis joonistatakse ümber objekti ja mille 

piir kulgeb kindlal kaugusel antud objekti(de)st. Näiteks võib 

see tähistada mõju–, huvipiirkonda, kaitsetsooni jms. 

Puhvertsooni loomiseks muuda kiht, millele puhvertsoonid 

tekivad redigeeritavaks ja vali valikukäskudega objektid, mille 

ümber puhvertsoonid luuakse. Seejärel anna käsk Spatial > 

Buffer > Buffer Objects. 

Avanevas dialoogiaknas tuleb ette anda puhvertsooni raadius, 

mis võib olla konstantne suurus (Value), aga ka muutuv 

suurus, mis võetakse iga objekti jaoks temaga seotud 

andmerea veerust (From column). Lisaks tuleb määrata ka 

ühikud, milledes puhvertsooni raadiust mõõdetakse (Units) 

ning puhvertsooni nurgapunktide arv (Smoothness). Viimast 

on vaja, sest puhver on sisuliselt polügoon, mitte ring. Mida 

suurem number, ümaramad on polügooni kõverjooned. 

Maksimaalne punktide arv on 500, mis tähendab, et täisringi 

kujutamiseks kasutatakse 500 nurgapunkti. Määrata saab ka, 

kas luuakse üks keeruline puhvertsoon kõigi valitud objektide 

ümber (One buffer for all objects) või iga objekti ümber eraldi 

puhvertsoon (One buffer for each object), enamasti 

kasutatakse esimest varianti. Lisaks määratakse, kas puhvri raadiuse arvutamine toimub maa kõverust arvestades 

(Spherical) või mitte (Cartesian). Tavaliselt soovitame kasutada tasapinnalist (Cartesian) meetodit. 

Soovitav on puhvertsoonid paigutada esialgu ajutisele joonestuskihile (Cosmetic Layer), millelt need saab hiljem 

Map > Save Cosmetic Objects käsuga vajadusel salvestada omaette kihile. 
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11. Kaardi kopeerimine teise programmi 

Peamiseks kaardipildi kopeerimise vahendiks on OLE (Object Linking and Embedding). OLE on Windowsi 

vahend, mis lubab tõsta objekte ühest programmist teise, kusjuures säilivad objekti sidemed. See tähendab, et 

muutes näiteks algallikas varem tekstiredaktorisse tõstetud objekti, kajastuvad muutused ka seotud objektis 

(nõuab refresh’i).  

MapInfost kaardi kopeerimiseks teise programmi OLE objektina on vaja kasutada Map > Drag Map käsku . 

Kõigepealt tuleb arvuti ekraanil saavutada olukord, kus mõlema programmi aknad on korraga nähtaval. Siis 

tuleb teha aktiivseks MapInfo kaardiaken (mitte kujundusaken), valida Drag Map nupukäsk ning lohistada 

hiirega kaardiakna sisu teise programmiaknasse, soovitud asukohta.  

Selliselt OLE objektina viidud kujutis nõuab hilisemal avamisel, et TAB failid oleksid kättesaadavad samas 

kohas. Seetõttu ei soovita seda meetodit kasutada juhul, kui on vaja näiteks PPT slaidishow kaasa võtta ilma 

sama arvutita. Sellisel juhul on kindel viia kaart teise programmi staatilise pildina (bitmap). Bitmap faili 

saamiseks on vähemalt kaks meetodit: [Prnt Scrn] klahv klaviatuuril või MapInfos käsk Layout > Save Image. 

12. Trükkimine 

MapInfost saab trükkida nii printerisse kui faili (näiteks pildifaili või PDF–i k.a kihilisse PDF-i). Saab trükkida 

nii kaardiakna, kui muude akende sisu ning spetsiaalse kujundusakna abil kõiki aknaid ka koos ja kujundatult.  

12.1 Mõõtkavaline trükkimine kaardiaknast 

Kaardiaknas näha olevat pilti mõõtkavas välja trükkides tuleb kaardiaken teha aktiivseks, suurendada üles sobiv 

piirkond ning anda käsk Home > Print. Avanevas dialoogiaknas vajutada Options nupule ning Custom Map 

Scale lahtris määrata numbriliselt mõõtkava. Enamasti suurendatakse seda numbrit (näiteks 28.4 asemele 

kirjutatakse 30 ning mitte 25, sest muidu ei mahu kaart ühele lehele ära. Lehe suurus ja orientatsioon pannakse 

paika eelnevalt juba Home > Page Setup alt, ehk enne Print käsu andmist. Alates MapInfo versioonist 8.5 on ära 

kaotatud 28 000 piksli piirang, mistõttu peaks olema võimalik rahulikult trükkida väga suures formaadis kõrge 

kvaliteediga. 

 värvilahutuse problemaatika: iga printer ja draiver annab pisut erineva värvigamma – see on paratamatu, 

võiks eelistada PostScript printeriga väljatrükki 

 PDF faili väljund saadakse kas MapInfo Home > Create  käsu või vabavaralise PDF virtuaalse printeri 

(PDF Creator, CutePDF, Adobe Acrobat PDF printer) abil. 

Home >Print käsuga trükitakse välja aktiivse akna sisu, tavaliselt soovitakse trükkida kujundusaknas näha 

olevat pilti (aga sageli on trükitavaks aknaks otse kaardi–, tabeli– või graafikuaken). Juhul, kui on lihtsalt vaja 

välja trükkida kindlas mõõtkavas kaardiaknas näha olevat kaardipilti, siis ei ole vaja kujundusakent kasutada 

ning tuleb toimida selliselt: 

1) Home > Page Setup alt üle kontrollida ja paika panna väljundseadme nime ja lehekülje parameetrid (A4, A3, 

A2 jne, Portrait, Landscape jne.). 

2) Tee aktiivseks kaardiaken. 

3) Vali Home > Print. 

4) Vajuta Options nupule ja määra Custom Scale aknas sobiv mõõtkava (näiteks 1 cm = 5 km). Milliseid 

ühikuid siin näidatakse, sõltub Pro > Options –> System Settings –>Paper and Layout Units ning Map > 

Map Options –> Distance Units määrangutest). 

5) Juhul, kui areaalobjektide sisu on defineeritud mustritega, siis võib olla on vajalik kvaliteetse väljundi 

saamiseks korra klikkida Advanced nupul ning lülitada välja linnuke Scale Patterns valiku eest. 

6) vajuta OK ja trükkimiseks ka OK. 

Selliselt Home >Print käsuga saab trükkida ka tabeliakent ja Options nupu alt määrata, millised read täpselt 

trükitakse.  

12.2 Kujunduse moodustamine ja trükkimine väljatrüki kujundusakna kaudu.  

Juhul kui soovitakse kujundatud väljatrükki, milles sisalduvad nii kaardiaknad, tabelaknad, legendid, logod, 

raamid, pealkirjad jms, siis uue kujunduse loomiseks on alates 12.5 versioonist on MapInfos olemas uus 

väljatrüki kujundamise aken, mille kaudu saab seda kõike teha. Selleks tuleb kasutada nuppu , mis 

asub Layout menüüs. 
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1. Vajuta  

2. Väljatrüki lehe seadeid (A4, A3, A2 jne, Portrait, Landscape jne.). saab muuta vajutades parempoolset 

hiireklahvi aknas ja valides Page setup või vajutades nupule . Need tuleks kindlasti enne 

kaardi kujundamist üle vaadata, sest hilisem muutmine võib kujunduse paigast ära viia. Esmalt tuleb 

avanenud aknas Print... nupust valida endale sobiv printer ja seejärel panna paika lehekülje seaded: 

suurus, piirid, orientatsioon.  

3. Lisa väljatrüki kujunduse aknase: olemasolev või uus kaardiaken nupust , tabeliaken 

, joonista kujund , lisa pilt , legend , mõõtkava  , tekst 

. 

4. Tihti on kaardil vaja kuvada ka põhjasuunanoolt. Selleks tuleb lisada laiendus North Arrow. Laienduste 

lisamisest täpsemalt peatükis 22.1. Kui laiendus on lisatud, leiab selle menüüst Map > Add To Map. 

Dialoogiaknas saab valida noole stiili, suuruse ja suuna. Nool lisatakse kaardi kosmeetilisele kihile. 

Noole asukoha muutmiseks tuleb teha kosmeetiline kiht teha muudetavaks ja valida välja Marquee 

Selection tööriistaga kogu nool ning liigutada see soovitud kohta. Noole värve saab muuta nagu 

tavaliste pindobjektide puhul.  

5. Paiguta objektid kaardil soovitud kohtadesse kasutades selleks abiruudustikku, mida saab kuvada/ peita 

nupust . Võimalik on muuta kuvatava ruudustiku suurust , aktiveerida 

automaatne ruudustiku külge haakimine  ja nihutada valitud objektid lähima vasema 

, parema , ülemise  või alumise  abijooneni. 

  

Nupu  kaudu saab  

a. Lisada vertikaalset või horisontaalset abijoont. (Add Vertical Guidline / Add Horizontal 

Guidline) 

b. Peita või eemaldada kõik abijooned (Disable Guidlines, Remove All Guidlines) 

Mainitud abivahendid asuvad Edit grupis 

6. Kujunda kaardiaknad või tabeliaknad vastavalt soovitule nii nagu tavalises kaardiaknas. Selleks tee 

vasakpoolse hiire nupuga topelt nupuvajutus vastaval aknal väljatrüki kujundusaknas, või hoia vajuta 

Alt+ hiire vasakpoolne nupuvuajutus 

7. Vali, kas kujundatud väljatrükk printida , luua PDF dokument  või salvestada pildiks 

. 

Raam (Frame) on graafiline kujundusakna põhielement. Kaardiaken, tabeliakne, kujutis pilt võit tekstiväli 

lisatakse väljatrüki kujunduse aknasse raamina. Raami enda parameetreid(äärejooni, täidet või läbipaistvust, 

fonti jms) saab muuta vajutades raamil parempoolset hiireklahvi ja valides Frame Properties. Uusi raame luua, 

kustuda raame ja raami sisu saab menüüst Layout > Frames > ... . 

Kui raam on halli värvi, toimub raami omaduste muutmine: suumimisel suurendatakse kogu raami, liigutatakse 

seda tervikuna jne. Topeltklõps raami sees teeb muudetavaks aga raami sisu. Selle märgiks, et muudetav on just 

sisu, on raami sinine värv. Tabeli puhul tähendab see, et saab muuta ka kirjete sorteerimistingimusi.  

Kattuvate raamide järjekorra muutmiseks vajuta vastaval raamil parempoolset hiirenuppu ja vali kas raam 

tuua ettepoole (Bring to Front) või saata raam tahapoole (Send to Back). Teine võimalus on valida raam ja 

seejärel mainitud käsud menüüst Layout > Reorder > ... . 

Väljatrüki kujundusaknas kujundatud kaardile legendi lisamiseks tuleb teha vastaval kaardiraamil parempoolse 

hiirenupu vajutus ja seejärel valida Add Legends. 
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Kiiremaks kaartide trükkimiseks võib kasutada kujundusmalle. Selleks võib lisada kujundusaknasse tühjasid 

raame ning salvestada seejärel tööseis (Home > Save Workspace). Hiljem saab tühjadesse raamidesse lisada 

kaarte, tabeleid, pilte jne.  

NB! Alates MapInfo 12.5 versioonist on Väljatrüki kujundusaknas olev kaart eraldiseisev objekt. Seega ei 

mõjuta algse kaardipildi nihutamine, ega kujunduse muutmine väljatrüki kujundusaknasse lisatud kaarti. 

 

12.3 Trükkimine pildifailiks 

Kaardipildi võib salvestada pildifailiks käsuga Layout > Save Image. Avanevas aknas tuleb valida salvestatava 

faili nimi, asukoht ja formaat. 

Toetatakse formaate: 

1. BMP, JPEG, JPEG 2000, GIF, PNG, TIFF (RGB ja CMYK), PSD – rasterformaadid 

2. WMF / EMF – vektorinfona (Windows Metafile) – aga siin võib kaotsi minna keerukas muster/joonestiil. 

3. universaalne nurgakoordinaatidega varustatud GeoTIFF formaat (alates MapInfo versioonist 9.0).  

Vajutades Save nuppu avaneb järgmine dialoogiaken, kus on võimalik määrata pildi kvaliteeti resolutsiooni (dpi 

– dot per inch ehk „punkti tolli kohta“) parameetri muutmise kaudu. Muuta saab ka pildi mõõtmeid. 

Rasterfaili võib tekitada ka anti–aliaising metoodikaga, mis tekitab ühelt värvilt teisele üle minekul 

pooltoonides värve, mis võib parandada rastri (N: tekstide) loetavust (linnuke Anti- aliasing ees). 

Lisaks on võimalik sisse lülitada valik Create a Geographically Referenced TAB file, mis tekitab pildifailile 

juurde nurgakoordinaatidega varustatud TAB faili ja kindlustab edasise rastri avanemise täpselt samasse kohta. 

12.4 Trükkimine PDF faili 

Kaardipildi saab salvestada PDF faili käsuga Home/Layout > Create. Võimalik on valida nii MapInfo enda PDF 

printer kui ka teisi arvutis saada olevaid pdf faili tekitavaid printereid. Võimalik on määrata pdf faili „paberi“ 

seadeid, lisada infot faili autori kohta, vesimärke, salasõna jne (Properties nupp).  

Klõpsates nupul PDF saab määrata, kas salvestada pdf faili kõik nähtavad kaardikihid eraldi kihtidena (Layered 

PDF), kas lisada pdf faili ka objektide atribuutinfo (Add Attribute Data to PDF) ja kas lisada pdf faili ka  

kaardiakna koordinaadid (Georegistered PDF). Koordinaate saab hiljem otse pdf failis vaadata tööriistaga 

Geospatial Location Tool. 
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Lisades linnukese kasti Automatically Open PDF avatakse fail peale genereerimist automaatselt.  

13. SQL päringud  

13.1 Mis on SQL päring ? 

SQL päring on tabeliridade (ja nendega seotud kaardiobjektide) valimise käsk, mille juures kasutatakse 

spetsiaalset avaldist (SQL avaldist – SQL statement) laialt levinud SQL keeles ehk struktureeritud päringukeeles 

(SQL – Structured Query Language). Tegemist on tabelandmete järgi objektide otsimisega. 

SQL keeles on lihtsal kujul olemas kõik vajalikud käsud andmebaasiga tööks, sh: 

 andmebaasi kirjeldamine (nt. tabelite loomine, muutmine ja kustutamine, nt. käsk create table, alter table, 

drop table) 

 tabelist andmete lugemine, ridade valimine (käsk select) 

 tabeli andmete uuendamine (käsk update) 

 tabeli ridade kustutamine (käsk delete) 

 tabelisse ridade lisamine (käsk insert) 

MapInfos saab kasutada enamikke standardseid SQL käske kas dialoogiakende või MapBasic käsurea–akna 

kaudu; ka menüüdest valitavad käsud tõlgitakse reeglina SQL keelde ning kui on avatud käsurea–aken (Home > 

Tool Windows > MapBasic), siis näidatakse selles aknas menüü kaudu käivitatud käskude kuju SQL keeles.  

MapInfo SQL Select dialoogiaknas (nupp  Table, Map ja Spatial menüüs) tehtava päringu tulemuseks on 

ajutine valikutabel, mis valib välja etteantavatele tingimustele vastavad read/objektid ühest või mitmest tabelist 

või arvutab midagi. Selles peatükis vaatleme põhjalikult SQL Select dialoogiakent.  

13.2 SQL päringu kasutamise üldine protseduur 

1. Ava tabel, mille andmete põhjal päring sooritada. See tabel saab olema baastabel. 

2. Vali päringunupp SQL Select  Table, Map või Spatial menüüst . Täida väljad vastavalt vajadusele (vt. 

järgmine alapeatükk) ja vajuta OK. MapInfo eraldab–valib baastabelist tingimus(te)le vastavad andmed ja 

paneb need nn. tulemustabelisse. Tulemustabeli nimi on vaikimisi Selection (seda saab muuta nii päringu 

moodustamise käigus kui pärast päringu tegemist) ja see sisaldab neid veerge, mida SQL päringu aknas 

kasutaja soovis tulemustabelis näha, ning neid andmeridu (ehk objekte), mis vastavad SQL aknas koostatud 

päringu tingimustele. 

3. Ava kaardi ja/või tabeliaken tulemustabeliga. MapInfo avab tabeliakna automaatselt, kui SQL Select 

dialoogiaknas sisse jätta Browse Results nupp/linnuke. Kui tulemustabel on Selection, siis nimetatakse 

tabeliakna avamisel see QueryX, kus X on 1 või suurem. 

4. MapInfo valib kõik read baastabelis, see võimaldab teostada edasisi toiminguid kogu valitud hulgaga (nt. 

muuta objektide stiili, jne.) Tähele tuleks panna, et kõik tulemustabelis tehtavad muudatused kanduvad 

edasi baastabelisse (ridade muutmine, kustutamine jne) ning vastupidi. Muuta saab tulemustabelis andmeid 

ainult juhul, kui tulemustabel on väljavõte ühest originaaltabelist (andmete valik on toimunud ühest mitte 

kahest või enamast tabelist) ning ei ole kasutatud grupeerivaid käske. Mitme baastabeli põhjal tehtud 

päringu tulemusaknas ei ole andmete muutmine võimalik. 

5. Salvesta tulemustabel, kui seda läheb ka hiljem vaja. Home > Save > Save Copy As salvestab selle eraldi 

staatilise tabelina–infokihina. Table > Save > Save Query salvestab tulemustabeli seose baastabeliga st. 

salvestab päringu süntaksi tekstifaili. Home > Save Workspace salvestab veel lahti oleva tulemustabeli akna 

nime ja asukoha ning päringu süntaksi tööfaili, et seda järgmisel tööfaili avamisel esile kutsuda (st. päring 

uuesti teha). Päringute põhjal tehtud päringuid tööseisu ei salvestata. Kogemata salvestatud palju päringuid 

tööseisus võib olla põhjuseks, miks seda tööseisu avatakse hiljem kaua aega. 

13.3 SQL päringu koostamine 
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SQL Select käsu käivitamisel avaneb 

selline aken:  

SQL Select aknas on soovitav nii 

palju, kui võimalik, kasutada 

abivahenditena lahtritesse vajaliku 

info sisestamisel valikunuppe paremal 

servas. Soovitav on päring 

moodustada järgmises järjekorras 

lahtritesse infot valides: 

 from Tables: tabel(id), 

mille(de)st read valitakse. Kui 

päringusse kaasatakse mitu 

tabelit, siis eraldatakse need 

komaga, sel juhul peab olema 

näidatud tingimuse lahtris (where 

Condition) kindlasti seos nende 

tabelite vahel. Tabelite nimesid ei 

pea mälu järgi ja käsitsi kirjutama 

(kuigi see on mõnikord kiirem) 

vaid neid saab valida Tables 

noole alt (joonise näitel valitakse 

ridu tabelist vald). Mitme tabeli 

puhul on tabelite valimise 

järjekord oluline. Esmalt tuleb valida selle tabeli nimi, millest soovime kaardiobjektid välja valida. 

 Select Columns: veerud, mida kasutaja soovib näha tulemustabelis – eraldatakse komaga. Veergude 

nimesid ei pea samuti mälu järgi ega käsitsi kirjutama (kuigi see on taas mõnikord kiirem), vaid neid saab 

valida Columns noole alt. Eriline on vaikimisi kasutatav * (tärn) – see tähendab, et valitakse tabeli(te)st kõik 

veerud. Kui on valitud mitu tabelit (seega võib olla samanimelisi veerge), siis MapInfo näitab veerge kujul: 

tabelinimi.veerunimi, tabelinimi.veerunimi, tabelinimi.veerunimi jne.  

Select Columns lahtrisse kirjutatakse lisaks veerunimedele ka avaldisi (veerunimi*5, veerunimi / 

veerunimi). Siia lahtrisse valitakse ka Aggregates nimistust funktsioone, mis summeerivad, loendavad, 

leiavad veergude keskmisi, minimaalseid või maksimaalseid väärtusi, arvutavad pindala, pikkust, vahemaad 

jne. Siin saab anda veerule ka nn. alias’e – endale meelepärase veeru nime, mida näidatakse päringu 

tulemustabeli aknas. 

 where Condition: päringuavaldis, mille järgi valitakse read. Selle moodustamisel saab valida tabeliveerge 

Columns nimistust, tehteid Operators nimistust, funktsioone Functions nimistust. Avaldise tulemus peab 

olema alati tõeväärtuslik (tõene või väär), sellest allpool pikemalt. Ülal näites valitakse välja need 

omavalitsused, kus elanike tihedus (mis jooksvalt arvutatakse EL_ARV veeru ja PINDALA veeru 

jagatisena) on suurem, kui 1000. 

 Group by Columns – võimaldab grupeerida sama tunnusega ridu. Siin näidatakse grupeeritava tunnuse 

veeru nimi. Näiteks elanike andmebaasis võib olla vajalik kokku panna kõik sama perekonnanimega isikud. 

Et leida, mitu isikut on eri perekonnanimega, tuleb kasutada grupeerimist, mis toob välja unikaalsed 

väärtused. 

 Order by Columns – millise veeru järgi tulemustabel sorteeritakse (ülal näites omavalitsuse nime järgi). 

Saab näidata ka mitu veergu, eraldades need komaga. Sorteerimine toimub järjekorras: esimesena 

sorteeritakse esimesena näidatud veeru järgi, pärast seda teisena näidatud veeru järgi jne. Sorteerida saab 

kasvavas (vaikimisi valik) ja kahanevas järjekorras, kirjutades veeru nime järele DESC – descending (vt. 

ülaltoodud näidet). 

 into Table Named – päringu tulemustabelile saab kohe määrata endale meelepärase nime (Selection 

asemel). 

Nupp Verify näitab, kas antud avaldised on korrektsed ("Syntax is correct") või mittekorrektsed (incorrect) 

Browse Results ees linnuke tähendab, et kohe peale päringu sooritamist avatakse uus tulemustabeli aken 

päringu tulemustega (lisaks sellele, et objektid valitakse ära juba kõigis võimalikes lahti olevates akendes). 

Find Results in Current Map Window – Find Selection käsk, mis otsib päringuga leitud objekti(d) 

kaardiaknas üles. 

Add Results to Current Map Window – Lisab päringutulemuseks olnud objektid kaardiaknasse 
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13.4 Päringu salvestamine 

Koostatav päring võib olla üsna keeruline, mistõttu on võimalik päringu süntaks salvestada hilisemaks uuesti 

kasutamiseks. Selleks on kaks nuppu: 

 Save Template – sisestatud väärtused ehk päringuavaldis salvestatakse näidise failina (tekib .qry laiendiga 

fail), mida saab hiljem uuesti kasutada Load Template nupu abil. 

 Load Template – loetakse salvestatud väärtused eelnevalt salvestatud failist. Lugeda saab ka neid .qry 

laiendiga päringufaile, mis on salvestatud failimenüü Save Query… käsuga. 

Päringut saab salvestada kahel viisil: (1) enne – Save Template ja (2) pärast päringu sooritamist (Table > Save 

>Save Query). Peamiseks erinevuseks on, et (1) .qry faili salvestatakse vaid päringu avaldis (avatud tabeli nimi, 

veerud, tingimus), (2) .qry faili salvestatakse päringutabelina lisaks ka alustabeli füüsiline asukoht (faili nimi 

koos ketta tähise ja kataloogiga) ning luuakse lihtsamaks päringutabeli avamiseks .TAB fail. 

13.5 Avaldiste moodustamine  

Avaldis on tehe, mida sooritatakse andmetega. Peale SQL Select päringuakna, saab avaldisi (expression) 

kasutada ka paljudes teistes MapInfo käskudes (nt. tabeli andmete massilisel uuendamisel, märgiste 

paigutamisel, teemakaardi loomisel), jne. 

SQL päringus saab kasutada avaldisi peamiselt kahel eesmärgil: 

1. Select Columns lahtris selleks, et valida, millised arvutatavad veerud tulemustabelis näidatakse. Lihtsalt 

veeru asemel on tihti vaja kasutada keerulisemat väärtust, milleks on enamasti teiste veergudega või 

funktsioonidega tehtud arvutus. Näiteks kasutades elanike arvu ja pindala veergude andmeid, saab näidata 

tulemustabelis elanike tiheduse (avaldise süntaks: elanike_arv / pindala). Enamasti on arusaamise huvides 

kasulik lisaks arvutatud veerule lisada ka objekti nime sisaldav veerg (nt. omavalitsuse nimi). 

2. where Condition lahtris tingimuse andmiseks, mis piirab päringuga saadavate objektide arvu – millised 

kirjed/read/objektid tulemusse valitakse. Mitmest tabelist andmeid tabeliaknasse koondades on 

kohustuslik kindlasti siinsamas lahtris näidata ära ka tabelite vaheline seos (join) – vt. ptk 13.10). Oluline on 

meeles pidada, et siin peab avaldis olema alati tõeväärtustüüpi. 

Mis andmetüüpi on avaldise tulemus, sõltub avaldises kasutatavatest veergudest (nende tüüpidest) ja etteantud 

väärtuste sisust. Avaldise moodustamise põhireegliks on, et tehetega saab kokku panna vaid sama tüüpi 

veerge ja väärtusi. Loomulikult on võimalik avaldise käigus teisendada jooksvalt numbrit tekstiks jne. 

Veergude ja muutujate kohta kasutatakse edaspidi ühisnimetajat muutuja. 

 

Võimalikud tehted on: 

1. Arvuliste muutujatega: 

Liitmine ( + ) , lahutamine ( – ), korrutamine ( * ) , jagamine ( / ), astendamine ( ^ ) 

Arvulised väärtused näidatakse lihtsalt numbriga, kümnendkoha eraldajaks on punkt. 

Näiteks: elanike_arv > 1000 – avaldis, mis valib välja need kirjed/read/objektid, kus baastabeli veerus 

elanike_arv on number suurem kui 1000 

2. Tekstiliste muutujatega: 

Liitmine (+) paneb tekstid üksteise otsa, nt. "Tartu" + " " + "maakond" tulemuseks on "Tartu maakond".  

NB! Tekstilised väärtused (tegelikult kõik mittenumbrilised väärtused) tuleb alati paigutada 

jutumärkide vahele. 

3. Kuupäev–tüüpi muutujatega: 

 Lahutamine (–) – annab kuupäevade erinevuse päevades (date tüüpi veeru andmete puhul). 

4. Tõeväärtuslike muutujatega: 

and – loogiline “ja”, mõlemad avaldised peavad olema tõesed 

or – loogiline “või”, üks avaldistest peab olema tõene 

not – loogiline eitus, true = not false, false = not true 

Tõeväärtuslik väärtus saab olla vaid kas TRUE (T, s.t tõene) või FALSE (F, väär). Tõeväärtuslik on 

tulemus ka võrdlustes: 

võrdsus (=), mittevõrdsus (< >), suurem kui (>), väiksem kui (<), suurem–võrdne (>=), väiksem–võrdne 

(<=). Võrrelda saab arvu arvuga ja teksti tekstiga. 
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Tavaliselt koosnebki lihtsam tõeväärtus–tüüpi avaldis (where – lause tulemuseks peab olema seda tüüpi 

avaldis) kolmest osast: <muutuja1> <võrdlus> <muutuja2> 

kus muutuja1 ja muutuja2 peavad omakorda olema sama tüüpi avaldised, tavaliselt:  

a) lihtsalt veeru nimi – nt. elanike_arv, pindala, kogus, nimi 

b) etteantud väärtus – nt. 32, 23.42, "Tamme", TRUE, "21.5.2002" 

c) omakorda avaldis (tehe) – nt. elanike_arv / 2 , kogus * hind 

d) funktsiooni tulemus (täpsemalt allpool) – nt. curdate(), area(obj,"sq km") 

Juba lihtsate andmestike juures saab kombineerida erinevaid muutujaid, tehteid, väärtusi ja funktsioone 

praktiliselt piiramatutes võimalustes erinevateks avaldisteks, tuues sellega välja objektide erinevaid tuletatud 

karakteristikuid. Ka on sama lõpptulemus võimalik saada vormilt erinevate avaldiste abil. 

13.6 Näiteid lihtsa päringu tegemiseks 

Kordame kuldreeglit:  

Väärtused, mida otsitakse numbrilistest veerust kirjutatakse ilma jutumärkideta ning väärtused, mida 

otsitakse mistahes muud tüüpi veerust (tekstilisest, kuupäev tüüpi, tõeväärtus–tüüpi), kirjutatakse alati 

jutumärkide vahele (andmebaasisüsteemides väljaspool MapInfot asendab jutumärki reeglina ülakoma).  

Tüüpiline SQL lause andmete valimiseks näeb välja näiteks:  

1) select * from tabelinimi1 (vali välja kõik read tabelist 1 ja näita tabeliaknas kõiki veerge ja ridu). 

2) select * from tabelinimi1 where veerg1=9 AND veerg2 like ’’A%’’ otsib välja tabelist 1 kõik read, kus 

numbrilises veerus 1 on väärtus 9 JA tekstilises veerus 2 algab tekst A tähega (mõlemad tingimused peavad iga 

rea/objekti puhul olema täidetud ehk tõesed). 

3) select veerg1,veerg2,veerg3 from tabelinimi1 where veerg1=9 OR veerg2 like ’’%a%’’ otsib tabelist 1 välja 

kõik read, kus numbrilises veerus 1 on väärtus 9 VÕI tekstilises veerus 2 sisaldub ükskõik millises lahtris a täht. 

Tulemustabelis näidatakse ainult baastabeli veerge 1 – 3. 

4) select * from tabelinimi1 where veerg1 IN (1,4,7) lühem ja mugavam variant kui eelmine (OR operaatoriga). 

Siin otsitakse välja tabelist 1 kõik read, kus veerus 1 on väärtused 1, 4 või 7 ja näidatakse tulemustabelis kõiki 

veerge. 

5) select * from tabelinimi1 where veerg2=’’kala’’ or veerg2=’’saba’’ or veerg2=’’raba’’ otsib täpseid 

tekstilisi väärtusi veerust 2. Siin otsitakse välja tabelist 1 kõik read, kus veerus 2 on kirjutatud kas ’’kala’’, 

’’saba’’ või ’’raba’’. Sama päringu mugavam süntaks on kujul: select * from tabel1 where veerg2 IN 

(’’kala’’,’’saba’’,’’raba’’)6) select ’ from tabelinimi1 where rowid <= 100 valib otsingutabelist välja esimesed 

sada kirjet. Funktsioon rowid võimalab ligipääsu kirjete järjekorranumbritele, kuid tähele tasub panna, et 

järjekorranumbri määrab järjekord algtabelis, mitte päringu tulemusel saadud tabelis. 

13.7 Tehete järjekord 

On järgmine (kõrgemalt madalamale): sulud; eksponent(astendamine); miinusmärk; korrutamine, jagamine; 

liitmine, lahutamine; ruumipäringud; võrdlustehted; loogiline EI (Not); loogiline JA (and); loogiline VÕI (or). 

13.8 Tekstide võrdlusest 

 Tekstiliste veergude puhul võib lisaks võrdusmärgile (pere_nimi = „Mets”) kasutada võrduses kuju ka nt. 

pere_nimi>”H”, sel juhul valitakse read tähestikulises järjekorras alates H tähest. 

 Kasulik on teksti võrduse eritehe Like, mida kasutatakse võrdusmärgi asemel. Võrdusmärgiga toodud 

avaldis otsib veerust täpset vastet (perekonnanimi peab olema täpselt „Mets”). Like suudab arvestada 

võrreldavas tekstis olevaid metamärke, võimaldades leida veerus sisalduda võivat tähekombinatsiooni. 

Metamärkideks on % ja _ 

 %  – asendab mitte ühtegi või mitut tundmatut tähemärki 

_  – asendab ühte tundmatut tähemärki 

 Like operaator ei tee vahet suur– ja väiketähtedel. MapInfo ei tee kahjuks vahet ka täpitähtedel (v.a. juhul, kui 

kasutate Windows XP eestikeelset operatsioonisüsteemi). 

 Näiteks:  

 nimi like "suur%"   – leitakse kõik objektid, mille nimi algab tekstiga suur ja Suur ja SUUR. 

nimi like "%ala%"  – leitakse kõik objektid, mille nimi veerus olev tekst sisaldab tähekombinatsiooni „ala”, 

sealjuures enne ja pärast „ala” võib olla muid tähti ja numbreid (sest tekstilist tüüpi veergus võivad ju olla 

kirjutatud ka numbrid). 
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 Seega – otsides täpset väärtust, kasutame tavaliselt võrdusmärki (=). N: nimi=“Tartu“ ning otsides objekte ilma 

täpset õigekirja teadmata kasutame LIKE operaatorit ja otsitava tähekombinatsiooni ümber metamärke (% ja/või 

_).  

13.9 Ruumipäringud  

Ruumipäring on üks GIS tarkvara spetsiifilisi võimalusi. Sellisel juhul sooritatakse päring graafiliste 

objektidega (spetsiaalse veeruga obj, mida tabeliaknas eraldi veeruna kasutajale ei saa näidata) neid omavahel 

võrreldes (mis mille sisse jääb või millega kattub). Võimalikud tehted: 

Contains – sisaldab, objekt A sisaldab objekti B, kui B keskkoht (mitte objekti geomeetriline keskkoht, vaid 

objekti ümbritseva ristküliku geomeetriline keskkoht) jääb A piiri sisse. Objekt B võib olla mistahes graafilist 

tüüpi objekt (joon, areaal, tekst, sümbol). Objekt A on areaal–tüüpi objekt. N: vali välja hooned antud kvartali 

seest. 

Contains Entire – sisaldab täielikult, objekt B peab jääma täielikult A piiri sisse ning ei tohi üheski punktis 

puutuda. N: Vali välja katastriüksused, mis jäävad täielikult antud kaitseala sisse. 

Within – seespool, objekt A on B sees, kui selle keskkoht on B piiri sees (vastand Contains käsule) Contains või 

Within kasutamine sõltub tabelite valimise järjekorrast SQL Select dialoogiaknasse. Tabelite valimise järjekord 

oli oluline objektide valimise seisukohast (milliselt kihilt valida soovitakse, see tabel peab olema loetelus 

eespool).  

Entirely Within – täielikult seespool (vastund Contains Entire käsule). 

Intersects – lõikab/kattub; kaardiobjektidel on vähemalt üks ühine kattumispunkt. Näiteks – milliseid 

katastriüksusi läbib kavandatav teetrass. Millised katastriüksused on täielikult või osaliselt kaitseala piirides. 

13.10 Tabelitevahelised seosed 

MapInfo võimaldab kirjeldada kahe (ja enama) tabeli vahel loogilisi seoseid ehk relatsioone (join) ning kasutada 

neid päringutes, andmete uuendamisel update käsuga ning veel mõnes käsus. MapInfo termin relatsiooni kohta 

on Join… – kõikjal, kus esineb see valik, on tegu kahe tabeli vahelise seosega.  

MapInfo toetab kahte liiki seoseid: 

1) seos tabelis olevate andmete kaudu. See on analoogne tavaliste andmebaasisüsteemidega – kaks tabelit 

seotakse omavahel samade väärtustega veergude abil. 

2) seos ruumiobjektide vahel – see on üks GIS andmebaaside peamisi eeliseid tavalise andmebaasisüsteemi 

ees. Tabelid seotakse selle järgi, kuidas graafilised objektid üksteise suhtes paiknevad (jäävad sisse, 

lõikuvad jms). 

Relatsioone on vaja peamiselt sellepärast, et tagada andmestike optimaalsus: et ei oleks sama objekti kirjeldus 

samas andmebaasis erinevates tabelites mitu korda. Mida enam on andmeid andmebaasis topelt, seda 

ebaökonoomsem on andmebaas. Relatsiooniline andmebaas aitab esmalt kokku hoida ruumi, kuid veel olulisem 

on andmete haldamise lihtsustamine: infot parandada on vaja vaid ühes kohas. Kohe toome selle kohta näite:  

Näide 1 

Näiteks on tabel, kus on kirjas objektide aadressid. Üks võimalus on kirjutada igasse ritta tekstiveergu täiskujul 

aadress, nagu: 
Soola 1 

Turu 8 

Riia 2A 

Samas on ilmne, et tänava nimi saab sellises tabelis nii mitme kordseks, kui palju on sellel tänaval hooneid. 

Seega oleks tunduvalt optimaalsem hoida aadressi kahes eraldi veerus, ning kasutada tänava nime asemel 

kodeeringut: 

Tabel aadresspunktidega: CENTROID 
tanava_ko

od 

majanumb

er 

11 1 

12 8 

9 2A 

ja sealjuures kirjeldada tänava koodidele vastavad tänava nimed teises tabelis, näiteks: 

Tabel tänavanimedega: TNIMED 
tanava_ko

od 

tanava_ni

mi 
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9 Riia 

11 Soola  

12 Turu 

Kui Soola tänava nimi peaks muutuma, siis tuleb see asendada vaid teises tabelis ühes lahtris. Samuti saab nii 

hoida ära tihti esineva probleemi, et sama tänava nimi on eri lahtrites kirjutatud erinevalt (eri lühendid, trükivead 

jms).  

Antud näites tabelitevaheline seos kirjeldatakse lihtsal kujul: centroid.tanava_kood = tnimed.tanava_kood. 

Aadressi saab SQL päringuga kätte seega järgmise süntaksiga avaldise moodustamisega, mis esialgu võib näida 

pikk ja kohmakas, kuid kõik tõsisemad registrid on üles ehitatud andmeid kodeerides ning andmete pärimine 

toimub ligikaudu selliselt: 

   

Kui on mitu tabelit, siis lisatakse veeru nimedele automaatselt tabeli nimi, sest eri tabelites võib esineda samade 

nimedega veerge. 

Ülal näites jutumärkide vahel olev ’’AADRESS“ on alias ehk veerule jõuga antav veeru nimetus – selle võib ka 

ära jätta, siis pannakse automaatselt veeru nimeks tnimed.tanava_nimi+’’ ’’+centroid.majanumber, mida ei ole 

just ilus vaadata. Nagu pildilt näha, saab alias’e järgi ka tulemuse sorteerida Order by Columns lahtris. 

Kolme tabeli sidumise puhul peab eriti silmas pidama from Tables lahtrisse kirjutatavate tabelite järjekorda. 

Mõlema tabeliga seotud tabel peab asuma loetelus keskel. Antud päring toob lisaks tänava nimele ja maja 

numbrile ning kirjelduse lahtrile kolmandast tabelist ka hoone tüüpi iseloomustava tunnuse. 

 

  

Näide 2 
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Paljudel juhtudel ei saa tabelitevahelise relatsioonita andmestikke üldse normaalselt kirjeldada. Olgu näiteks 

objektideks majad (tunnuseks aadress) ja seal asuvad korterid (tunnusteks number ja elaniku nimi). Üks 

võimalus on teha majade tabelisse nii mitu veergu, kui palju on kortereid ja kirjeldada sinna iga korteri andmed. 

Kuid sellel on palju puudusi: 

* sellises tabelis on väga keeruline teha päringuid 

* tabelis ei saa olla üle 254 veeru 

* tavaliselt ei ole teada, kui palju veerge läheb tarvis 

 

Lahenduseks on jällegi kahe omavahel seotava tabeli kasutamine:  

MAJAD     KORTERID 

 

 

Tabelite sidumiseks on mitmesugustel põhjustel kombeks kasutada eraldi numbrilist nn. identifikaator veergu 

(kuigi võiks kasutada ka aadressi). Antud näitel on tabelitevaheline seos kirjeldatav avaldisega: 

MAJAD.maja_id = korterid.maja_id. Nii on võimalik leida näiteks kõik Metsa 8 aadressiga majas olevad 

korterid ja nende elanikud SQL päringu abil: 

Select Columns: Aadress, Korteri_Number, Elanik 

from Tables: majad,korterid 

Where Condition: majad.maja_id = korterid.maja_id and majad.aadress = "Metsa 8" 

Siin on Where tingimuses and tehtega kokku pandud kaks avaldist: tabelitevahelist seost kirjeldav ning andmeid 

filtreeriv tingimus. Tähele võib panna, et tulemustabelis on ära toodud nii korterite kui majade tabelitest ainult 

olulised veerud: 
Metsa 8 2 Jaan 

Metsa 8 3 Tooma

s 

Näide 3 

Eelmised näited olid tabelite atribuutandmete vaheliste relatsioonide moodustamise kohta. Tabelite 

ruumiobjektide vahel seoste kirjeldamine käib põhimõtteliselt analoogselt, kuid kasutades spetsiaalseid 

ruumitehteid spetsiaalse veeruga Obj (graafiline objekt) kujul: 

 tabel1.obj Contains tabel2.obj  – tabeli 1 kaardiobjekt sisaldab tabeli 2 objekti. 

 tabel1.obj Within tabel2.obj – tabeli 1 kaardiobjekt on tabeli 2 objekti sees (vastandtehe contains – tehtele). 

 tabel1.obj Intersects tabel2.obj – tabeli 1 ja 2 kaardiobjektid lõikuvad. 

Näiteks olgu meil kaks tabelit, üks on alad ja teine on puud. Need vastavad kaardiobjektidele: 

Kaardiobjektid: 

puud: 

 

 

 

 

alad: 
id omanik 

a Anneli 

b Toomas 

(mõlemad id – veerud on vaid viitamiseks näidise kaardipildile, seoses neid ei kasutata!) 

Ruumiliselt kujunevat seost on võimalik kasutada näiteks sellisele tüüpilisele küsimusele vastamiseks: Millised 

puud jäävad kummagi ala omaniku maa peale? 

Maj

a_id 

Aadress 

1 Metsa 8 

2 Oru 32 

Maja_i

d 

Korteri_ 

Number 

Elanik 

1 2 Jaan 

1 3 Tooma
s 

2 1 Peeter 

2 2 Malle 

 

id Nimetus 

1 kask 

2 kuusk 

3 mänd 

4 jalakas 

5 kask 

6 kuusk 

7 mänd 

2

1

3
4 5

6

7

b

a
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Vastuse teada saamiseks kasutame lihtsat SQL päringut: 

Select Columns: alad.omanik, puud.nimetus 

from Tables: alad, puud 

Where Condition: alad.obj contains puud.obj 
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tulemuseks on: 

 

 

 

 

Tähele tasub panna, et ruumilised seosed on juba algselt olemas kõigil kaarditabelitel, sõltumata objektide 

tabelandmetest. Selles seisnebki GIS–i üks põhieeliseid tavalise andmebaasi ees. 

Sageli kasutatakse seda aladele jäävate objektide loendamiseks. Kasutades lisaks ühte agregeerivatest 

funktsioonidest (millest detailsemalt edaspidi) on võimalik leida, mitu objekti jääb kummagi omaniku maatükile: 

Select Columns: alad.omanik, count(*) 

from Tables: alad, puud 

Where Condition: alad.obj contains puud.obj 

Group by Columns: alad.omanik  

tulemuseks on: 

 

 

13.11 Andmete grupeerimine 

Et teada saada, millised on unikaalsed väärtused (N: hoonete tüübid) tabeli veerus, saab teha sellise päringu:  

Select Columns: hooned.tyyp 

from Tables: hooned 

Where Condition: 

Group by Columns: hooned.tyyp 

tulemuseks on: 

 

 

 

Et teada saada, mitu mingeid väärtusi kokku on, tuleb Select Columns lahtris täiendavalt kasutada 

agregeerivat funktsiooni Count(*).  

Järgnev päring on pisut keerukam, kuna objektide arv tuleb teisest tabelist. Tabelis TNIMED on tänavate nimed 

ühekordselt. Tabelis CENTROID on sadakond aadressi. Kahe tabeli siduvaks veeruks on tanava_kood.  

tnimed:      

 

 

 

 

 

 

centroid: 

                                                   

 

omanik nimetus 

Anneli Kuusk 

Anneli Mänd 

Anneli Jalakas 

Toomas Kuusk 

Toomas Mänd 

omanik Count 

Anneli 3 

Toomas 2 

tyyp 

eluhoone 

kõrvalhoon

e 

äripind 

garaaž 
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Leiame, mitu aadressiga hoonet on igal tänaval: 

   

agregeerimise meetodid on järgmised: 

 Average (Avg)  – grupi keskmine 

 Count (Count)  – grupi liikmete hulk/arv 

 Minimum (Min)  – minimaalne väärtus veerus 

 Maximum (Max)  – maksimaalne väärtus veerus 

 Sum  (Sum)        – grupi liikmete summa 

 Weighted Average (WtAvg) – kaalutud keskmine, lubab kasutada teise veeru numbrilisi andmeid igale 

objektile kaalu omistamiseks (tähtsustada ühtesid objekte teiste ees, või kasutada näiteks areaalobjekti 

pindala suurust kaaluva konstandina) 

Näide 4 

Olgu kaks tabelit: 

Seome kaks tabelit relatsiooniga 

objektid.valla_kood = vallad.valla_kood 

Seda seost on võimalik kasutada näiteks järgnevalt: 

1. leida objektide keskmine suurus valdade kaupa: selleks on vaja kasutada agregeerivat funktsiooni 

average(). 

SQL päringus näeks see välja järgnevalt: 

Select Columns: vallad.valla_nimi, avg(objektid.suurus) 

from Tables: objektid, vallad 

where Condition: objektid.valla_kood = vallad.valla_kood 

Group by Columns: vallad.valla_nimi 

Tulemuseks tuleb tabel: 

Saku  167.5 

Viimsi  127.5 

Analoogselt saab leida objektide summa, kasutades funktsiooni avg() asemel sum(). 

2. Leida, suurte (üle 20) objektide summa tabel valdade kaupa: 

Where lahtrisse saab kokku panna nii tabeleid siduva, kui andmeid filtreeriva tingimuse: 

OBJEKTID 
nimi suurus valla_ko

od 

Nelli 13 v12 

Kallaku 322 v12 

Orjala 233 v15 

Vissi 22 v15 

VALLAD 
valla_nimi elanike_arv valla_ko

od 

Saku 1260 v12 

Viimsi 2340 v15 
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 Select columns: vallad.valla_nimi, sum(objektid.suurus) 

 Tables: objektid, vallad 

 where Condition: objektid.valla_kood = vallad.valla_kood and objektid.suurus > 20 

 Group By: vallad.vald 

Tulemuseks tuleb tabel: 

Saku  322 

Viimsi  255 

13.12 Funktsioonid 

Funktsioonide abil saab andmestikega teostada mitmeid arvutusi (N: lugeda tabelisse objekti pindala). 

Funktsioonile antakse reeglina ette argumendid, et näidata, mis muutuja(te)ga protseduur sooritatakse, et saada 

üks kindel tulemus.  

Tabelis on antud sulgudes, mis tüüpi peab olema argument (num – number, date – kuupäev, obj – objekt, text – 

tekstiline). Kui funktsiooni nimi lõpeb $, on selle väärtuseks tekst. Funktsioonide ega muutujate nimedes suur– 

ja väiketähtedel vahet ei tehta;, siin on nad eraldatud selguse huvides. Samas tuleb meeles pidada, et 

tekstimuutujate sisus on suur– ja väiketäht erinevad tähemärgid. 
 

Funktsiooni 

nimi 

Kirjeldus Näide 

Abs(num) Väljastab arvu absoluutväärtuse abs( – 32)  32, abs (32)  32 

Area(obj,ühik) 

 

Väljastab objekti pindala maakera kumerust arvestades; ühik on 

spetsiaalne tekstiväli ( "sq km", "sq m", "hectare"); obj jääbki sellise 

tekstina tinglikuks veerunimeks. Funktsioon Cartesian Area arvutab 

tulemuse tassapinnaliselt. Funktsioon SphericalArea ... 

area(obj,"hectare")  56.03 

CentroidX(obj) Väljastab objekti keskkoha X koordinaadi centroidx(obj)  523328 

(meetersüsteemis) 

centroidx(obj)  24.532123 

(kümnendkraadides) 

CentroidY(obj) Väljastab objekti keskkoha Y koordinaadi centroidy(obj)  6556314 

centroidy(obj)  59.65343 

Chr$(num) Väljastab numbrist (ASCII kood) tähemärgi chr$(13)  reavahetuse märk 

chr$(128)  "ü" 

Cos(num) Väljastab koosinuse väärtuse cos(45)  0.7071067811865 

CurDate() Väljastab jooksva (tänase) kuupäeva CurDate()  "02.11.16" 

CurDateTime() Väljastab jooksva kuupäeva ja kellaaja   

CurTime() Väljastab hetke aja  

Day(date) Eraldab kuupäevast päeva Day(“13.04.95”)  13 

Distance(x1,y1, 

x2,y2,ühik) 

Väljastab kauguse kahe punkti (objektide keskpunktide) vahel. Ühik 

on tekstiline: nt. "m", "km". Funktsioon Cartesian Distance arvutab 

tulemuse tassapinnaliselt. Funktsioon SphericalDistance ... 

distance(centroidX(obj), centroidY(obj), 

24.532123, 59.65343,"km") 

Format$(num, 

muster) 

Annab numbri tekstina vastavalt mallile. Antud käsu lihtsam variant 

on FormatNumber$ ja vastupidine lihtsustatud variant 

DeformatNumber$ 

Format$( 12345.678, " #,## Kr”) “12 

345,68 Kr” 

FormatDate$(...)   

FormatTime$(...)   

GetDate(...)   

GetTime(...)   

Hour(...)   

InStr(pos,tekst, 

alamtekst) 

Väljastab numbrilise väärtuse, millest alates leiti tekst sisaldavat 

alamteksti, otsimine algab pos–ist.  

InStr(1,”Juhan Tomusk”,”To”)7 

Int(num) Ümardab arvu allapoole lõigates komakoha julmalt ära int(23,534)  23 

Lcase$(tekst) Teisendab teksti väiketähtedeks  LCase$(“Jüri”)  “jüri” 

Left$(tekst, pos) Eraldab tekstist vasakult pos arvu sümboleid  left$(“Mihkel”,3)  “Mih” 

Len(tekst) Annab teksti pikkuse Len(“kuusteist”)  9, Len(veerg1)<20 

LTrim$(tekst) Kustutab teksti algusest segavad mittetrükitavad märgid (tühikud, 

tabulaatorid) 

Ltrim$(“ Võhandu”)  “Võhandu” 
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MakeDateTime   

Maximum(num1, 

num2) 

Annab kahest numbrist suurema maximum(32,23)  32 

Mid$(tekst,pos, 

pikkus) 

Lõikab tekstist välja alamteksti alates positsioonist pos ja pikkusega 

pikkus 

Mid$(“Juhan Tomusk”,7,3)  “Tom” 

Minimum(num, 

num) 

Annab kahest numbrist väiksema minimum(0.10, 0.9)  0.1 

Minute   

Month(date) Eraldab kuupäevast kuu  Month(“13.04.95”)  4 

ObjectLen(obj, 

ühik) 

Annab objekti(de) pikkuse(d). Ala ja punkti pikkus on alati null. 

Funktsioon Cartesian ObjectLen arvutab tulemuse tassapinnaliselt. 

Funktsioon SphericalObjectLen ... 

objectlen(obj,"km")  32.42 

Perimeter(obj, ühik) Annab objektide ümbermõõdud. Funktsiooni Cartesian Perimeter 

arvutab tulemuse tassapinnaliselt. Funktsioon SphericalPerimeter ... 

perimeter(obj,"km")  32.42 

PointToMGRS$   

PointToUSNG$   

Proper$(tekst) Väljastab teksti, mille iga sõna algab suure tähega Proper$(“TALLINNA 

VANALINN”)”Tallinna Vanalinn” 

Right$(tekst) Eraldab tekstist paremalt pos arvu sümboleid  Right$(“Mihkel”,3)  “kel” 

Round(num1, 

num2) 

Ümardab arvu num1 täpsusega num2 Round(12.1452, 0.01)  12.15 

Round(12.1452, 1)  12 

round(23432322,100)  23432300 

Rtrim$(tekst) Kustutab teksti lõpust mittetrükitavad märgid (tühikud, tabulaatorid) RTrim$(“Tapa ”)  “Tapa” 

Second   

Sin(num) Väljastab arvu siinuse  

Str$(num) Teisendab avaldise (numbri) tekstiks; objekti (obj) puhul antakse selle 

graafiline tüüp (“Line”, "Polyline", "Point", "Region", "Rectangle", 

"Text", "Ellipse", "Arc", "Rounded Rectangle") 

str$(23234.32)  "23 234.32" 

Ucase$(tekst) Teisendab kogu teksti suurtähtedeks ucase$(“Jaan”)  “JAAN” 

Val(märkavaldis) Annab (teksti) avaldise numbrilise sisu val(“ – 12.3”)  – 12.3 

Weekday(date) Annab kuupäevast nädalapäeva numbrina (1 – pühapäev ... 7 – 

laupäev) 

Weekday(“22.03.96”)  6 

Year(date) Eraldab kuupäevast aasta  year(“13.01.95”)  1995 

13.13 MapBasic akna kasutamine 

MapBasic on programmeerimiskeel, milles saab anda MapInfole käske ning milles on tehtud lisavahendid 

(MBX programmid). Valides Home menüüs Tool Windows > MapBasic Window avaneb käsuaken, mis töötab 

käsurealiidesena (command line interface) ja mis tunnistab MapBasic ja SQL käske. Kasu on aknast mitmeti: 

näiteks näidatakse selles aknas jooksvalt menüüdest ja dialoogidest valitavate käskude kuju SQL keeles / 

MapBasic’us. Seda on hea kasutada SQL keele õppimiseks. Sageli on nii, et on vaja teha palju rutiinseid 

operatsioone erinevate veergude, tabelite vms.–ga. Siis saab liigutused teha üks kord menüükäskude abil ära ja 

hiljem juba muutes käsuaknas algparameetreid, käivitame samad käsud [ENTER] klahvi abil uuesti ja uuesti. Nii 

võib palju aega kokku hoida. Korraga saab käivitada ka mitmerealisi käske, selleks tuleb kõik read hiirega 

lohistades välja valida ning vajutada [ENTER]. 

Mõned menüüdest valitavad käsud koosnevad tegelikult mitmest MapBasic käsust ning siis näidatakse need kõik 

järgemööda käsuaknas, korduvkasutusse võib ka võtta vajadusel vaid ühe käsu nendest. Näiteks tüüpiline Select 

käsk toob MapBasic aknasse kaks rida: “Select * from TABEL1…” ning “Browse from Selection”. Esimene 

nendest teeb valiku tabelist ja teine avab selle valiku tulemuse uues tabeliaknas. 

Käsureale võib trükkida kogu käsu (või viia selle sinna copy–paste abil näiteks tekstifailist) ja käivitamiseks 

vajutada [ENTER] klahvile (seejuures hiire kursor ei pea [ENTER] klahvile vajutamisel olema rea lõpus). 

MapBasicu akna sisu saab alternatiivselt copy–paste meetodile salvestada tekstifaili: hiire parema klahviga 

vajutus MapBasicu aknas, rippmenüüs Save Contents. 

SQL käsud antakse MapBasicus lihtsalt üks–ühele: võib toksida lihtsalt select * from TABEL1, delete from 

TABEL1 where…, kasutades standardset SQL–i.  

MapInfo SQL sisaldab ka vahendeid, mida tavalises SQL keeles ei ole ning mis teevad mitmeid manipulatsioone 

tunduvalt lihtsamaks. Näiteks delete object from TABEL1 kustutab tabelist 1 ära kogu graafilise info jättes alles 

atribuutandmed (sama käsk asub ka Spatial > Clear Map Objects, ainult et siis tuleb eelnevalt valikukäskudega 
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kõik objektid kaardiaknas ära valida. Võimalik on ka osad objektid valida ja ainult nendel graafiline pool ära 

kustutada. 

 

14. Geokodeerimine 

14.1 Mis on geokodeerimine 

Geokodeerimine on nähtuste/objektide sidumine kaardiga e. koordinaatidega – neile asukohainfo ehk 

koordinaatide omistamine. 

Meetodeid selleks on mitmeid: 

1) Joonistamine taustakaardi järgi sh. valitud tabelirea sidumine kaardiobjektiga (valides rea ja joonistades 

kaardiaknas objekti) – seda liigutust käsitleti baaskursuses objektide joonistamise peatükis. 

2) Tabeli veergudes olevate koordinaatide järgi punktobjektide tekitamine Spatial > Create Points – mis on 

enim kasutust leidev meetod näiteks GPS andmete viimisel kaardile. 

3) Kahe tabeli sidumine ühise tunnusveeru järgi, millest üks tabel sisaldab koordinaate. Ehk siis kopeerime 

koordinaadid ühest tabelist teise ja loome nende järgi teises tabelis objektid. Üks tabelitest on nö koordinaat–

andmebaas – koordinaatidega varustatud objektide loetelu, teine tabel on see, mille objektid on vaja kaardiga 

siduda. Näiteks on elanike tabel, kus on iga elaniku juures toodud tema elukoha aadress tavalisel kujul 

(tänava nimi ja maja number). Geokodeerimise tulemusena on võimalik elanikest moodustada kaart, kus iga 

elanikku tähistab kaardil üks sümbolobjekt. Eelduseks on aadressandmebaasi kõigi aadresside ja neile 

vastavate koordinaatidega. 

Selles peatükis keskendume viimasele variandile. Esimene ja teine variant leiavad käsitlemist joonistamise 

peatükis ja GPS temaatilises peatükis. 

14.2 Geokodeerimise alusandmed 

Automaatse geokodeerimise eelduseks on alustabeli olemasolu, milles oleks juba defineeritud mingil viisil 

(kõigi) objektide ruumilised tähendused. Selleks on kaks üldisemat meetodit: 

1. Asukoht on antud iga objekti kohta, näiteks: 

 iga postiindeksi kohta on antud selle kehtivuspiirkonna keskpunkt. Siduvaks andmeväljaks on 

postiindeks. 

 iga eraldi aadressiga maja kohta on tabelis punktobjekt. Siduvaks väljaks on aadressi tekst (asula nimi, 

tänava nimi, maja number). 

Et geokodeerida sellise andmestiku järgi, peavad ka alustabelis (aadress–andmebaas) olemas olema kõik 

vastavad objektid, mis on tähistatud täpselt samal kujul tunnusega, mida kasutatakse geokodeeritavas 

andmestikus. 

2. nn. Streetinfo – meetod 

Spetsiaalselt suurte andmehulkade geokodeerimiseks on meetod, kus aadressid näidatakse tänavajoonte abil. 

Tänavalõiku tähistava joonobjekti kohta öeldakse tänava nimi ning majade aadressivahemik, mis jääb kahele 

poole seda tänavajoont. Konkreetne aadress tänavalõigus saadakse umbkaudse hinnangu (interpoleerimise) abil. 

Selle meetodi eeliseks on kokkuhoid andmemahus (ja andmete rahalises ostuväärtuses), sest ei pea enam 

kirjeldama iga üksikut maja, samas saadav täpsus on enamikel juhtudel täiesti piisav (kuigi see on väiksem, kui 

esimesel meetodil). Andmete tootjale tähendab aga tegelikkuses streetinfo ettevalmistamine lisatööd. 

14.3 Geokodeerimise käik 

1. Ava geokodeeritav tabel ja aadress–andmebaas, 

mis sisaldab koordinaatidega varustatud kõigi 

objektide andmeid ehk siis näiteks: x, y ja 

tunnusveerg, mis muuhulgas peab olema 

indekseeritud (Table > Table > Modify 

Structure –> tabeli valimine –> OK –> Indexed 

ette linnuke). 

2. Spatial > Geocode avab akna, kus tuleb näidata: 

 Geocode Table – geokodeeritav tabel 
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 using Column – tunnusveerg, mille järgi kodeeritakse (nt. aadress, sihtnumber, metsakvartali number) 

 Search Table – alustabel, kus on vajalikud ruumiobjektid juba olemas 

 for Objects in Column – alustabelist kasutatav tunnusveerg (mis vastab geokodeeritava tabeli 

tunnusveerule) 

 Mode – geokodeerimise meetod: 

Automatic – automaatne, kui aadressile täpset vastet ei leita, jäetakse rida geokodeerimata. 

Interactive – kui andmetes on erinevus ja rida ei suudeta automaatselt geokodeerida, saab kasutaja iga 

problemaatilise objekti puhul loetelust valida ligilähedaste tunnuste (tänavanimede, majade, 

sihtnumbrite) hulgast sobivaima. 

 Symbol – sümboli valimine, millega kujutatakse geokodeeritava tabeli objekte kaardil. 

Soovitav on esmalt püüda geokodeerida automaatselt ning seejärel käsitsi ükshaaval (Interactive) probleemsed 

read üle vaadata. Peamine ülesanne on minimeerida käsitsi geokodeeritavate kirjete mahtu. Selleks oleks 

soovitav veel enne geokodeerima asumist geokodeeritav tabel kriitilise pilguga üle vaadata ja silmahakkavad 

vead ära parandada (õigekirjavead, lühendid, tänavanimede laiendid, topelt–tühikud jne.). 

Geokodeerimine ei eristata suur– ja väiketähti, seega ei ole seda õigekirja seisukohalt vaja jälgida. 

14.4 Probleemid 

Seda, et kõik kirjed suudetakse kohe geokodeerida, on 

reaalandmetega tavaliselt võimatu saavutada 

(baastabelist ei tohi puududa ükski kasutatav aadress 

jne). Suurte andmestike puhul läheb automaatselt kokku 

tavaliselt 70–80% andmestikke. Ülejäänud nõuavad 

tavaliselt personaalset lähenemist. 

Mitme sama aadressiga koha eraldamiseks (nt. kui on 

tegu mitme asulaga, milles on loomulikult samanimelisi 

tänavaid) võib kasutada vastavaid alade tabeleid, mille 

nimi antakse lahtris Refine Search... ja vastav veerg 

lahtris Using Boundary... 

Interaktiivsel kodeerimisel, kui alternatiividest on 

valitud välja üks, ei muudeta kodeeritavat tabelit ennast 

(kuigi seal võis tegu olla ainult õigekirjeveaga), st. 

automaatselt seal tunnusveeru andmeid ära ei parandata 

– objekt lihtsalt seotakse kaardiga. Interaktiivsel 

geokodeerimisel võib abiks olla ka Geocode Options 

(avaneb Geocode akna nupust Options...) all olev 

võimalus Display Additional Column, mis võimaldab 

(lisaks tunnusveerule) näidata ka mingi teise veeru 

andmeid (näiteks objekti nime). See võib olla teinekord 

abiks käsitisi geokodeerimisel. 

Juhul, kui ikkagi jäävad üksikud objektid geokodeerimata, võib need kaardile joonistada käsitsi – valides välja 

tabelis rea ning joonistades objekti kaardiaknasse õigesse kohta. 

Juhtumisi valesti geokodeeritud objekti graafilise sümboli kustutamiseks tuleks see objekt välja valida ning anda 

Spatial menüü käsk Clear Map Objects. 

14.5 Lühendite tabel 

on mõeldud selleks, et hakkama saada erinevate lühenditega eri aadresside juures. Lühendite fail koosneb 

sõnaosade paaridest, neist teine on esimese lühend, näiteks: 

! Version 7.0 

PUIESTEE PST 

MAANTEE MNT 

MAANT MNT 

PL PLATS 

TÄNAV  

TN  
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T  

Nendel juhtudel asendatakse aadressis sisalduv tekst PUIESTEE tekstiga PST jne. Lühendite fail 

Mapinfow.abb asub programmi kataloogis ja seda saab täiustada tavalise tekstiredaktoriga (NOTEPAD). 

Viimased kolm rida TÄNAV, TN, T (mille taga on ABB failis füüsiliselt paar–kolm tühikut), asendatakse mitte 

millegagi ja seda ongi vaja saavutada. 

Seda, kas lühendite tabelit kasutatakse geokodeerimisel või mitte, määratakse Geocode Options dialoogiaknas 

Try Subtitutions from „MapInfow.ABB“. Punkte tänava lühendi järel niikuinii ignoreeritakse, sest ABB failis on 

vaikimisi kirjas. 

14.6 Geokodeerimise tulemuse kontrollimine 

Lisavõimalusena pakub geokodeerimise moodul veatüübi raporteerimist – mis põhjusel mingit andmerida ei 

õnnestunud geokodeerida (näiteks tänavanime õigekirjas esines erinevus). Selleks saab eelnevalt tabelisse 

loodud tühja numbrilisse veergu lasta kirjutada vea numbri, mis iseloomustab iga rea puhul geokodeerimise 

tulemust. Vastav veeru nimi määratakse Geocode dialoogi Options… nupu alt parameetriga Put Result Code in 

Column: Soovitan seda kasutada, siis on kohe tabelist näha millised andmed suudeti geokodeerida ja millised 

mitte. Alternatiivne variant oleks teha SQL päring tingimusega not obj – saab kätte objektid, millel graafilist osa 

peale geokodeerimist ei eksisteeri.  

Koodide tähendused on antud MapInfo User’s Guide peatükis Understanding the Geocoding Result Codes. 

14.7 Aadressvahemike abil geokodeerimine  

Keerukam ja võimalusterohkem on lugu aadressilõikude abil geokodeerimisel.  

Tüüpiliselt koosnevad majade aadressid kahest või kolmest komponendist: 

 Tänava nimi 

 Maja number 

 Korteri number (tihti puudub) 

Nende komponentide käsitlemiseks toimuvad MapInfos eri protseduurid: 

Tänavanimed 

Geokodeerimisel püütakse leida täpne, üks–ühene vaste tänavanimede vahel. Kui täpset vastet ei leita, võetakse 

kasutusse lühendite fail (abbrevation file) – mapinfow.abb 

Majanumbrid  

Aadressis antud numbrit võrreldakse alustabelis antud vahemikega. 

MapInfo streetinfo – kujul on tabelinfo iga tänavalõigu kohta antud järgmise tabelina: 
Name FromLeft ToLeft FromRight ToRight 

Paju t 19 31 18 30 

Paju t 33 55 32 54 

Paju t 57 81 56 80 

Selleks, et leida objekt aadressiga “Paju tänav 43”, otsitakse tabelis, kuni jõutakse Paju tänavani ning seejärel 

otsitakse vahemik, kuhu 43 sobib. Antud juhul oleks see 33 – 55 (keskmine tabelis). MapInfo eeldab, et paaris ja 

paaritud tänavanumbrid on erinevatel tänava külgedel.  

Saab öelda, et kui täpselt sobivat vahemikku pole, leitaks automaatselt lähim vaste. Selleks peab sisse olema 

lülitatud parameeter Use the Closest Address Number Geocode akna Options… nupu alt. 

Offset Address Location määrab, kui kaugele tänavajoonest sümbol pannakse, Inset Address Location – määrab 

sümboli asukoha kauguse tänavajoone otsast. 

 

15. Pindteemakaardid 

Pindteemakaardid (surface maps) on 

omapärane ning unikaalne viis visualiseerida 

ruumiliselt hajusalt jagunevaid või levivaid 

nähtusi (nt. lumikatte paksus).  

Meenutame: koropleet–kaardi abil 

(vahemikkaart) näidatakse suurusi värvides ära 

eksisteerivad objektid – näiteks külad, 
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metsakvartalid, maakonnad, kus siis iga objekt värvitakse vastavalt sellele, millisesse vahemikku jääb seda 

objekti mingis veerus iseloomustav numbriline väärtus. See töötab väga hästi kindlate piiridega nähtuste korral, 

samas kui hajusate nähtuste puhul (reostuse levik, lumikatte paksus, rahvastiku tihedus, maapinna kõrgus) on 

selline jaotus tihti lihtsustus ning ei pruugi iseloomustada nähtust adekvaatselt. Äärmusliku näitena võib tuua 

maapinna kõrguse, mis selgelt pole seotud valdade vms. jaotustega kindlateks aladeks. Sellest ülesaamiseks on 

MapInfos võimalus luua pindteemakaarte (grid thematic maps), mille tulemuseks on sujuv levikuala, jagades 

nähtuse suuruse ühtlaselt üle kaardi pinna. 

Alljärgnevas näites on toodud pindteemakaardina rahvastiku tihedus Eestimaal: 

Üks võimalus on kasutada pindteemakaarti maapinna kõrguse visualiseerimiseks. Maailmas on levinud 

peamiselt kaks kõrgusmudeli esitluse meetodit: TIN ja GRID (kolmnurk–mudel ja võrgustikmudel). MapInfo 

toetab mõlemaid. Võrgustikmudel on sujuv pind, mis kirjeldatakse regulaarse ruudustiku punktide (grid node) 

abil. TIN on kolmnurk–mudel, mis luuakse punktide vahele kolmnurkade joonistamisega. Algandmeteks võivad 

MapInfos olla ainult punktandmed (mitte jooned ega areaalid). See ei ole muidugi takistus samakõrgusjoonte 

ega areaalide kasutamiseks – need saab vabavaralise lisavahendiga teisendada punktideks. Lisaks punkti 

asukohale on tähtis ka selle visualiseeritav atribuutväärtus, mida kasutatakse punkti väärtuse (N: kõrguse) 

defineerimisel ning mis peab olema numbriline. Ühel pinnal saab kasutada ühest veerust tulevaid numbrilisi 

väärtusi; samas on võimalik samadest punktidest eri veergude andmeid kasutades vajadusel genereerida mitu 

mudelit ja pinda (seega pindteemakaarti). 

Pindteemakaardi loomine on pisut erinev tavalisest teemakaardist, sest lisandub üks etapp: sujuva "pinna" 

interpoleerimine diskreetsete punktide väärtuste järgi. Selleks on mitmeid matemaatilisi meetodeid, MapInfosse 

on sisse ehitatud üks nendest: Inverse Distance Weighting (IDW). MapBasicu abil on võimalik kasutada ka teisi 

meetodeid, kuid üldiselt on IDW piisavalt universaalne meetod. IDW loob võrkmudeli, TIN kolmnurk–mudeli 

(mille tulemus on vähem sujuv kuid täpsem).  

Üldiselt soovitatakse IDW–d kasutada juhul, kui muutuja on kõrge variatiivsusega (näiteks rahvastiku, 

mullastiku, keskkonnamonitooringu andmete ja tarbijakäitumise uurimise puhul), sest see kasutab kaalutud 

keskmise meetodit, pehmendades pinna moodustamisel originaalandmeid. Siin ei ole eriti tähtsad maksimaalsed 

ja minimaalsed väärtused, vaid pigem iseloomustab tulemus üldist trendi: 

 

Moodustatav võrkmudel salvestatakse formaati Open Grid Format, nii saab kasutada loodud pinda ka edaspidi 

rastri–sarnase pildina, vajamata algandmeid. TIN mudelit võib kasutada kõrgusandmete ja näiteks temperatuuri 

interpoleerimisel, kus andmepunktide väärtuste omavaheline 

suhe on rohkem lineaarne. 

 

Joonised: TIN mudel vasakul (perspektiivis vaadatuna) ning GRID mudel sama ala kohta paremal (perspektiivis 

vaadatuna). 

15.1 Pindteemakaardi loomine: 
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Avada algandmed  

Anda käsk Map > Add Theme 

Vali Type: Grid ja teemakaardi mall (Grid Default) 

Näita 

 tabel, kus on algandmed (N: korgus_p)  

 veerg, mida kasutatakse väärtusena (N: korgus) 

 tabel, mille alade järgi piiratakse pind (selle võib ka määramata jätta, 

kui ei ole soovi areaalobjektiga ala piirata) 

 faili nimi ja kataloog, millesse tulemus (Grid File Name) 

salvestatakse. Hiljem saab mudelit avada tavalise MapInfo tabelina. 

vajuta Next nupule, mille tulemusena avaneb dialoogiaken, milles 

määrame ülejäänud teemakaardi parameetrid: 

 Interpoleerimise algoritm (Interpolator). Vaikimisi on IDW, 

alternatiivne valik TIN. 

võrkmudeli parameetrid (Settings):  

 

 Cell Size (võrgusilma suurus) – vahe võrkmudeli punktide vahel. 

Mida väiksem see on, seda detailsem on pind, kuid kasvab ka 

andmemaht. Optimaalse suuruse valik sõltub algandmete täpsusest 

ja tulemuse kvaliteedieesmärgist. 

 Search Radius (otsimisraadius) – maksimaalne kaugus võrgusilmast, mille seest otsitakse algandmete 

punkte, et arvestades (kaaludes) punkti kaugust võrgusilmast leida visualiseeritava atribuudi keskmine 

väärtus.  

 Exponent – mitmenda astme vähimruute kasutatakse (vaikimisi 2) 

 Grid Border – mudeli äärealast üle ulatuvate võrgusilmade hulk (juhul, kui mudelit piiratakse mingi areaal–

tüüpi objektiga, siis kui palju võib mudel üle selle ulatuda) 

 Aggregate Coincident Points by – saab määrata, kuidas käitutakse võrgustiku moodustamisel 

(interpoleerimisel) juhul, kui samas kohas on mitu punkti. 

Olenevalt andmetest saab muuta ka atribuutandmete agregeerimise 

meetodeid: 

o Leida atribuutväärtuse keskmine (Average) 

o Lugeda punktide koguarv (Count) 

o Summeerida atribuutväärtus (Sum) 

o Leida minimaalne atribuutväärtus (Min) 

o Leida maksimaalne atribuutväärtus (Max) 

 

värvigamma dialoogiaken (Styles…) 
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 Method – kuidas objekte valitakse: 

o Equal Cell Count – vahemikud püütakse määrata nii, et igasse vahemikku jääks võimalikult võrdne arv 

objekte 

o Equal Value Ranges – luuakse automaatselt võrdsed vahemikud minimaalse ja maksimaalse numbrilise 

väärtuse vahele 

o Custom Cell Count – kasutaja defineerib vahemikesse jäävate objektide arvu 

o Custom Value Ranges – minimaalse ja maksimaalse väärtuse, mille vahele vahemikud arvutatakse, saab 

ise määrata 

 Number of Inflections – vahemike arv 

 Round By– millisel tasemel ümardatakse 

 Color Adjustments – pildi kontrasti, heleduse ja poolläbipaistvuste muutmine 

 Grayscale ja Flip Colors – kasutada halltoone, vahetada värviskaala tagurpidiseks 

 Relief shading – reljeefivarjutuse efekti lisamine vastavalt valgusallika (N: päikese) asukohale. See annab 

veelgi loomulikuma kõrguskaardi mulje. 

 Inflection Values – abistav statistika algandmete minimaalsete ja maksimaalsete väärtustega 

Legendi kirjad (Legend…) 

 Title – pealkiri, selle väljanägemine 

 Subtitle – alapealkiri, selle väljanägemine 

 Range Labels – vahemike kirjelduste muutmine 

Kui mudel loodud, siis Map > Map Tools > Info või Home > Tool Windows > Info käsuga saab küsida suvalises 

kohas arvutatud (interpoleeritud) numbrilist väärtust – näiteks kõrgusmudeli puhul maapinna kõrgust. 

Veelgi võimsam vahend GRID kaartide tegemiseks MapInfo Professional keskkonnas on MapInfo Vertical 

Mapper lisatarkvara. 

15.2 Pindteemakaardi visualiseerimine 

Loodud mudel kuvatakse sujuvate üleminekutega värvilise rasterpildina. Seda on võimalik vaadata ka 

perspektiivis kolmemõõtmelise kujutisena spetsiaalses 3D vaateaknas (Home > New Document > 3DMap), mis 

lubab pinda vaadata, suurendada–vähendada, vaate keskpunkti nihutada (panning), muuta vaatenurga kallet, 

“pöörata pilku” 360 kraadi ümberringi. NB! 3D kaardiaknas pildi renderdamine nõuab hea jõudlusega arvutit! 

Home > New Document > 3DMap käsu peale avaneb dialoogiaken, milles määratakse mudeli visualiseerimise 

parameetrid: 
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Camera – vaatenurga muutmiseks (reeglina ei ole tarvis muuta) 

Light – valgusallika asendi ja värvi muutmiseks (reeglina ei ole tarvis muuta) 

Appearance – tulemuse täpsuse / sujuvuse / detailsuse (Resolution) määramine, taustavärvi muutmine, Z telje 

skaala võimendamine (Scale) 

OK nupule vajutus käivitab protsessi, mille tulemusena tuuakse ekraanile 3DMap nimeline aken. Lisaks asendub 

Map menüü 3DWindow nimelise menüüga (kui 3DMap aken on aktiivne) ning sellest menüüst saab juhtida 

tekitatud pildi kuvamist (vaatenurka). Näiteks valides Wireframe, saab tulemust kuvada võrgustikuna (mitte 

värvilise pinnana). Samad 3DWindow menüüs asuvad käsud on olemas ka hiire hüpikmenüüs. 

MapInfos on olemas veel üks huvitav teemakaardi tegemise vahend – Prism Map (Home > New Document > 

Prism Map), mis loob kolmemõõtmelise efektiga kujutise vastavalt tabeli väärtusele  

 

16. Piirkondadeks ümber jaotamine 

Objektide grupeerimine ehk piirkondadeks ümber jaotamine (redistricting, load balancing) on funktsioon, mis 

võimaldab teostada visuaalset what if…analüüsi – „Mis juhtub siis, kui me objektid grupeerime selliselt?“ 

Visuaalselt näidatakse MapInfo kaardiaknas objektide gruppe erineva värviga (luuakse individuaalväärtustega 

teemakaart) ning spetsiaalses tabeliaknas näidatakse gruppide (agregeeritud objektide) atribuutandmeid. See on 

väga võimas ja lihtsalt käsitletav abivahend planeerimisel, eriti just kiirelt muutuvate andmete juures. 

Grupeerida saab nii areaalobjekte (levinuim), joon–, kui punktobjekte. Liigutades ühe objekti teise grupi alla, 

muutuvad „lennult“ kohe mõlema grupi atribuutandmed. Niiviisi saab loominguliselt ja hõlpsasti moodustada 

halduspiirkondi (omavalitsuste ühinemine), valimisringkondasid, müügiterritooriume, posti laialivedamise 

piirkondi, mingeid suvalisi tsoone, arvestades näiteks elanike arvu, elanike sissetuleku suurust, pindalasid, muid 

näitajaid. Näiteks – oletame, et meil on algandmeteks linnades olevad kvartalid, mille atribuutandmeteks on 

kvartalis olevate elanike arv. Ülesanne on moodustada rahvaloenduse piirkonnad kvartalite kokkuliitmise teel 

selliselt, et igasse piirkonda jääks suhteliselt võrdne arv elanikke ning alad oleksid kompaktsed (ei oleks 

lahustükke).   

Tööprotsessi käivitamiseks: 

1) veendu, et avatud on kaardiaken, mis sisaldab infokihti, mida soovid analüüsida ning sellel infokihil on tühi 

või juba grupitunnuseid sisaldav veerg (meie näites RD). 

2) vali Map menüüst käsk Redistricter > New Redistricter Window või  Home  menüüst New Document > 

Redistricter. Selle tulemusena avaneb ligilähedane dialoogiaken: 



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  17-92 

 

kus: 

Source Table – tabel, mille objektidega analüüsi tehakse. 

District Field – veerg, mille alusel esialgsed piirkonnad grupeeritakse. Kõik selles veerus ühesugust väärtust 

omavad objektid grupeeritakse ühte gruppi (maksimaalne võimalik gruppide arv on 594). Kui veeruks määrata 

vastloodud tühi veerg, siis sellisel juhul kuuluvad kõik objektid algul sellesse ühte gruppi ning analüüsija käitub 

selliselt, et moodustab juurde tühjasid gruppe, millistesse hakkab esimesest grupist objekte ümber suunama. 

Available Fields – veerud, mille agregeeritavaid andmeid kasutatakse analüüsi juures objektide jagamisel 

gruppidesse (tüüpiliselt näiteks elanike arv, sissetuleku suurus, pindala). Soovitan veergusid objektide arv 

(Count) ja väljanägemine (Fill/Line/Symbol) Fields to Browse lahtris valituks jätta. 

Calculate Percentage based on – veergude andmete võrdlemisel saab kasutada avaldisi. Column Total valik 

võtab andmed nagu need tabelis kirjas on. Expression puhul saab näiteks veeru andmed konstandiga läbi 

korrutada vms. 

OK vajutus genereerib kaardiaknasse esialgse teemakaardi valmis ning avab ka spetsiaalse tabeliakna (Districts 

Browser), milles näidatakse gruppide agregeeritud tabelandmeid (numbrilise veeru summat ja numbrilise veeru 

osatähtsust % kogusummast). 

Sellele järgneb tegelik loominguline töö, ehk grupeerimine. See toimub niiviisi, et valitakse kaardilt noole 

nupuga objektid välja, seejärel valitakse District Browser tabeliaknas rea päise kaudu üks vaba grupp ja käsuga 

Assign District liigutatakse valitud objektid selle grupi alla. Seejärel valitakse kaardilt järgmised objektid ja 

liigutatakse need teise grupi alla, seda protseduuri korratakse seni, kuni kõik objektid kuuluvad kuhugi. Näiteks, 

igasse gruppi peab jääma selline arv külasid/asulaid, et haldusüksuse maksumaksjate koguarv võrduks 

ligilähedaselt 5000 maksumaksjaga, mida loeme siis piisavaks, et tagada kogu piirkonnale elujõuline areng. 

Kõik piirkondadeks jaotamise käsud asuvad Map > Redistricter nimelises menüüs. Samad käsud asuvad ka sellel 

hetkel hiire hüpikmenüüs. 

Assign District – valitud objektide lisamine teise gruppi 

Set Target – aktiivse grupi valimine kaardilt valitud objekti põhjal 

Add District – uue tühja grupi lisamine 

Delete District – rea päise kaudu valitud grupi kustutamine 

Gruppide värvi saab muuta, tehes hiirega klõpsu värvi lahtris. 

 

17. Tööfaili korrigeerimine 

MapInfo hoiab mitmeid andmeid ja parameetreid tekstifailides. See annab kogenud kasutajale võimaluse 

korrigeerida vajadusel infot tavalise tekstiredaktoriga (nt. NOTEPAD). Kõige enam võib vaja minna 

korrigeerida tööseise (.WOR faile). WOR fail on sisuliselt MapBasic käskude jada tekstifailina. Selles on kõige 

olulisem tavaliselt vaadata faili algust, mis on umbes järgmine: 

!Workspace 

!Version 950 

!Charset WindowsLatin1 

Open Table "C:\Andmed\Linn" As Linn Interactive 

Open Table "C:\Andmed\Maakond" As Maakond Interactive 
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Map From Linn,Maakond 

… 

Set Window FrontWindow() Printer 

Name "\\muri\color_ps" Orientation Portrait Copies 1 

Papersize 9 

…ja kus: 

 teine rida “!Version…” tähistab tööfaili versiooni. Kui kasutada vanemat MapInfo versiooni, kui siin olev 

number, siis ei suuda see avada seda tööseisu (veateade “Cannot Open Workspace, MapInfo Version 6.0 can 

do it”). Kui leppida sellega, et lähevad kaotsi uuema versiooniga tehtud spetsiifilised asjad, siis saab antud 

tööseisu avada peale numbri 600 (mis tähendab MapInfo 6.0–ga ühilduv) asendamist ühega nendest: näiteks 

400 (MapInfo 4.0), 410 (MapInfo 4.1), 450 (MapInfo 4.5), 500 (MapInfo 5.0), 550 (MapInfo 5.5) ning 

loomulikult alles peale NOTEPAD abil WOR faili salvestamist. 

 kolmas rida “!Charset …” tähistab märgitabelit/kooditabelit. Windows–spetsiifiliselt võib tekkida vahel 

probleeme erinevate märgitabelitega, sel juhul antakse veateade tööseisu avamisel (“Cannot Open 

Workspace, unsupported Character Set”). Siis aitab üldiselt universaalse WindowsLatin1 kasutamine 

(problemaatiline võib mõnikord olla näiteks WindowsBalticRim). 

 edasised read “Open Table…” tähistavad avatavaid tabeleid. Siin on oluline tabeli füüsiline 

paiknemine/asukoht kõvakettal (või võrgukettal). Kui see on tööseisu salvestamise järgselt muutunud, ei 

avane tööseis enam korrektselt, ning seda probleemi saab korrigeerida just siin failide asukoha (ketta tähis, 

kataloogi nimi, faili nimi) parandamisega. Kasutada saab ja on soovitav kasutada suhtelisi otsimisteid, 

näiteks “..\..\andmed\eesti” – läheb sellest kataloogist, milles on salvestatud tööseis, kaks kataloogi ettepoole 

ning seejärel läheb sisse „andmed” kataloogi ning avab sellest kihi „eesti.TAB” 

Või näiteks: 

Open Table "voru_pnt" As voru_pnt Interactive 

Open Table "andmed\voru_pnt_KORGUS.TAB" As voru_pnt_KORGUS Interactive 

Open Table "..\voru_pnt_KORGUS2.TAB" As voru_pnt_KORGUS Interactive 

 kus: 

voru_pnt tabel asub tööseisuga samas kataloogis 

voru_pnt_KORGUS.TAB asub tööseisu asukoha kataloogist üks kataloog edasi ANDMED 

alamkataloogis 

voru_pnt_KORGUS2.TAB asub asub tööseisu asukoha kataloogist üks kataloog eespool 

 Edasised read “Map From…” sõltuvad sellest, mis aknad on avatud, mis kihte seal kasutatakse, jne. näidates 

kõik akende parameetrid. Samuti salvestatakse tööseisus ajutisele joonestuskihile ja kujundusaknasse 

joonistatud objektid. Kui neid on palju, võib tööfail paisuda mahult väga suureks. 

 Tööfaili lõpuosas on printeri(te) parameetrid (kui nende salvestamine on Preferences all lubatud). Ka need 

read tuleks maha kustutada, kui on vaja antud tööfaili avada vanema MapInfo versiooniga, kui 5.5 

Vahel võib vaja minna ka TAB ja MIF failide analoogilist korrigeerimist.  

 .TAB fail – sisaldab kaarditabeli kirjeldust, märgitabeli ja MapInfo versiooni tähistust ja kihi metaandmeid. 

Metaandmete salvestamise võimalused TAB faili täiustuvad iga uue MapInfo versiooniga.  

 

Vektorformaadis andmestiku TAB fail ei sisalda koordinaatsüsteemi infot, see on salvestatud MAP faili (mis 

ei ole tekstiredaktoriga muudetav). Rasterformaadis kihi TAB fail sisaldab ka rastri nurgakoordinaate ning 

koordinaatsüsteemi kirjeldust. 

 .MIF ja .MID failid – need kaks faili koos moodustavad MapInfo andmevahetusformaadis 

(eksportformaadis) kaardikihi. MID on sisuliselt komaga eraldatud ASCII andmetabel, kus on objektide 

tabelatribuutandmed, MIF fail sisaldab kaardiinfot. MID/MIF failid väljastatakse MapInfost käsuga Table > 

Export ning tagasi MapInfosse imporditakse käsuga Table > Import. Eriti kasulik on see formaat 

andmevahetuseks teiste GIS–programmidega, sest enamik nendest oskab MIF–i lugeda ja/või kirjutada. TAB 

formaat on suletud formaat MapInfo ärisaladus. 

Näiteks Eesti linnade MIF faili algus võiks olla selline: 

Version 300 

Charset "WindowsLatin1" 

Delimiter "," 

CoordSys Earth Projection 3, 115, 7, 24, 57.51755393056, 58, 59.33333333, 500000, 6375000 Bounds (–165003996.711, –
155108791.233) (166003996.711, 175899202.19) 

Columns 2 

 NIMI Char(20) 
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 EL_ARV Integer 

Data 

Point 579615.7 6443630.9 

 Symbol (46,8421504,9,"MapInfo Cartographic",0,0)  

…kus: 

 Alguses on MapInfo programmiversiooni ja märgitabeli (charset) info, mida võib olla kasulik vahel 

korrigeerida ning väärtuste eraldaja (delimiter). 

 Vahel on vaja muuta “Coordsys…” rida, kus on kirjas kihi koordinaatsüsteemi parameetrid ja kaardiala 

välised piirid (Bounds). Näites on kasutatud Eesti Põhikaardi L–EST97 koordinaatsüsteemi. Problemaatiline 

võib olla, kui kihil on mittegeograafiline koordinaatsüsteem (Non–Earth). Sel juhul võivad objektide 

koordinaadid olla isegi õiged (MapInfo staatusreal näidatakse õigeid koordinaate), kuid erinevaid kaardikihte 

(projected ja non–earth) kokku panna ei saa. Probleemi lahendab töö käik, kus (1) eksporditakse kiht Table 

> Export käsuga MIF formaati, (2) asendatakse MIF failis NOTEPAD tekstiredaktori abil Coordsys… rida 

näiteks L–EST97–ga ning (3) imporditakse tabel uuesti Table > Open > Import käsuga tagasi. Tähele tuleb 

panna, et erinevate koordinaatide puhul peab olema õige ka ühik (tavaliselt meeter).  

 Edasi kirjeldatakse MIF failis kasutatavad atribuutandmete veerud ja peale Data–rida on salvestatud 

graafilised andmed koos iga objekti kuvamise parameetritega (värv, sümbol jms.) 

MIF faili saab lugeda ka ilma MID failita, siis arvestatakse nagu ei oleks atribuutandmeid sisestatud. 

Päringute lisamine tööfaili 

Päringuid, mis käivitatakse peale tööseisu avamist automaatselt, saab samuti lisada tööseisu nii MapInfo kui 

näiteks NOTEPAD abil. Ava NOTEPAD abil WOR fail ja lisa Open Table käskude järele uuele reale päringu 

tekst. Näiteks: Select nimi,majanr From TANAVANIMED, HOONE Where 

HOONE.tanava_id=TANAVANIMED.tanava_id and HOONE.majanr<>"" Into AADRESS 

See käsk teeb päringu, mis toob ekraanile AADRESS nimelise tabeliakna veergudega tänava nimi ja 

majanumber ja valitakse ainult need kirjed, kus majanumbri veerg ei ole tühi lahter. 

Meeldetuletuseks – enne tööfaili salvestamist tuleks alati veenduda, et ei ole lahti jäänud mittevajalikke 

päringuid – sest päringud salvestuvad tööseisu salvestamisel ning aeglustavad tööseisu taasavamist. 

Mittevajalikud päringuid Query1 ... Query23 tuleks enne tööseisu salvestamist sulgeda Home > Close > Close 

Table käsu abil. 

18. Kaardiobjektidega manipuleerimine 

18.1 Objektide kombineerimine 

Objektide kombineerimine on mitme tabeli rea ehk graafilise objekti liitmine üheks kirjeks (objektiks). Siin on 

mitu võimalust: lihtsalt objektid kaardilt välja valida ja kokku liita või teostada liitmine tuginedes tabeli veerus 

olevatele ühistele tunnustele. 

18.1.1 Tabelis oleva ühise tunnuse järgi objektide liitmine 

Vali Spatial > Combine > Combine Using Column. Siin tuleb näidata, millise tabeli objektid liidetakse 

(Combine objects from table), millise veeru andmete järgi liidetakse (Group objects by column) ja millisesse 

tabelisse uued objektid lisatakse (Store Results in Table) ning valida Next. 

Graafiliste objektide liitmisel ja lahutamisel tuleb alati meeles pidada, et koos graafiliste objektidega 

liidetakse/eraldatakse ka atribuuttabeli read (v.a. ajutisel joonestuskihil asuvate objektide puhul, millel 

andmeridu ei eksisteeri). Seetõttu toob MapInfo peale kombineerimiskäsu valikut ekraanile alati ka 

tabelandmete agregeerimise dialoogiakna, kus küsitakse, kuidas käituda tabelandmetega (iga veeru puhul saab 

eraldi määrata). 

Dialoogiaknas kuvab MapInfo veergude nimekirja, kus saab valida veeru, ning meetodi. Võimalikeks 

meetoditeks on : 

 Blank – uuel objektil jäetakse selle veeru lahter tühjaks. 

 Value – uue objekti selle veeru lahtris saab olema kindel väärtus (mis võetakse ühe olemasoleva objekti 

väärtuse järgi). 

 Sum  – uue objekti selle veeru lahtrisse arvutatakse kõigi liidetavate objektide väärtuste summa 

(arvuliste väärtuste puhul). 
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 Average – uue objekti selle veeru lahtrisse arvutatakse kõigi liidetavate objektide väärtuste keskmine (siin 

saab ka näidata, mis veeru järgi keskmine kaalutakse – Weight By). 

Valides OK luuakse näidatud tabelisse uued objektid. Kui tabel on sama, kust andmed võeti, jäävad liidetavad 

objektid sinna alles; tavaliselt salvestatakse tulemus kasutaja poolt aga uude tabelisse – New. 

18.1.2 Kaardilt valitud objektide kokku liitmine 

Eelduseks on kokku liidetavate objektide eelnev kaardilt hiirega valimine. Seejärel anna Spatial menüü käsk 

Combine > Combine Selected Objects. 

Uute objektide kohta luuakse tabeli lõppu uued read, esialgsed objektid kustutatakse (tekivad nn. „hallid read” 

tabelis). Seega on soovitav peale kombineerimiskäskusid kasutada tabeli pakkimise käsku Table > Table > Pack 

Table. 

Combine – liidab kokku valitud graafilised objektid ja tabelisse jääb seda tulemust iseloomustama üks 

andmerida. Sellel andmereal olevate väärtuste iseloom sõltub valikutest, mida on kirjeldatud eelmises lõigus. 

Alates versioonist 6.5 on võimalik kokku liita ka erinevat tüüpi graafilisi objekte (jooned, areaalid, punktid). 

Mitme punkti puhul on tulemuseks multipoint objekt ning teiste puhul collection.  

Spatial > Disaggregate – vastupidine vahend Combine käsule, mis lõhub kompleksobjektid tagasi 

üksikobjektideks (kui need olid lahustükkidana). Disaggregate käsku saab edukalt kasutada ka näiteks aukudega 

areaalidest aukude kihi tekitamiseks. 

18.2 Objektide lõikamine 

Mitmeteks objektidega manipuleerimise operatsioonideks kasutatakse nn. sihtmärgi seadmise meetodit (Set 

Target), mis lubab uute objektide loomiseks kasutada sama või teise kihi objekte. 

Set Target metoodika on järgmine: 

1. Valitakse objekt või objektid, millistest luuakse uued objektid (mis lõhutakse tükkideks, millele lõigatakse 

augud sisse vms.) – need objektid peavad asuma redigeeritaval kihil. 

2. Antakse Spatial menüü käsk Set Target (või klahvivajutus [Ctrl]+[T]). Kehtivat Set Target käsku saab 

tühistada Spatial menüü käsuga Clear Target. 

3. Valitakse objekt(id), mida kasutatakse lõikava(te) objekti(de)na. Need ei pea olema samal kihil. Näiteks võib 

kasutada ajutise joonestuskihi või mõne teise kihi objekte. 

4. Antakse üks järgmistest Spatial menüü käskudest: 

Split:  

> Split Target – objekti(de) lõikamine–poolitamine areaalobjekti abil 

> Split Target Using Polyline – objekti(de) poolitamine joonobjekti abil. MapInfo moodustab 

automaatselt joonobjekti ja lõigatava objekti osa ümber areaali, mida ta siis lõikajana kasutab. 

Kasutajalt oodatakse ainult Next vajutust. Ekraanile ilmub taas dialoogaken, kus saab määrata, kuidas 

käitutakse tabelandmetega, mis nüüd jagunevad kahe objekti vahel. Jagamise meetodi saab anda iga 

veeru jaoks eraldi. Võimalused on: 

• Blank – uutel objektidel jääb konkreetse veeru lahter mõlemal tühjaks. 

• Value – mõlema uue objekti veeru lahtrisse pannakse esialgne väärtus, mis oli jagataval objektil. 

• Area Proportion – arvuliste andmete puhul saab jagada väärtuse proportsionaalselt vastavalt 

moodustavate jagatud alade pindaladele. 

Erase:   

> Erase Target – kustutatakse objektidest osa, mis jääb lõikava objekti sisse – Näiteks kasutatakse seda 

tihti aukude (saarte) tekitamiseks areaalide sisse. Käsku saab kasutada ka tüki välja lõikamiseks. 

> Erase Outside Target – valitud objekti(de)st väljapoole jäävate objektide kustutamine; kustutatakse 

objektidest osa, mis jääb lõikajast välja 

Nodes > Overlay Nodes Onto Target – lisab Set Target käsu abil valitud joon– ja areaalobjektile 

lisapunkte (nodes) kohtadesse, kus see objekt ristub/lõikub teise valitud objektiga. 

Erandiks on Split > Polyline Split at Node, mis poolitab murdjoone näidatavas nurgapunktis ja eeldab 

kasutajalt kõigepealt murdjoone valimist, Reshape käsku, seejärel nurgapunkti valimist ja seejärel 

poolitamiskäsku Split > Polyline Split at Node. 
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18.3 Automaatne polügoonide moodustamine 

Käsk Spatial > Regions > Enclose (Polylines to Regions) on mõeldud automaatseks areaalobjektide 

moodustamiseks kasutades ära olemasolevaid äärejoonte–andmeid (jooned ja areaalid). Ehk siis tegemist on 

automaatse piirjoontest areaalide moodustamise funktsiooniga. 

Käsk Spatial > Buffer > Convex Hull moodustab uue areaalobjekti nii, et valitud objektide nurgapunktid jäävad 

tervikuna moodustatava areaali sisse – tekib väikseim võimalik ümar algobjekti ümbritsev areaalobjekt 

(minimum bounding polygon). 

Käsk Spatial > Regions > Voronoi tekitab punktandmetele mõjupiirkonnad lineaarse interpoleerimise teel. 

Tulemuseks on sellise kujuga areaalid iga punkti ümber kus igas kohas areaali sees on kaugus selle areaali 

keskpunktini väiksem võrreldes kaugusega suvalise teise punktini. 

18.4 Automaatne topoloogia korrastamine 

Sageli juhtub andmete joonistamisel nii, et ei suudeta ideaalse topoloogiaga objekte joonistada (objektid ei ole 

snäpitud, nad lähevad kattuma või jäävad kohati üksteisest kaugele, objektid ristuvad iseendaga, tekivad 

kiilualad, kuigi piir peaks täpselt kokku langema). MapInfos on selliste vigade kontrollimiseks ja parandamiseks 

käsud Check Regions, Clean, Snap/Thin. Nende käivitamise eelduseks on kaardilt välja valitud objektid, mille 

korrasolekut soovitakse kontrollida. 

Spatial > Fix/Clean > Check Regions – saab kontrollida kohti, kus areaal ristub iseendaga (self – intersections), 

erinevate areaalide kattuvuse kohti (overlaps) ning kohti, kus areaalide piir peaks kattuma, kuid tegelikkuses ei 

kattu (vahel on auk –gap). Viimaste puhul tuleb määrata ka maksimaalne ala suurus, mida loetakse auguks, 

määrates selle pindala (Maximum Gap Area), ning ühikud, milles pindala mõõdetakse (Area Units). Check 

Regions tekitab probleemsetesse kohtadesse uued objektid (ristumiskohtadesse sümbolobjekti ja 

kattuvuskohtadesse värvilised areaalobjektid). Need on soovitus paigutada eraldi (ajutisele) kihile. Järgmise 

sammuna tuleks probleemid ükshaaval üle vaadata ja ära parandada. 

   

Kattuvusprobleemide puhuks on Spatial menüüs olemas ka automaatne parandamise käsk Fix/Clean > Clean 

Objects, kuid selle käsu rakendamise korral soovitan olla ettevaatlik ja eelnevalt pisut katsetada, kuna kahe 

areaali vahele ei leita mingit keskmist piiri, vaid kiiluala liidetakse MapInfo versioonides 6.5 ja 7.0 suurima 

pindalaga areaali külge ja MapInfo 7.5 versioonist alates liidetakse „kiiluala” pikema küljepikkusega 

(keerukama piiriga) areaali külge. 

Spatial > Fix/Clean > Snap / Thin – haarab (snap) kokku nurgapunktid, silub ühist piiri, kaotab ära 

topeltpunktid ning eemaldab augud.  



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  19-97 

 

Inter–Object Node Snap – kasutatakse eri objektide nurgapunktide kokkupanekuks. Seda saab kasutada 

polügoonide kattuvus–probleemide lahendamiseks ja joonobjektide otsapunktide kokkupanekuks (kaks 

jooneotsa peavad koos olema, kuid tegelikkuses ei ole). NB! Jooni ja areaale tuleb parandada eraldi. Tolerantsi 

mõõdetakse, kasutades ristkoordinaatsüsteemi, seega tuleb arvestada, et Longitud/Latitude koordinaatsüsteemi 

kasutades ei ole tolerantsi määramine absoluutselt täpne. 

 End Node Tolerance – kasutatakse otsapunktide automaatseks kokkupanekuks 

 Internal Node Tolerance – kasutatakse sisemiste nurgapunktide automaatseks kokkupanekuks 

Tolerance Units – määratakse kasutatav mõõtühik 

Node Thinning/Generalization – kasutatakse joonte ja äärejoonte silumiseks punktide vahelt ära võtmise kaudu. 

Siludes kahe areaali ühist äärejoont, säilitatakse nende kattuvus. Idee on selles, et esimese ja kolmanda punkti 

vahele tõmmatakse mõtteline sirge ja võrreldakse teise–vahepealse punkti kaugust sellest sirgest. Kui see kaugus 

on väiksem või võrdne 3–Node Collinear Deviation lahtris määratud kaugusega, siis see punkt eemaldatakse. 

Node Separation – kui ühe joone või areaalobjekti kaks nurgapunkti on üksteisele lähemal, kui siin lahtris 

määratud kaugus, siis üks nendest punktidest eemaldatakse. Sobib ka hästi üksteise peale sattunud topelt–

nurgapunktide eemaldamiseks. Distance Units lahtris määratakse kasutatav mõõtühikute süsteem. 

Polygon Area Thinning – kasutatakse pindalalt väiksemate kui... areaalobjektide (sageli suure areaali aukude) 

eemaldamiseks. Millisest pindalast väiksemad areaalid automaatselt eemaldatakse, määratakse ära Minimum 

Area lahtris. Area Units lahter määrab mõõtühiku. Kasutades Longitude/Latitude koordinaatsüsteemi, on pindala 

määramine pisut ebatäpne. 

 

19. GPS andmete kasutamine 

GPS andmete näitamiseks MapInfo kaardiaknas on mitu võimalust: Andmeid saab näidata  

1) Importides GPS seadme mällu salvestatud andmed kontoris MapInfo TAB formaati. Paljud tarkvarad (näiteks 

GPSU – www.gpsu.co.uk) suudavad GPS seadmest andmed väljastada MID/MIF failina, mille saab hõpsasti 

MapInfosse importida. 

2) Online režiimis – GPS seade on ühendatud kaasaskantava arvutiga ning näitab väljas/autos viibides MapInfo 

kaardiaknas reaalajas asukohta. Asukohapunkte või teekonna joont on võimalik samal ajal ka salvestada. Siin on 

vajalik GeoGraphic Tracker lisavahendi kasutamine, mis tuleb eraldi installeerida MapInfo CD pealt. 

19.1 GPS andmete toomine MapInfosse tekstifailist 

GPS seade salvestab reeglina asukoha–info enda mällu. Kui see sealt mingi spetsiaalse tarkvaraga arvutisse 

lugeda ja salvestada, siis on üsna sageli tekib tekstifail, mille väljanägemine võib olla ligilähedaselt selline: 
1 58 55 48.10416 N 22 35 33.42578 E 18.05603 3/5/2002 6:44:39  PESA 

2 58 55 48.17586 N 22 35 33.48285 E 18.81355 3/5/2002 6:44:48   
3 58 55 48.18063 N 22 35 33.4802 E 19.13131 3/5/2002 6:44:49 J. ALGUS 

http://www.gpsu.co.uk/
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Tähelepanelikult vaadates on kusagil kindlasti tegemist koordinaatidega. Antud näites on:  

* esimene veerg rea identifikaator 

* veergudes 2–5 on kirjas punkti laiuskraadi koordinaadid (kraad–minut–sekund, põhjalaiuse tähis N) 

* veergudes 6–9 on kirjas punkti pikkuskraadi koordinaadid 

* veerus 10 punkti kõrgus 

* veerus 11–12 kuupäev ja kellaaeg 

* veerus 13 välitöö käigus GPS abil sisestatud selgitav tekst antud punkti kohta 

Hea on, kui koordinaadid on kohe ühes veerus kümnendkraadi kujul (N:22.59262,58.93003) Või kui nad seda ei 

ole, kuid on siiski ühes tulbas (59:34:25), siis on MapInfoga kaasas MBX lisavahend Degree Converter, mis 

teisendab kraadikoordinaate kuuekümnendsüsteemist (kraad:minut:sekund) kümnendsüsteemi kraadideks 

(24.45566) ja vajadusel vastupidi. Ülal toodud näites tuleb koordinaadid kõigepealt ühte veergu kokku liita, 

kuna MapInfo suudab koordinaatide järgi punktobjektid kaardile kanda siis, kui koordinaat on kirjutatud ühte 

lahtrisse kas meetersüsteemis või kümnendkraadides. Kõige lihtsam on veerge kokku liita Microsoft Excel abil, 

avades GPS tekstifaili Excelis ja kirjutades vabasse veergu (siin näiteks veergu 14) järgmise valemi:  

=kraad+(minut+sekund/60)/60 

kus kraad on antud juhul veerg 2 (B1), minut on veerg 3 (C1) ja sekund on veerg 4 (D1) 

ning kopeerides seda valemit kõigile ridadele (lohistades lahtri alumisest paremast nurgast).  

Sarnane operatsioon tuleb sooritada ka Y koordinaatidega ja õigete algveergudega. 

Seejärel saab MapInfos luua Longitud/Latitude (WGS84) koordinaatsüsteemis  

 

uue tabeli vastava struktuuriga (näiteks SELETUS tüübiga character(30), X float, Y float) 



MapInfo koolituse terviklik teooriakonspekt  © Reach-U koolitus 1996–2016 

02.11.2016  19-99 

 

ning copy–paste abil viimased kolm Excelis olevat veergu 13–15 MapInfo tabelisse tuua (kui arvutis on 

Regional Setting’ud määratud Estonian, siis võib olla vajalik kõigepealt tõsta need kolm veergu tekstifaili, 

asendada komaga kujutatud koma , punktiga . (sest MapInfos on komakoha eraldajaks alati punkt) ja alles 

siis tõsta kogu kupatus MapInfo tabelisse. 

Järgmine samm on käsk Spatial > Create Points 

 

Viimasena kasutame käsku Home > Save > Save Copy As, et tabel salvestada uue nime alla L–EST97 

koordinaatsüsteemis. 

Võimalik on ka Excel või tekstiformaadis faili avamine Open käsuga ja seejärel Table > Table > Modify 

Structure kaudu selle kaardistatavaks tegemine (Table is Mappable ette linnuke) seejärel Projection nupu alt 

valida Longitude/Latitude WGS84, edasi Create Points ja Save Copy As uue nime alla. Seejärel võiks selle uue 

faili avada ja muuta ära veergude vaikimisi nimed (COL1, COL2 jne.) endale mugavamaks. 

19.2 GPS–andmete vaatamine online režiimis 

MapInfo installeerimise CD pealt Install Products – Install Utilities – GPS käivitub The GeoGraphics Tracker 

installeerimine. See lisaprogramm on litsentseeritud kõigile MapInfo Professional programmi kasutajatele ning 

eraldi selle eest raha ei taheta. Programmi abil on võimalik vaadata MapInfo kaardiaknas reaalajas GPS 

seadmest tulevaid asukohaandmeid. Reeglina on siin tegemist siis juhtumiga, kus sõidetakse autoga ja kaasas on 

arvuti (laptop), millesse on installeeritud MapInfo Professional ja GeoGraphics Tracker programm ja selle 

arvutiga on ühendatud GPS seade. Kontoriruumis sees ei ole mõtet katsetada, kuna GPS vastuvõtja ei suuda 

hoones olles kinni püüda satelliitide signaali (GPS seadme aknalaual asudes võib–olla suudab). GPS seade 
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ühendatakse arvutiga COM pordi, USB pordi või traadita ühenduse (bluetooth) kaudu. Seadistamisel tuleb 

jälgida ühenduskiirusi (Bits per second, Baud Rate), need peavad olema kolmes kohas ühesugused (GPS seadme 

parameetrites, pordi parameetrites ja GeoGraphic Tracker parameetrites). Andmete edastuskiiruse võiks määrata 

näiteks 9600 või uuemate seadmete korral ka kiirema. 

1) käivita MapInfo Professional 

2) ava aluskaardi andmed (ühtegi kaarditabelit avamata väljastab GeoGraphic Tracker veateate) 

3) käivita Home > Tool Windows > MapBasic ja GPS alamkataloogist GEOTRACK.MBX  

4) esimest korda sisenedes määra ühenduskiirus GPS > Set GPS Receiver Options ja Baud Rate 

5) vali File > Live GPS Data, et vaadata reaalajas asukohta kaardil (F3 – funktsiooniklahv) 

Andmete jooksvaks salvestamiseks tuleb The GeoGraphic Tracker failimenüüst (mitte MapInfo GPS menüüst) 

valida Record GPS Data. Eelduseks on, et avatud on redigeeritav tabel, milles on veerud X ja Y koordinaadi 

ning märkuste jaoks. Mõnedel juhtudel on GPS asukohapunkt kaardil nihkes võrreldes aluskaardi infoga – 

tavaliselt aitab siis Map > Map Options alt kaardiakna koordinaatsüsteemi määramine kuvamise ajaks 

Longitude/Latitude (WGS84), sest kõik vanemad GPS seadmed ei pruugi toetada L–EST97 süsteemi. 

Käsuga Simulated GPS data, saab salvestatud .gps faile kaardil simuleerimiseks–näitamiseks sisse lugeda  

Set Preferences alt saab määrata mitmeid parameetreid – näiteks andmete kuva uuendamise intervalli 

sekundites, ühikuid koordinaatide–, kõrguse– ja kiiruse väärtuste näitamiseks 

Käskudega View Satellite Signal Strengths ja View Satellite Configuration vaadata nähtaval olevate satelliitide 

parameetreid. 

 

20. Andmevahetus väliste andmebaasisüsteemidega 

20.1 ODBC andmestikud 

ODBC on vahend eelkõige klient–server andmebaasidest andmete lugemiseks, näiteks Oracle või Microsoft 

SQL Server jpt.  

 Kui serverilt loetav tabeliinfo sisaldab ruumiinfot (üldiselt objektide X ja Y koordinaate), siis saab need 

MapInfos kaardistada punktobjektidena automaatselt. 

 Andmestik võib olla ainult lugemiseks, kui ka lugemiseks ja kirjutamiseks, võib olla kättesaadav puhvri 

(cache) vahendusel või „elusalt” (live–data). Selle määrab kasutaja tavaliselt andmebaasiühenduse loomisel 

tabeli avamise käigus. 

20.2 Oracle Spatial 

Suuremates geoinfosüsteemides tasub kaaluda Oracle andmebaasisüsteemi tarkvara kasutamist kõigi andmete 

salvestamise kohana (nii tabelandmed, kui ka graafilised kaardiandmed). MapInfo Professional on võimaldanud 

just Oracle andmebaasi kõigi andmete salvestamise kohana kasutada alates Oracle vastava tehnoloogia – Oracle 

Spatial esitlemise algusest peale. Praeguseks on Oracle Spatial kujunenud de facto standardiks ruumiandmete 

salvestamisel andmebaasisüsteemi. Lisaks andmete salvestamise kohana sisaldab Oracle Spatial tegelikult ka 

traditsioonilisi GIS tarkvara analüüsifunktsioone – ruumipäringuid, toetab koordinaatsüsteeme, LRS–i (linear 

referencing system), lubab andmebaasi salvestada ka koordinaatinfoga seotud rasterfaile, kuid kuna 

klienditarkvara (näiteks MapInfo) abil on GIS funktsionaalsus lihtsamini kasutatav, siis on Oracle pigem kõigi 

andmete salvestamise turvaline koht, kui GIS töökohatarkvara asendaja.  

Andmebaasipõhine lähenemine annab:  

 eelise kiiruses juhul, kui on vaja ülal pidada (väga) suuremahulist informatsiooni, süsteemil on palju 

kasutajaid ja päringud, mida andmebaas peab rahuldama, on keerukad 

 kõik andmed on samas keskkonnas – ühes andmebaasis – aitab tagada andmete turvalisuse ja terviklikkuse 

 samasid andmeid võivad paralleelselt kasutada erinevad GIS– ja "tavalised" programmid, samuti on teiste 

kasutajate jaoks muutmiseks lukus ainult need objektid, mida keegi teine hetkel muudab, mitte ei ole lukus 

terve fail (nagu see oleks failipõhisel süsteemil) 

 geoinfot dokumenteeritakse, struktureeritakse ja töödeldakse samamoodi nagu "tavalisi" tabelandmeid 

 saab luua nii kahekihilisi (klient–server) kui kolmekihilisi (klient–aplikatsiooniserver–andmebaasiserver) 

geoinfosüsteeme 
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 saab hakata dokumenteerima objektidega manipuleerimise ajalugu, mis varem ei olnud võimalik teisiti, kui 

tehes graafikafailidest ja andmebaasist üheaegselt ja perioodiliselt varukoopiaid. Nüüd saab luua süsteemi, 

mis väljastab geoinfo andmebaasi hetkeolukorra näiteks täpselt kolm kuud tagasi kell 13:00. 

 

21. Programmi tööparameetrite muutmine 

Peale MapInfo installeerimist on soovitav muuta osasid programmi tööparameetreid, mis omakorda võib 

edaspidi mugandada töötamist ja hoida kokku aega. Parameetritele pääseb ligi akna Pro > Options kaudu. 

Vastupidiselt näiteks aktiivse kaardiakna parameetrite määramisele (Map > Map Options) jäävad Options aknas 

määratavad parameetrid kehtima alatiseks arvutisse sisse loginud konkreetse MapInfo kasutaja jaoks. 

21.1 System  

System Settings: 
 Units – vaikimisi mõõtühikute seadistamine (alates MapInfo versioonist 8.5): paberi ja kujundusakna ühikud 

(Paper and Layout Units), vahemaade mõõtmisteks (Distance Units), pindala näitamiseks (Area Units).  

 Number of Undo Objects – mitme objektiga tehtud muudatused võetakse tagasi (soovitav ja maksimaalne arv 

hetkel 800). Tagasi ei saa teatavasti võtta operatsioone, mille juures MapInfo annab ise eelnevalt teada, et 

tagasivõtmine ei ole peale operatsiooni teostamist enam võimalik ning ka Save, Revert, Modify Table 

käskudega toimunut ei saa tagasi võtta. 

 Memory Size for Undo – selleks, et saaks tagasi võtta kuni 800 objektiga tehtava muudatuse, peavad valitud 

objektid oma mahult mitte ületama siin määratud numbrit baitites (min 102400, maks. 10 000 000) 

 Color Defaults – millist värviprofiili teemakaartide tegemisel kasutatakse (reeglina ei ole vaja muuta). Black 

ja White võib kasutada siis, kui soovime halltoonides teemakaarti, Color valikut juhul, kui omame must–

valget monitori ja soovime värvilist väljatrükki. 

 Encode Workspaces and Tab Files – 

 Enable True Color Cursors –  

 Date window for 2–digit Years – millisest numbrist alates käsitletakse kahe sümboliga antud aastaarvu 

eelmise sajandi aastaarvuna. 

 Copy To Clipboard – kontrollib, millist infot on võimalik lõikepuhvri (copy–paste käskude) kaudu teistesse 

programmidesse viia (reeglina ei ole vaja muuta) 

 Window Export and Clipboard Resolution – vaikimisi resolutsioon, mida kasutatakse Save Window As käsu 

ning Copy Map Window puhul pildi viimisel lõikepuhvrisse. Vaikimisi on see konkreetse arvuti ekraani 

resolutsioon. 

 Display Pre–Version 4 Symbols Using TrueType Font– kuidas käitutakse MapInfo Professional neljandast 

versioonist (4.0) varasemate MapInfo versioonide sümbolitega (Eestimaal sellist probleemi ei ole, kõigil 

kasutajatel on MapInfo versiooniks 4.0 või hilisem, seega ei ole tarvis antud parameetrit muuta). 

 Display Vertical Mapper GRD files as – kas Vertical Mapper GRID faili näidatakse GRID failina (Grid), 

rasterfailina (Raster) või Default valikuna, mis käsitleb seda kas rastrina või GRID–ina (juhul, kui TAB failis 

on kirjeldatud spetsiifiline stiilikood 6 1). 

 Enable Multi-touch – puutetundliku ekraani lubamine 

 New Tables – uute tabelite loomisel kasutatavad seadistused 

Styles: 
 Default Object Styles – millised on programmi käivitamise järgselt vaikimisi uute joonistatavate objektide 

väljanägemine (areaalide–joonte–sümbolite–tekstide/märgiste jaoks eraldi) 

 Enhanced Rendering Defaults for New Windows: 

 Highlight Control – kontrollib kaardiaknas valitud objektide väljanägemist (võimalik jällegi määrata iga 

objektitüübi jaoks eraldi) 

 Default Find Style – määrab, milline on Find käsu puhul kasutatav sümbol. 

Startup: 
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 Save MAPINFOW.WOR when Exciting MapInfo – kas väljudes salvestada tööseis MAPINFOW.WOR 

selleks, et järgmisel programmi käivitamisel saaks kasutaja taastada väljumisaegse seisu käsuga restore 

previous session 

 Load MAPINFOW.WOR when Exciting MapInfo – viimati avatud tööseis laetakse MapInfo käivitamisel 

automaatselt, ilma küsimata. 

 Save Queries in  Workspaces – kui väljas, siis ei salvesta MapInfo tööseisu sisse tehtud päringuid. 

 Save Printer Information into Workspaces – kas salvestada printerit puudutav info tööseisu (printeri nimi, 

paberi suurus ja orientatsioon, koopiate arv). See on üks asi (peale tööseisu versiooninumbri), mis reeglina 

takistab uute versioonidega salvestatud tööseisu varasemates MapInfo versioonides avamast – abiks 

vastavate ridade kustutamine tööfailist ja samuti versiooninumbri muutmine varasemaks !Version 950 –> 

!Version 600. Asutusest väljapoole andmeid saates võiks need read eelnevalt maha võtta. 

 Restore Printer Information from Workspaces – kas taastada printereid puudutav info tööfaili avamisel. 

 Default DBMS Connection – saab määrata vaikimisi välise andmebaasiühenduse. 

 Display Quick Start Dialog – kas näidatakse Quick Start dialoogi MapInfo käivitamisel või mitte. 

Custom Colors: 

 MapInfo värvipaleti muutmine 

Directories: 

Võimaldab määrata mitmesuguseid vaikimisi andmete otsimise katalooge. Näiteks oleks kindlasti kasulik muuta 

järgmist tüüpi failide otsimise katalooge (mida esmalt Open käsu peale otsima hakatakse): 

 Tables – kuhu salvestatakse kaardikihid/tabelid.  

 Workspaces – kus asuvad tavaliselt salvestatud tööseisud. 

 SQL Queries – kuhu kataloogi salvestatakse tavaliselt päringuid 

Defineerida tuleks sellised kataloogid, kus reaalselt andmeid hoitakse. Search Directories for Tables alla saab 

üles loetleda 4 erinevat kataloogi, millest MapInfo veel omakorda vaikimisi otsib tööseisu avamisel tööseisus 

sisalduvaid tabeleid, millel puudub täielik viide asukohale. 

Workgroup Directory alt saab määrata kõigile grupikasutajatele ühise kataloogi, millest laetakse 

projektsioonifailid, kujundusmallid, sümbolid, serverite nimekirjad ja muud programmiseaded. Ühiskataloog 

kindlustab, et kõigil kasutajatel on ligipääs samadele projektsioonidele, mallidele ja sümbolitele. 

MapInfo tabelandmete avamise järjekord on selline: 

o TAB failis kirjeldatud kohast 

o Samast kataloogist, milles paikneb TAB fail 

o Search Directories for Tables parameetriga määratud kataloogidest 

Address Matching: 
 Numbers Before Street Name – kas geokodeerimise funktsiooni kasutamise korral on veerus maja number 

enne tänava nime või vastupidi – Numbers After Street Name 

Web Services: 
 Veebiteenuseid pakkuvate serveritega ühendusparameetrite seadistamine 

Image Processing: 
 Reprojection Using – kuidas käsitletakse kaardiaknas rasterpilte. Kas rasterpilti ei arvutata vastavalt 

projektsioonile ümber kunagi (Never), arvutatakse ümber alati (Always) või kasutatakse optimeeritud 

meetodit (Optimized). See tähendab, et kontrollitakse, kas rasterpildi servakoordinaadid moodustavad 

kaardiaknas paralleelsete külgedega ristküliku või ei ning vastavalt sellele kasutatakse lihttransformatsioone 

või arvutatakse rasterpilt täielikult ümber uuele projektsioonile. 

 Resampling Method – millist meetodit kasutatakse rasterpildi ümberarvutusel. Cubic Convolution arvutab 

uue piksliväärtuse kaalumise ja interpoleerimise abil 4×4 pikslises aknas. Annab parema tulemuse kui teine 

valik, Nearest Neighbour ehk lähima naabri valimise meetod. 

Performance: 

 Concurrency Level – millises ulatuses jagab MapInfo protsessimise arvuti tuumade vahel ära 

 Smart Indexing – MapInfo eemaldab enne töötlemist selle protsessi kiirendamiseks indeksid ning pärast 

töötluse lõppu loob need uuesti 
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Notifications: 

 Check for a new maintenance patch once in... – kas ja mis aja tagant kontrollib MapInfo uuenduste 

olemasolu 

 Update me on news from PB once in... – kas ja mis aja tagant teavitatakse Pitney Bowesi tooteuudistest 

 Update Server Request Timeout – kui pikk peab olema aeg, mille jooksul MapInfo ei suuda kontakteeruda 

teavituste serveriga, et ühendus loetaks aegunuks 

Application: 

 Ribbon Tab Switching – kuidas MapInfo liigub ribamenüüde vahel, kui aktiviseeritakse erinevaid aknaid  

 Load State on Startup – MapInfo käivitamisel laetakse see koos kasutajaliidese kohandustega 

 Save on Exit – kasutaja tehtud kohandused kasutajaliidesesse salvestatakse MapInfo sulgemisel 

 Enable Ribbon on Floating Windows – ujuvatel akendel kuvatakse ribamenüü individuaalselt 

Workspace: 

 Auto Save Workspace every – tööseis salvestatakse automaatselt valitud aja tagant 

 Backup on Save – iga kord, kui tööseis salvestatakse, luuakse ka tagavarakoopia 

 Prompt to Save – kõigi tabelite sulgemisel ja MapInfost väljudes pakutakse ka tööseisu salvestamist 

 Include Window Location, State or Size Changes – muudatustena on vaja salvestada ka akende suurused, 

asukohad ja kuvamise viis 

 Include Tool Windows with Workspace – tööseisu alla kuuluvad ka tööriistaaknad 

21.2 Window 

Map Window: 

Display: 

 When Resizing Map Window – kas kaardiakna suuruse muutmisel säilitatakse suurendusaste (Preserve 

Current Scale) või suurendatakse pilti vastavalt akna suuruse muutmisele (Fit Map To New Window). 

Muutus ei mõju juba avatud akendele, sellisel juhul aitab vahepeal programmist väljumine. 

 Apply Clip Region Using – kuidas käitutakse Clip Region funktsiooni puhul (st. kas käsule alluvad ka 

regioonist välja jäävad teatud tüüpi objektid – tekstid, rastrid jms.) 

 Scroll Bars – kas näidata kaardiakna juures kerimisribasid või mitte. 

 Autoscroll – kas automaatne kuva liigutamine akna ääre lähedale sattudes on lubatud või mitte. 

Mittekogenud kasutajal on soovitav Autoscroll välja lülitada. 

 Show InfoTips – kas näidata abistavat informatsiooni st. käsunupu lühiseletust kollase kasti sees, kui hiirt 

üle sekundi käsunupu kohal hoida. 

 Automatic Raster Zoom Layering – kas avatavate rastrite puhul kasutab programm automaatset zoom 

layering funktsiooni so. kontrollib seda, kas rasterfail peale tema avamist on kohe kasvõi kribuna 

kaardiaknas näha või mitte. 

 Automatic Grid Zoom Layering – kas võrgustikmudelite puhul kasutada automaatset zoom layering 

funktsiooni või mitte. 

 Draw Layers Under Themes – sisselülitatult võimaldab ühe kihi kohta tekitada mitu teemakaarti (näiteks 

vahemik– ja individuaalväärtustega kaart). 

 Automatically Open Default Theme – sisselülitatult avatakse kiht ja näidatakse kohe kaardiaknas selle 

kihi kohta varem tehtud ja salvestatud teemakaarti. 

 Enable HardWare Accelereation for 3DMap Windows – kas lubada arvuti videokaardil 3D–aknas info 

kuvamisel kasutada nimetatud võimalust (mis peaks kiirendama kuvamist info detailsuse kaotamise 

hinnaga). 

 Mouse Wheel Zoom Based on Cursor Location: hiire rullikuga suurendamisel suurendab seda kohta, kus 

paikneb kursor 

 Handler for New Grids – mis vahendit kasutades luuakse uusi võrgustikmudeleid. Valik sõltub arvutisse 

installeeritud lisatarkvarast – näiteks MapInfo Vertical Mapper–ist. 

Editing: 
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 Warn Prior to Loss of – kas programm hoiatab (või mitte) enne tabeli/programmi sulgemist et tööfaili 

mitte salvestamisel on oht ära kaotada ajutise joonestuskihi objekte, märgiseid, teemakaardi kihte jms. 

 Move Duplicate Nodes in: the same layer – sellise valiku korral nurgapunktide nihutamisega (Reshape 

käsk) tuleb kaasa ka teise samal kihil oleva ja nihutatava objektiga ühist piiri omava objekti nurgapunkt 

(et ei peaks eraldi nihutama). 

 Digitizing Options – haaramisrežiimi tolerantsi määramine (Snap Tolerance), kui kaugelt objekti 

nurgapunktist (mõõdetuna ekraani pikslites) hiir haarab automaatselt selle objekti külge. Autonode 

tolerance – kui tihedalt üksteise kõrvale on nurgapunkte lubatud vabakäe–joonistusrežiimis joonistada. 

Vaikimisi mitte lähemale, kui 10 pikslit iga suurenduse juures. 

 Find Selection Options – kuidas käitutakse päringuga leitud objektide kaardiaknas näitamisel. Vaikimisi 

valik on nagu alati – ühe objekti puhul jääb kaardiakna suurendusaste samaks, kuid uus valik on Zoom on 

Find Seletion – kaardiakna kuva suurendatakse selliselt, et objekt on aknasse optimaalselt ära mahutatud. 

Find Selection after Paste – kleepimiskäsu järgselt toimub objektide kuvamine Find Selection reeglite 

järgi. 

Projection: 

 Default Projections – Table Projection määrab vaikimisi koordinaatsüsteemi uue tabeli loomisel, 

andmete importimisel ning rasterfaili registreerimisel. Session Projection määrab vaikimisi 

koordinaatsüsteemi sisemiseks tööks – MapBasic funktsioonide tarbeks (näiteks CentroidX(obj) – 

punktidele koordinaatide lugemiseks tabelisse). Soovitav on mõlemad valikud määrata L–EST97. 

 Display Coordinates – kuidas kaardiaknas kuvatakse koordinaate (kas kümnendkraadides, kujul kraad–

minut–sekund või teatud militaarses süsteemis). 

 Distance/Area Using – kas vaikimisi tehakse kõik mõõtmised ja võrdlused mööda kumerat maapinda 

mõõtes (Spherical) või tasapinnaliselt (Cartesian). Soovitatav valik on Cartesian, kui töötatakse valla 

tasandil objektidega. 

Adornments: 

 Adornment – kaardiakna lisade, nagu näiteks joonmõõtkava, logo vms. vaikimisi paigutuse ja stiili 

määrangud. Default position määrab asukoha kaardiaknas, offsett nihke määratud asukoha suhtes. Custom 

position võimaldab määrata asukoha kaugusena kaardiakna ülemisest vasakust nurgast. 

 Scale Bar Adonment – määrab joonmõõtkava kujunduse vaikimisi parameetrid 

Browser Window: 

Alternating Row Color – tabelis värviliselt kuvatavate ridade värv 

Explorer:  

 Sections – milliseid gruppe Exploreri aknas näidatakse 

 Remember Section Heights – iga grupi kõrgus säilitatakse 

Legend Window: 

Kartograafilise legendi vaikimisi parameetrite muutmine (pealkirja ja alapealkirja stiil, legendikirje sümboli stiil, 

raami stiil) 

Legend Frame Defaults:  

# märk asendatakse automaatselt tabeli nimega (saab kasutada nii Title, Subtitle kui Style Name Pattern lahtris). 

Võib jätta siin lahtris ka lihtsalt # või üldse ära kaotada, küll aga on soovitus # märki kasutada järgmises Style Name 

Pattern lahtris. 

% saab kasutada ainult Style Name Pattern korral – näitab graafilise objekti tüüpi. 

Aa nupu alt saab muuta legenditeksti välimust (kirja stiil, kirja suurus, värv jne). 

Legend Frame Sample Sizes – kui suur on legendi tingmärk  

Display Grid by Default – vaikimisi kuvatakse abijoonestikku 

Snap to Grid Enabled by Default – abijoonestiku külge haakimine on vaikimisi sisse lülitatud, kui kastis on linnuke 

Saab määrata ka abijoonestiku värvi (Grid Color ja Guideline Color) 

Layers: 
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 Maps to show in list – kas ja milliseid kaarte kuvada Layers aknas (Kõik/ainult aktiivne/list „pakitakse kokku“ 

ruumi kokkuhoiu huvides) 

 Confirm removal of layers – kihtide eemaldamisel küsitakse kinnitust 

 Show ToolTips when cursor is over layer list – kui hiire kursor on kihi kohal nimekirjas, siis kuvatakse selle 

kohta suumimisinfot ja failiteesid 

 Show icons for styles and layer types – kihi nimekirjas näidatakse kihil olevate objektide tüüpe ja stiile  

 Show Friendly Names – kihtide nimesid saab endale meelepärasemaks muuta ilma, et muutuks nt .TAB faili 

nimi 

 Use Description Field for Friendly Name – Friendly Name pannakse automaatselt .TAB faili kirjelduse lahtrist 

MapBasic: 

 Enter Key executes command – Enter vajutamine käivitab käsu 

 Enable Syntax Highlighting – teatud koodijuppide esiletõstmine on lubatud 

Task Manager: 

Show notification when task completes – kui toiming lõpetatakse, siis ilmub teavitus 

Window List: 

Show Tools – akende nimekirjas on ära toodud ka tööriistaaknad 

21.3 Devices 

Printer: 

Saab määrata, kas kasutatakse alati Windows Print Manager kaudu määratud vaikimisi printerit või micngit 

konkreetset, millest alati MapInfo asju välja trükkida soovitakse ja mis ei ole muidu kasutaja vaikimisi Windows 

printer.  

Output Settings: 

Display: 

 Display Settings – Kas kuvada ja trükkida raster– või GRID–tabel täisvärvides või mitte. Täisvärvid 

omistatakse vaikimisi parameetriks, kui ekraanil kuvatavate värvide arv on suurem 256–st. Kui 

täisvärvid on välja lülitatud või kui need on sees, kuid ekraanil kuvatakse 256 või vähem värvi, siis 

hakkab mängima Dither Method, mis määrab muidu täisvärviliste piltide teisendamise meetodi 

väiksema arvu värvide peale. 

Printing: 

 Printing Settings – saab valida, kas trükitakse otse väljundseadmesse (Printing Directly To Device) või 

trükitakse kõigepealt EMF formaadis fail ning seejärel saadetakse see väljundseadmesse (Print Using 

Enchanced Metafile). Väljundseade peab olema võimeline EMF faili vastu võtma. Poolläbipaistvate 

rastrite kasutamise korral soovitatakse trükkida läbi EMF faili. Print using Offscreen Bitmap määrab, et 

enne printimist genereeritakse kõigepealt bitmap pildifail mis saadetakse väljundseadmesse. 

 Print Border For Map Window – kas kaardiaknale trükitakse raam ümber või mitte. 

 Internal Handling for Transparent Vector Fills and Symbols – lubab MapInfol veel omakorda kasutada 

spetsiaalset lähenemist läbipaistvate objektide trükkimisel. Vastasel juhul jääb see töö Microsoft 

Windowsi ja väljundseadme kanda. 

 Scale Patterns – kas mustrite sisu säilitab oma suhtelise suuruse/tiheduse sõltumata kaardiakna 

suurendusest ja kas seda kohandatakse vastavalt väljundseadme võimalikule trükkimise kvaliteedile või 

mitte. Soovitav on mustrite trükkimisel katsetada, kuidas paremini konkreetsesse printerisse trükkimisel 

asi toimib. 

 Subdivide Printing – printimisel jagatakse printimiskäsk mitmeks väiksemaks alamülesandeks, et 

saavutada paremat trükikvaliteeti. Kasulik väga suurte läbipaistvust kasutavate rasterpiltide printimisel. 

 Polygon Mode – iga kaardiobjekt joonistatakse korraga ühe käsuga. Linnukese eemaldamisel kasutab 

MapInfo spetsiaalset optimeeritud lähenemist. 

 Use ROP Method to Display Transparent Raster – sama asi läbipaistvate rastri– või GRID tabelitega, 

kuid siin on MapInfo poolne soovitus katsetada, kas seda tasub kasutada või mitte. Soovitatakse 

kasutada, kui väljundformaat on valitud metafail (EMF või WMF). 

 Print Raster In True Color When Possible – raster trükitakse täisvärvides, kui väljundseade seda toetab. 

Dither Method määrab täisvärvide teisendamise meetodi väiksema arvu värvide peale, kui väljundseade 
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täisvärvides trükki ei toeta või kui Print Raster In True Color When Possible parameeter on välja 

lülitatud. 

 Dither Method – määrab muidu täisvärviliste piltide teisendamise meetodi väiksema arvu värvide peale. 

Exporting: 

 Window Export sektsioon – kõik samad asjad (v.a. Scale Patterns), mis ülalpool nimetatud, kuid siin 

olevad määrangud kehtivad, kui kasutatakse trükkimisel käsku Save Window As. Alates MapInfo 

versioonist 8.5 on siia lisatud ka anti–aliaising tugi, mis võib parandada rastri loetavust (eelkõige 

tekstide osas). Filter all on erinevad rasterpildi sujuvamaks tegemise meetodid. Mask Size all saab 

määrata, mitme piksli osas objektide ümber pooltoone tekitatakse. Treshold – saab määrata 

heledusastme, millest alates rastril kujutatud objekte sujuvamaks muudetakse.  

21.4 MapInfo Pro Raster 

Preferences: 

Display:  

 Color Table – vaikimisi avatavale rastrile omistatav värviskeem 

 Display Transform – rastri kuvamise viis 

 Enable Hill Shade – nõlvavarjutuse lubamine  

 Sun Angle – kujutletav päikese nurk  

 Sun Elevation – kujutletav päikese kõrgus 

 Enable Sun Highlight -  

 Highlight Angle  

 Highlight Elevation 

 Generate Raster Overview Cache    

 Apply Changes Automatically -  muudatuste automaatne sisseviimine 

 Show Band Unit – näita kanali ühikut 

 Show Color table name – näita värvitabeli nime 

 Enable Block Access  

 Enable Display Resampling  

 Display Resampling Method  

 Legend Mapping – rastri legendi kuvamine kaardil 

Memory & Performance: 

 Memory Cache Size – vahemälu suurus 

 Automatic Interpolation Cache Size – MapInfo kontrollib automaatselt vahemälu suurust 

File Paths: 

 Temporary Folder – kausta failitee, kuhu paigutatakse ajutised failid 

Windows: 

 Windows Display Mode – kas aken paigutatakse ujuvalt või kleebituna 

 Preserve Map Window Scale – kaardiakna mõõtkava säilib samal ajal, kui teostatakse rastritega 

toiminguid 

 Restrict Decimal Precision – komakohtade arvu piiramine 

 Remember Task Window State – kas Task Window avatakse iga kord, kui uus toiming tööle pannakse 

(jätab meelde, mis seisu aken jäi). 

Output Settings: 

 MRR Compression – kuidas kokku pakkida MRR-na salvestatavaid rastreid 

 Compression Level – kokkupakkimise tase 

 MRR Compression Imagery – kuidas pakkida kokku sisendrastreid  

 Compression Level –  kokkupakkimise tase  

 Display Raster on completion of processing – kuva raster pärast töötluse lõppu 
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 Open Raster Preferred View – eelistatud rastrite avamise vaate valimine (uus kaardiaken/ aktiivne 

kaardiaken/ automaatne/ kohe ei kuvatagi) 

 Encoding Type - kodeerimisviis 

Raster  Formats: 

Erinevad rastriformaadid, mille avamist ja töötlemist saab teha MapInfos 

Processing & Analysis: 

Sampling Frequency – joonel asuvate punktide arv Line Stats ja Cross Section tööriistade puhul 

 

 

22. Lisavahendid 

22.1 Programmiga kaasas olevad lisavahendid 

Asuvad: \Program Files\MapInfo\Professional\Tools\ kataloogis 

Kasutatakse: siis, kui vaja :), Käivituvad: Open > Program, või Home > Tool Extensions 

 Load Tool (Run) – käivita tööriist käimasolevaks sessiooniks 

 Edit Registered Tool Information – muuda registreeritud tööriista infot 

 Unregister Tool – eemalda tööriist 

Home > Tool Extensions > Registered abil on mõistlik sagedamini kasutatavad lisavahendid määrata automaatselt 

käivitatavateks lülitades sisse Autoload valikukasti. See garanteerib, et need käsud on alati menüüs kohe olemas. 

Running paneelis kuvatakse hetkel töötavad vahendid ning Recent paneelis need, mida hiljuti on kasutatud. 

Vajutades hiireklahviga laiendusereal, näidatakse infot selle kohta, mida lisavahendiga teha saab. 

 
 Catalog Browser – võimaldab avada OGC standardile vastavaid CSW metaandmete katalooge 

 Command Editor – kiirklahvide ja otseteede muutmine 

 Coordinate Extractor – lihtne vahend objektide keskpunktide koordinaatide lugemiseks tabelisse. Vajadusel 

saab samas dialoogiaknas tekitada jooksvalt uued koordinaatveerud ning määrata suvalise koordinaatsüsteemi, 

millises koordinaate tahetakse tabelisse lugeda. 

 Coordsys Bounds Manager – võimaldab ümber defineerida kaardistatava ala ulatuse (Bounds väärtused) ehk 

tegelikult selle, kui täpselt me saame joonistada. Vajalik mõnikord suuremõõtkavaliste projektide, 

teostusjooniste ja plaanide juures, kus objekte tuleb salvestada millimeetri täpsusega. Sisuliselt on tegemist 
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töövälja ulatuse ja resolutsiooni ümberdefineerimisega konkreetse kihi jaoks. Reeglina on 99% andmetest Eestis 

muutmata vaikimisi tööväljaga, mis lubab joonistada 16.5 cm täpsusega. 

 Degree Converter – teisendab kraadikoordinaate kümnendsüsteemist (24.45566) kuuekümnendsüsteemi (kraad–

minut–sekund) ja vastupidi. Ka ühekaupa simuleerimise režiimis. 

 Delete Duplicates – kustutab tabelist topeltandmetega kirjed (töötab kahtlaselt!) 

 Distance Calculator – leiab tabeli (või kahe tabeli võrdluses) iga objekti jaoks temale lähima või kaugeima 

objekti samast (või teisest tabelist) + näitab kauguse väärtust. 

 GELink – võimaldab kaardiakna info „kokku sulatada” GoogleEarth satelliidipiltidega. Eeltingimuseks on, et 

GoogleEarth tarkvara on arvutisse eraldi installeeritud () versioon 3.0 on hetkel soovitatav valik. 

 Grid Maker – kaardile (koordinaat)võrgustiku loomiseks. 

 Layout Scalebar – vahend mõõtkava paigutamiseks kaardiaknasse 

 MapCAD – kaardijoonistamise lisavahendid 

 MapInfo EasyLoader – töövahend .TAB failide laadimiseks andmebaasi 

 MapInfo Pro Raster – Raster ja võrgustikandmete loomise ja muutmise tööriistad 

 Named Views – kaardiakna (keskpunkti koordinaatide ja suurendusastme) seisu salvestamine, et seda igal 

hilisemal ajal taas esile kutsuda. Ei eelda tööfaili salvestamist ega salvestushetkel aknas näha olnud samade 

tabelite eelnevat avamist, taas–väljakutsumine toob kaardiaknasse sama piirkonna suvaliste avatud andmete 

korral. 

 North Arrow – põhjasuuna asetamiseks kaardiaknasse. 

 Proportional Overlap – võimaldab proportsionaalselt agregeerida infot kahe tabeli objektide ruumisuhete alusel 

 Register Vector Utility – vahend vektorteisendusteks ehk andmete tõstmiseks–venitamiseks nende soovitud 

asukohta. 

 Rotate Symbols – saab etteantava nurga võrra keerata tabeli ulatuses kõiki sümboleid. Nurga suurus võib olla 

kirjutatud ka tabelisse numbrilisse veergu ja seega saab igat sümbolobjekti keerata individuaalselt erineva nurga 

võrra.  

 Seamless Manager – võimaldab tekitada „tavalise” MapInfo tabeli, mille kaudu saab korraga avada palju 

kaardikihte (näiteks planšette). Kihi loomise eelduseks on, et korraga avatavatel kihtidel oleks sama tabeli 

struktuur. 

 Search & Replace – otsi ja asenda tekst/tekstistring tabeli mingis kindlas veerus mingi teise tekstiga. 

 Spider Graph – arvutab kaugusmaatriksi objektide (kliendid, inimesed, mis iganes kaardil olevad objektid) ja 

nendega reaalelus seotud "keskuste" vahel (kontorid, koolid, perearstikeskused,…) ning visualiseerib tulemuse 

efektselt kaardiaknas. 

 Sync Windows – kaardiakende sünkroniseerimise vahend – hea kasutada info vaatamiseks mitme kaardiakna 

kaudu, kusjuures eri kaardiakendes on taustaks erinev aluskaart. Võimaldab ka joonistada objekte korraga kõigi 

kaardiakende ajutistele joonestuskihtidele. 

 Universal Translator – tänuväärne lisavahend andmete konverteerimiseks levinud GIS failiformaatide vahel 

(MapInfo TAB, MapInfo MID/MIF, AutoCAD DWG, Bentley DGN, ESRI Shape). 

 Workspace Packager - MapInfo tööseisus sisalduvate andmete kokkukogumiseks ühte kataloogi ja sellele 

vastavalt tööseisu koopia salvestamine. Mugav vahend andmete kokkukogumiseks, kui on vaja kellelegi saata 

andmeid koos neid andmeid korrektselt avava tööseisuga. 

Metaandmed on andmed andmestike endi kohta. Info haldusel on need väga suure tähtsusega, sest iga kasutatava 

andmestiku kohta võiks/peaks olema tüüpiliselt teada: 

o mis andmestik see on 

o mis on andmestiku objektid 

o milliseid objektide kirjeldusi andmestik sisaldab (tabeli veerud) 

o kui vana on andmestik 

o millal vajatakse uuendamist 

o kes on andmestiku loonud 

o kes tohivad seda andmestikku kasutada 

o kes kasutas/muutis viimati andmestikku 

o millal tehti andmestikust varukoopia ja kuhu see tehti 
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o GIS puhul:  

o millist geograafilist ala andmestik katab 

o mis koordinaatsüsteemi kasutatakse 

o milline on koordinaatide täpsusaste (mõõtkava) 

o milline on info tihedus 

o jne jne. 

Metaandmed võivad olla eri tasemetel:  

1. kogu kõvakettal asuva andmebaasi metaandmed (nt. kes on andmestiku hooldaja) 

2. andmekogumite (tabelid) metaandmed (nt. mis tabeliga on tegu) 

3. tabeliveergude metaandmed (nt. mis tüüpi andmed on mingis veerus) 

4. tabeliridade metaandmed (nt. kes lisas selle rea, millal) 

Suurte infosüsteemide puhul ehitatakse eraldi protseduurid metaandmete kasutamiseks ja loomiseks, väikeste 

andmekogumite puhul saab selle lahendada poolautomaatselt. Oluline ei olegi, kuidas see info on salvestatud 

(tekstifailis, paberi peal või mujal), vaid et see oleks piisaval kujul olemas, kättesaadav, korrektne ning säiliks. 

22.2 Tasuta lisavahendid 

Lisaks MapInfoga kaasas olevatele Home > Tool Extensions > Registered kataloogi lisavahenditele, on võimalik 

internetist leida hulga tasuta lisavahendeid. Neid võib otsida Home > Tool Extensions > Options > Get Tools 

22.3 Tasulised lisaprogrammid 

22.3.1 MapInfo enda toodetavad – näiteks MapInfo Vertical Mapper 

Algselt Kanadas Northwood GeoScience (www.northwoodgeo.com) poolt tehtud korralik abivahend keerukamaks 

GRID mudelil põhinevaks analüüsiks. Aastal 2003 omandas selle tarkvara edasise arendamise– ja müügi õigused 

MapInfo Corp. Näiteks saab selle tarkvara abil tekitada maapinna kõrgusmudeleid, kuid programm sobib ka mitte–

kõrgusliku andmestiku jaoks. Vaid väike osa analoogsest funktsionaalsusest on MapInfos olemas pindteemakaardi 

(GRID thematic map) nime all. Eestis kasutatakse Vertical Mapperit vähemasti kaheksas asutuses: Jõgeva ja Ida–

Viru Maavalitsuses, TPÜ Geoökoloogia õppetoolis, TTÜ Mäeinstituudis, Tartu Ülikoolis, Põllumajandusuuringute 

Keskuses, Muinsuskaitseametis ning Regios. 

Peamised funktsioonid: 

1. Pinnamudeli genereerimine 

o punktandmetest interpoleerimise meetoditega: 

o ruumimudelitest modelleerimise meetoditega: 

o MapInfo areaalobjektidest 

o importides mitmetest välistest formaatidest: 

2. Pinnamudeli visualiseerimine ja info küsimine 

o kolmemõõtmelise (3D) vaatamisprogrammi abil, pinna tekstuurina saab kasutada kaardipilti 

o MapInfo kaardiaknas rasterkihina 

o mudelist pinna väärtuse (kõrguse) küsimine punkti, ala või joone lõikes 

3. Kontuuride moodustamine 

o nii samakõrgusaladena, kui – joontena 

4. Ruumianalüüsis pinnamudeli kasutamine 

o mudeli kalkulaator : pindadega tehted (liitmine/lahutamine, korrutamine/jagamine jpm) 

o mudeli päring : valitakse mingile tingimusele vastav piirkond (nt. kõrgusega kuni 100m või languga vähemalt 45 

kraadi) 

o läbilõike moodustamine 

o punkti ja ala inspekteerimine (pinna väärtuse leidmine, vastupidine pinna moodustamisele) 

o Kahe punkti vaheline nähtavusanalüüs ja ühe punkti nähtavuse analüüs (kasutatakse enamasti raadiolevi 

planeerimisel) 

5. Pinnamudeli konverteerimine erinevatesse väljundformaatidesse (loetletud on levinumad) 

o ASCII Point File – X, Y, Z tühikuga eraldatud tekstifail 

o MapInfo Table (.TAB) file – punktabel Z väärtusena atribuutveerus. 

http://www.northwoodgeo.com/
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o Windows Bitmap (.BMP) file – arvestades visuaalseid parameetreid (värvigammat) 

6. Andmete agregeerimine ja ruumistatistika 

o agregeerimine on vajalik, et vähendada punktide arvu andmestikus, saab kasutada mitmeid erinevaid meetodeid: 

7. Loomuliku naabruse (natural neigbourhood) analüüs 

o kasutatakse Delaunay triangulatsiooni, et moodustada pinnast omakorda alad. 

o Voronoi diagrammid (iga punkti ümbritseb regioon, moodustub "kärg") 

o punktide tiheduse arvutamine (tiheduseks on punkti ümbritseva regiooni pindala) 

22.3.2 EverName 

EverMap (http://www.evermap.com) poolt tehtud vahend märgiste asukoha automaatseks optimeerimiseks. 

22.3.3 Encom Discover 

Vähemalt samavõrd võimas lisaprogramm, kui MapInfo Vertical Mapper, aga suunitlusega geoloogiliste 

andmestike kaardistamiseks, analüüsiks ja visualiseerimiseks (http://www.encom.com.au/template2.asp?pageid=9). 

23. Klahvikombinatsioonid-lühivalikud 

Funktsiooniklahvid: 

F1 – Help      

F2 – Edit a cell/ Rename a Window      

F3 –  New Map Window        

F4 – New Browser Window 

F5 –  New Layout Window 

F8 - Text Style 

F9 – Add Theme 

F10 - Prism Window 

HotKey’d: 

Snap  S  AutoNode N 

Crosshair C  Autotrace T 

Klahvikombinatsioonid: 

Käsk Klahvikombinatsioon Menüü 

Add Workspace Ctrl+Shift+A HOME 

Clone Window Ctrl+Shift+C HOME 

Info Window Ctrl+Shift+I HOME 

Layers Window Ctrl+Shift+L HOME 

Legend Window Ctrl+Shift+G HOME 

MapBasic Window Ctrl+Shift+B HOME 

Browser Window F4 HOME 

Prism Window F10 HOME 

Run MapBasic Program Ctrl+U HOME 

Table Window Ctrl+Shift+T HOME 

Tasks Ctrl+Shift+K HOME 

Tool Manager Ctrl+Shift+U HOME 

3D Map Window F11 HOME 

Layout Window F5 HOME/LAYOUT 

Map Window F3 HOME/MAP 

Redistricter Window Shift+F4 HOME/MAP 

http://www.evermap.com/
http://www.encom.com.au/template2.asp?pageid=9
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Redraw Window Ctrl+D HOME/MAP 

Statistics Window Ctrl+Shift+Z HOME/MAP 

Workspace Explorer Window Ctrl+Shift+E HOME/MAP 

Copy Ctrl+C HOME/SPATIAL 

Cut Ctrl+X HOME/SPATIAL 

Paste Ctrl+V HOME/SPATIAL 

Undo Ctrl+Z HOME/SPATIAL 

Save Table Ctrl+S HOME/TABLE 

Save Workspace Ctrl+K HOME/TABLE 

Open Workspace Ctrl+Shift+O HOME/TABLE/MAP 

Open Table Ctrl+O HOME/TABLE/MAP/LAYOUT 

Print Ctrl+P LAYOUT 

Remove Delete LAYOUT 

Add Legend Shift+F3 MAP 

Add Theme F9 MAP 

Map Redraw On/Off Ctrl+Shift+D MAP 

Previous View Alt+vasak nooleklahv MAP 

Clear Ctrl+W MAP/TABLE/SPATIAL 

Exit Alt+F4 PRO 

Add Node Ctrl+Shift+N SPATIAL 

Clear Target Ctrl+Delete SPATIAL 

Line Style Shift+F8 SPATIAL 

Region Style Ctrl+F8 SPATIAL 

Reshape Ctrl+R SPATIAL 

Set Target Ctrl+T SPATIAL 

Snap to Nodes S Key SPATIAL 

Symbol Style Alt+F8 SPATIAL 

Text Style F8 SPATIAL 

Add New Row Ctrl+E TABLE 

New Table Ctrl+N TABLE 

WFS Table Refresh Alt+F5 TABLE 

Find Selection Ctrl+Shift+F TABLE/MAP/SPATIAL 

Find and Mark Ctrl+F TABLE/SPATIAL 

Akendele omased käsud (kui vastav aken on aktiveeritud): 

Explorer Window 

Liigub kaardisektsiooni Alt-M 

Liigub tabelisektsiooni Alt-T 

Liigub akendesektsiooni Alt-W 

Liigub ühenduste sektsiooni Alt-C 

Liigub otsingulahtrisse ALT+F 

Liigub järgmise objekti juurde Tab 

Window List  

Hüpikmenüü Shift+F10 

Akna ümbernimetamine F2 

Vali kõik sama tüüpi aknad Ctrl+A 

Sulge aken Del 
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Muuda aken nähtavaks/peida Tühikuklahv 

Akna aktiveerimine Enter või topeltklõps 

Aktiveeri aken, aga jäta klaviatuur aktiivseks Window Listi suhtes Ctrl+Enter 

Akna dubleerimine Ctrl-Shift+C 

Connections Window 

Hüpikmenüü Shift+F10 

Sulge Delete 

Lisa uus ühendus Ins 

Ava ühenduse kaudu tabel Enter või topeltklõps 

Layers Window  

Hüpikmenüü Shift+F10 

Nimeta kaart ümber F2 

Vali kõik või vali kõik grupist Ctrl+A 

Muuda kiht nähtavaks/peida Tühikuklahv 

Ava Layer Properties aken Shift+P või topeltklõps 

Muuda kiht redigeeritavaks Shift+E 

Muuda kiht valitavaks Shift+S 

Lülita sisse/välja automaatsed märgised  Shift+L 

Lülita sisse/välja võimalus tervet kihti vaadata Shift+V 

Style Override Swatch Hiireklõps või  Enter 

Mitme objekti valimine Shift+ nooleklahvid 

On a map node: activate the map and keep focus on the Layers list Hiireklõps või  Enter 

On a map node: activate that map and set keyboard focus on Map window Ctrl+Enter (Alt+Click) 

On a map node: view entire layer Shift+V 

On a map node: Collapse/Expand Node Shift+-/+ 

On a map node: Collapse/Expand Node all nodes Ctrl+Shift+-/+ 

Tables Window  

Hüpikmenüü Shift+F10 

Vali kõik või vali kõik grupist Ctrl+A 

Ava üks või enam kihte uues kaardiaknas Shift+M 

Ava üks või enam kihte olemasolevas kaardiaknas Shift+C 

Ava üks või enam kihte uues tabeliaknas Shift+B 

Sulge kihte Del 

Muuda tabeli struktuuri Topeltklõps 

Layout Window  

Hüpikmenüü Shift+F10 

Vali kõik raamid Ctrl+A 

Selekteerimine Shift+S 

Kaardi nihutamine Shift+P 

Suurendamine/vähendamine + / - 

Selekteeritud raamide liigutamine Nooleklahvid 

Selekteeritud raamide liigutamine kindla sammuga Shift+nooleklahvid 

Raami lõikamine lõikelauale Ctrl+X 

Raami kopeerimine lõikelauale Ctrl+C 

Raami kleepimine lõikelaualt Ctrl+V 

Selekteeritud raami kustutamine Del 
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Mahuta kujundus tööaknasse Shift+F 

Kujundus printimisel Ctrl+P 

Hiire ratta kerimine kujundusaknas suurendab/vähendab kujunduspilti  

Map Window 

Hüpikmenüü Shift+F10 

Nihuta kaardi keskpunkti Nooled 

Lülita sisse käänupunktide külge haakimine S  

Cross-hair C key C  

Auto node N key N  

Mööda olemasolevaid objekte joonistamise aktiveerimine T 

Suurendamine/vähendamine +/- 

Hiire ratta kerimine kaardiaknas suurendab/vähendab kaardipilti  

Browser Window  

Hüpikmenüü Shift+F10 

Vali kõik Ctrl+A 

Uurs rida Ctrl+E 

Muuda lahtrit F2 

Hiire ratta kerimine tabeliaknas liigutab tabelit üles-alla  

MapBasic Window 

Hüpikmenüü  Shift+F10 

Move To Window 

Liigu kaardiaknasse Ctrl+Enter 

Suurenda parimasse mõõtkavasse Alt+topeltklõps 

Tasks Window  

Hüpikmenüü Shift+F10 

Eemalda lõpetatud protsess Task Managerist Del 

Paus   

Tühista   

Vaata logi Shift+L 

Info Window  

Järgmine kiht Ctrl+Right Arrow 

Eelmine kiht Ctrl+Left Arrow 

Akna kerimine Page up/down 

Tools Window  

Pane tööle vaikimisi käsk Enter 

 

 

24. MapInfo Pro 16.0 tarkvara installeerimine 

Miinimum nõuded arvutile ja operatsioonisüsteemile 

Operatsioonisüsteem: Mälu ja protsessor Kettaruum Graafika Monitor 

 Windows7 Ultimate32-bit SP1 

 Windows7 Ultimate64-bit SP1 

with 32-bit compatibility mode 

512MB RAM 

1GHz Pentium 
protsessor 

1.5GB 16- või 24bitise värvitoega. 1024x768 

 Windows 2008 Server 32-bit 

SP2 

512MB Ram 

1GHz Pentium 

protsessor 

2.9GB 16- või 24bitise värvitoega. 1024x768 

 Windows 2008 Server R2 64-

bit SP1 + XenApp 6.0 
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 Windows 2008 Server R2 64-

bit SP1 

 Windows 8 1GB RAM(32-bit) 

2GB RAM(64-bit) 

1GHz protsessor koos 

PAE, NX ja SSE2 toega 

16GB 

(32-bit), 

20GB 

(64-bit) 

Mirosoft DirectX 9 

graafikakaart koos WDDM 

draiveriga 

1024x768 

 Windows 2012 Server 512MB RAM 

1.4 GHz (64-bit) või 

kiirem ühetuumaline 
protsessor, 

1,3GHz(64-bit) või 

kiirem mitmetuumaline 
protsessor 

32GB Mirosoft DirectX 9 

graafikakaart koos WDDM 

draiveriga 

Super VGA 

(800x600) 

Installeerimine 

MapInfo Professional tarkvara installeerimine võtab aega umbes 5 minutit, kuid MapInfo eel-rekvisiitide paigaldus 

võib võtta rohkem aega. 

Logi arvutisse sisse administraatori õigustega kasutajana.  

Aseta CD (algselt valges õhukese paberiga ümbrises) nimega MapInfo Professional - version 12.5 kettaseadmesse. 

Juhul, kui arvutil on „autorun/autoplay“ lubatud, siis peaks mõni hetk peale CD sisestamist automaatselt ekraanile 

ilmuma dialoogiaken. Kui „autorun“ ei ole lubatud, siis tuleks Windows Explorer kaudu minna CD kettaseadme 

peale ning paremal failide loetelus topeltklõpsuga käivitada setup.exe  Osadel juhtudel nõuab installeerimise 

protsess vahepeal arvutile alglaadimise (restart) tegemist, sellisel juhul ärge palun eemaldage MapInfo CD-d 

vahepeal kettaseadmest, sest muidu ei saa installeerimine hiljem peale alglaadimist ja uuesti sisse logimist 

automaatselt jätkuda.  

MapInfo CD kettaseadmesse asetamise järgselt on avanenud dialoogiaknas järgnevad valikud:  

Install Products – installeerimine  

What’s New – olulisemate uuenduste lühiülevaade  

Online Reference – kasutajajuhendid PDF formaadis  

MapInfo Tutorial – õppeprogramm  

Other Products – MapInfo Professionaliga tihedamalt seotud programmide lühitutvustused  

Contact Information – MapInfo Corp. kontaktandmed  

Register Online – programmi seerianumbri registreerimine 

Browse CD – CD peal olevate failide vaatamine Windows Explorer abil 

Exit – dialoogiakna kinni panemine 

Lühike installeerimisõpetus 

Vali Install Products  

Vali MapInfo Professional  

Vali MapInfo Professional Installer  

Vali Next  

Vali I Accept the terms in the license agreement ja Next  

Sisesta enda nimi, asutuse nimi, MapInfo seerianumber (SN# algab tähtedega MINWES125…) ja access code 

(sisesta ainult number, mis on on kirjas AC# järel ... ning vali Next  

Vali Typical Workstation installation ja Next  

Vali Next  

Vali Install  

Vali Yes – Check updates (ja kui on olemas veaparandus e. update patch, siis tuleks see alla laadida ja installeerida) 

Vali Finish  

peale installeerimisprotseduuri lõppemist välju Exit nupule vajutades lahti olevast Autorun dialoogiaknast 

Käivita MapInfo Pro 16.0 Start -> All Programs -> MapInfo alt ning vali Activate Now ning seejärel Automatic 

Activation 

Võimalik on valida ka MapInfo Professional Workgroup, et installeerida võimalus jagada mugavalt kasutajate vahel 

andmeid, malle, sümboleid ja projektsioonifaile. Lugege lühikest tutvustust ja jälgige installeerimisjuhiseid MapInfo 

Professional Workgroup -> Workgroup Install. 

 

MapInfo CD meedia sisu 

MapInfo CD sisaldab ka eraldi installeeritavaid lisavahendeid (Additional Utilities) ning concurrent litsentside 

ostmise korral litsentsiserverit (MapInfo License Server). Litsentsiserverit ei tohi installeerida, kui ei ole ostetud 

vastavat tüüpi mitmekasutaja-litsentsi. GPS seadmega koostööks – Install Products -> Free Utilities -> Install GPS 

support. PDF failide trükkimiseks - Install Products -> Additional Utilities -> Install GPS support. ECW formaadis 

failide salvestamiseks – Install Products -> Additional Utilities -> Install ECW Compressor. 

MapInfo esmakordne käivitamine 
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MapInfo programmi käivitamiseks tekkis Start -> All Programs -> MapInfo alla shortcut nimega MapInfo Pro 16.0. 

Esmakordsel käivitamisel luuakse märkamatult sisse loginud kasutaja jaoks MapInfo personaalsed seaded tema 

windows’i kasutajaprofiili alla (Documents and Settings -> Application Data - > MapInfo jne), seejärel avaneb 

dialoogiaken, milles palutakse MapInfo aktiveerida/registreerida (Activate Now). Activate Now toiming vajab 

internetiühendust ja selle tagajärjel saab litsentseeritakse MapInfo tarkvara püsivalt ja koheselt vastava arvuti jaoks 

ära (st. litsentsivõtme küsimine tehakse veebi kaudu automaatselt ära). Juhul, kui te ei soovi koheselt MapInfot 

jäädavalt aktiveerida, siis tuleb iga kord MapInfot käima pannes valida Activate Later, ja nõnda saate Te MapInfoga 

töötada 30 päeva. Kolmekümne päeva möödumisel enam ilma programmi aktiveerimata töötada ei saa. Kui Te olete 

kindel, et just selles arvutis hakkate Te pikema aja jooksul MapInfoga töötama, siis soovitame valida kohe valiku 

Activate Now ja edasi alavaliku Automatic Activation. 

25. MapInfo poolt toodetava tarkvara lühiülevaade 
 

MapInfo tootevalik jaguneb neljaks: 

 Töökohatarkvarad (MapInfo Professional, MapInfo ProViewer, MapBasic, Encom Discover jne.) 

 Serveritarkvarad ja moodulid (Spectrum, Spectrum Location Intelligence Module, Enterprise Routing 

Module jne.) 

 Pilvelahendused (MapInfo Stratus, MapInfo Exponare) 

 Globaalsed andmekogud (Transportation & Routing, Business & Point of Interest, jne) 

Kogu MapInfo tootevaliku koos informatsiooniga leiab aadressilt http://www.mapinfo.com. 

 

 

EDU MAPINFO KASUTAMISEL !   

Lektorid: Mati Tee, Kaido Irdt 

AS Reach-U 

September 2016 

http://www.reach-u.com/ 

Konspekti koostas: Mati Tee 

Täiendasid: Marta Olvet, Kaido Irdt 

http://www.mapinfo.com/
http://www.reach-u.com/

